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Product Description 

• Writer a word processor you can use for anything from writing a quick letter to 

producing an entire book. 

• Calc a powerful spreadsheet with all the tools you need to calculate, analyse, and 

present your data in numerical reports or sizzling graphics. 

• Impress the fastest, most powerful way to create effective multimedia 

presentations. 

http://www.openoffice.org/product/writer.html
http://www.openoffice.org/product/calc.html
http://www.openoffice.org/product/impress.html


• Draw lets you produce everything from simple diagrams to dynamic 3D 

illustrations. 

• Base lets you manipulate databases seamlessly. Create and modify tables, forms, 

queries, and reports, all from within Apache OpenOffice. 

• Math lets you create mathematical equations with a graphic user interface or by 

directly typing your formulas into the equation editor. 

• Apache OpenOffice is – 

------------------------------- 

 

• Great software 

Apache OpenOffice is the result of over twenty years' software engineering. 

Designed from the start as a single piece of software, it has a consistency other 

products cannot match. A completely open development process means that 

anyone can report bugs, request new features, or enhance the software. The result: 

Apache OpenOffice does everything you want your office software to do, the way 

you want it to. 

• Easy to use 

Apache OpenOffice is easy to learn, and if you're already using another office 

software package, you'll take to OpenOffice straight away. Our world-wide 

native-language community means that OpenOffice is probably available and 

supported in your own language. And if you already have files from another 

office package - OpenOffice will probably read them with no difficulty. 

• and it's free 

Best of all, Apache OpenOffice can be downloaded and used entirely free of any 

license fees. Apache OpenOffice is released under the Apache 2.0 Licence. This 

means you may use it for any purpose - domestic, commercial, educational, public 

administration. You may install it on as many computers as you like. You may 

make copies and give them away to family, friends, students, employees - anyone 

you like. 

Where is Apache OpenOffice currently used? 

• Governments 

• Education 

• Businesses 

• Not for profits 

• IT Businesses 

http://www.openoffice.org/product/draw.html
http://www.openoffice.org/product/base.html
http://www.openoffice.org/product/math.html
http://www.openoffice.org/why/why_great.html
http://www.openoffice.org/why/why_easy.html
http://www.openoffice.org/why/why_free.html
http://www.openoffice.org/why/why_gov.html
http://www.openoffice.org/why/why_edu.html
http://www.openoffice.org/why/why_sme.html
http://www.openoffice.org/why/why_nfp.html
http://www.openoffice.org/why/why_oem.html


 

Apache OpenOffice is standards compliant 

certified by OSI as open-standard compliant, and the first software package in the world 

to use OASIS OpenDocument Format (ISO 26300) as its native file format 

 

 

OpenOffice is an absolutely free office software suite for word processing, spreadsheets, 

presentations, graphics, databases and other modules. OpenOffice functionality is very 

similar to popular  Microsoft Office or Lotus SmartSuite. It is 100% alternative to the 

Microsoft Office (MS Office), which can be used for any purpose. 

 

 

Microsoft Office Compatibility 

OpenOffice is compatible with Microsoft Office and able to read, write Microsoft 

Office files. You can open and save Microsoft Word, Microsoft Excel and Microsoft 

PowerPoint files using OpenOffice in Windows, Linux and Solaris. 

 

 

 

 

OpenOffice Operating system compatibility 

OpenOffice run on Microsoft Windows, Linux, Solaris, BSD, OpenVMS, OS/2 and 

IRIX. OpenOffice.org expands this availability by offering ports to Mac OS X, FreeBSD, 

and HP-UX. 

 
 

 

 

 

 

 

http://www.opensource.org/docs/definition.php
http://www.oasis-open.org/
http://www.oasis-open.org/committees/tc_home.php?wg_abbrev=office


 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

the office suite is the meat and potatoes of most businesses. From correspondence, to 

spreadsheets, to presentations, nearly all offices rely on the tools that comprise the office 

suite. And there are a handful of outstanding candidates in this category. But to this day 

Microsoft Office and OpenOffice are the kings of the office suite hill. However, a new 

player has entered that is not new to the game, but may be new to you. IBM’s Lotus 

Symphony is a free alternative to Microsoft Office that contains the three most important 

tools an office suite has to offer: Word processor, spreadsheet, and presentation. 

http://symphony.lotus.com/software/lotus/symphony/home.nsf/home
http://symphony.lotus.com/software/lotus/symphony/home.nsf/home


Specifications 

 

• Supported Windows platforms: Windows XP, Windows Vista 

• Supported Linux platforms: SLED 10, RHEL 5, Ubuntu 

• Supported Mac platforms: Intel processor-based Macs with Mac OS X 10.5 

• Hard drive memory: At least 750MB of free disk space on Linux, at least 

540MB on Mac OS, and at least 540MB on Windows 

• RAM memory: At least 512MB 

• Note: Windows installer does not support AMD64 CPU with XP/Vista 64 bit 

platforms installed 

• Cost: Free 

• Additional vendor information 

• TechRepublic Photo Gallery 

Who’s it for? 

Symphony is for any business looking for an office suite, but operating without the IT-

budget for Microsoft Office or the need for the extra features of OpenOffice. 

What problem does it solve? 

Lotus Symphony enables the small business, running on a tight budget, to have a 

streamlined, reliable office suite. And since Symphony supports both the Open Document 

Format and Microsoft Office formats, you will not have a problem sharing documents 

with other businesses. 

Standout Features 

• Single “desktop” interface where all components are accessed 

• Macro support 

• Context-sensitive menus 

• Adobe PDF conversion 

• Track changes 

• Extendable via plugins 

http://symphony.lotus.com/software/lotus/symphony/home.nsf/home
http://content.techrepublic.com.com/2346-13629_11-368323.html


• Support for 28 different languages 

• Works seamlessly with other tools in the Eclipse Framework 

What’s wrong? 

Some will find the inclusion of only three tools in the Symphony suite of applications a 

major drawback. When you can get OpenOffice for the same price (Free) which also 

includes a database application, a simple drawing application, and more, why turn to a 

pared down suite of tools? 

Another issue is the font rendering in Linux isn’t the best. In fact, the font rendering in 

Symphony on Linux looks more like what OpenOffice did in the ’90s. Add some font 

smoothing into the mix and the interface would look quite a bit better. 

 

 

License: Freeware Operating Systems: Linux, Mac OS X, Windows 7 (32 bit), Windows 

7 (64 bit), Windows Vista (32 bit), Windows Vista (64 bit), Windows XP Requirements:  

Windows: XP requires SP3, Vista requires SP2; Mac: Intel processor and Mac OS X 10.5 

or later; Linux: SuSE Linux Enterprise Desktop 11, RedHat Enterprise Linux 5 Update 4, 

Ubuntu 8.04  

Languages: English Software Cost: Free 

 

 

 

STAR OFFICE SUITE:------- 
 

StarOffice, known briefly as Oracle Open Office before its discontinuation in 2010, was 

a proprietary office suite. It was originally developed by StarDivision which was 

acquired by Sun Microsystems in 1999. Sun was itself acquired in 2009 by Oracle 

Corporation. 

StarOffice supports the OpenOffice.org XML file format, as well as the OpenDocument 

standard, and can generate PDF and Flash formats. It includes templates, a macro 

recorder, and a software development kit (SDK). 

The source code of the suite was released in July 2000, creating a free, open source office 

suite called OpenOffice.org, which subsequent versions of StarOffice were based on, 

with additional proprietary components. 

In March 2009, a study showed that StarOffice could only gain 3% market share in the 

corporate market. 

http://en.wikipedia.org/wiki/OpenDocument


 

In April 2011, Oracle announced the discontinuation of Oracle Open Office[1] as part of 

the decision to turn OpenOffice.org into a "purely community-based project".[5 

 

 

The competitors of Microsoft always celebrate when there is any case against Microsoft 

or if a free Software is launched similar to Microsoft's Products. But those who are 

unbiased should always weigh the pros and cons of any software before judging the 

winner. 

 

Sun Micro system's Star Office is the direct competitor of Microsoft's MS Office. Star 

Office software was free until its 5th version. Therefore Star Office was well received by 

computer users. Better still the features in Star Office was more or less similar to MS 

Office. 

 

But from Star Office Version 6, it was not free. However it is still far cheaper than MS 

Office. Here we will see the features available in Star Office and see its Pros and Cons. 

 

Components in Star Office 

 

Star Office Version 7 consists of Writer (a word processor), calc (a spreadsheet), 

adabas (a database), draw (a drawing program) and Impress (a presentation 

software). 

 

You can use Star Office in Windows 98/NT/2000/XP, with Pentium processor, 64MB 

RAM and 256 MB free hard disk space. 

 

Writer  

1. If you have ever worked in MS Word, it is very easy for you to use Writer. You 

can even save the file you create in Writer as a 'Word 97/2000/2002/6.0' 

document. Similarly you can open a .Doc file using Writer. 

2. You can also save your document in Writer as RTF, Text or HTML format. 

3. You can insert tables, images and charts in Writer. Similar to MS Word, Writer 

also has Auto text and Auto Correct features. Auto Complete facility is also 

available. Which means when you type the first two or three letters of a word, 

Writer will prompt you with the full word. This reduces typing time. 

4. Spelling checker and grammer checker are also available in Writer. You can also 

send the document created in Writer through email. 

5. Writer can also convert the document you create into a PDF file. 

calc 

http://en.wikipedia.org/wiki/StarOffice#cite_note-hexus-0
http://en.wikipedia.org/wiki/StarOffice#cite_note-4


1. Similar to MS Excel, calc is a spreadsheet application. If the text you typed in a 

cell cannot fit inside the cell then 'calc' will display a small red arrow at the end of 

the cell. 

2. You can save the file you created in calc as MS Excel file or to a dbase database. 

You can also open Excel files in Calc. 

3. You can use the data in calc file to mail merge in writer document. You can also 

generate many beautiful charts. 

Adabas 

 

Comparing to MS Access database, adabas is a very simple database. Very less features 

are available. However adabas can open ODBC, JDBC and MySQL databases. An 

adabas database cannot exceed 100MB storage size. Another restriction is that only three 

users can access the adabas database over the network. Due to all these difficulties not 

many people like adabas. Adabas doesn't have distributed database facility 

Impress 

 

Impress is a presentation software like MS PowerPoint. Animation and Transition effects 

are some of the features available in Impress. Plenty of templates are available in 

Impress. Therefore anybody can create a presentation using Impress very easily. You can 

also convert an Impress presentation into a HTML format and publish it in your website. 

 

Draw 

1. Compared to MS Paint, Star Office Draw is more powerful and has many 

additional features. It is sure that everybody will like the Draw application. You 

can use Star Office draw to create Vector graphics, Animated GIF and even 3D 

graphics. 

2. Draw is also capable of handling many different image formats. You can create 

buttons and images in GIF, JPG or PNG format and use it in your website. You 

can also convert the graphics that you create in Draw into PDF, HTML or even 

shockwave flash format. 

Pros of Star Office 

• Very cheap. 

• Star Office Draw software is very powerful. 

• Conversion to PDF is also a plus 

Cons of Star Office 

• Star Office adabas database is very inferior 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

MS-WORD 2003 
 

 



 

Introducing Microsoft Office 2003 

Microsoft Office 2003 is the latest version of the popular Office application suite. 

Microsoft Office 2003 comes in different editions that include a different set of Office 

applications. For example, the Microsoft Office Professional Edition, which we cover in 

this book, includes Word 2003, Excel 2003, PowerPoint 2003, Outlook 2003 with the 

Business Contact Manager, Publisher, and Access 2003. Table 1.1 provides a look at 

each of the Microsoft Office 2003 editions. 

 

 

Table 1.1. The Different Editions of Microsoft Office 2003 

 

 

Edition: 

Microsoft Office 

Professional 

Edition 2003  

Microsoft 

Office Small 

Business 

Edition 2003 

Microsoft 

Office 

Standard 

Edition 2003 

Microsoft Office 

Student and 

Teacher Edition 

2003 

Applications 

Included 

    

 Word 2003 Word 2003 Word 2003 Word 2003 

 Excel 2003 Excel 2003 Excel 2003 Excel 2003 

 PowerPoint 2003 PowerPoint 

2003 

PowerPoint 

2003 

PowerPoint 2003 

 Outlook 2003 

with Business 

Contact Manager 

Outlook 2003 

with Business 

Contact 

Manager 

Outlook 2003 Outlook 2003 

 Publisher 2003 Publisher 2003   

 Access 2003    

 

 

No matter which edition of Office you use, you are provided with different software 

applications that you can use to tackle a large variety of business and personal tasks on 

the computer. For example, Word allows you to create reports, letters, and other 

documents, and Excel allows you to tackle spreadsheets, invoices, and do a wide variety 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch01lev1sec1.html#ch01table01#ch01table01


of number-crunching tasks. Each application provides a specialized set of tools and 

environments for addressing your productivity needs. 

Microsoft Office 2003 offers a number of new enhancements to the Office suite. This 

lesson serves as a quick overview of some of these new features. Other new features are 

highlighted in Part II of the book ("Migrating to Office 2003"). You will also use some 

new features as you explore each of the Office applications discussed in this book. 

 

 

Office 2003 and the Document Workspace 

An exciting new feature, the Document Workspace, allows users who don't have the 

option of sharing documents on a corporate network to collaborate on the Web. The 

Document Workspace is actually an extension of Microsoft Windows SharePoint 

Services, which allows you to store documents for collaboration on a SharePoint server. 

Multiple users can access the document in the shared workspace, and tasks can be 

assigned associated with the collaborative effort. 

The Document Workspace is a fairly advanced feature offered by Office 2003, so the full 

details related to the use of this powerful feature are beyond the scope of this 

introduction. However, creating a new workspace is surprisingly easy. It does, however, 

require that you are connected to the Internet and have access to a SharePoint server 

maintained by your company or you have subscribed to a SharePoint hosting service such 

as those offered by Microsoft. Let's take a look at creating a Document Workspace in 

Microsoft Word. 

To create a Document Workspace, follow these steps (these steps assume Microsoft 

Word is already open): 

1. Open the document that will be available in the shared workspace. 

2. Select Tools and then Shared Workspace. The Shared Workspace task pane opens 

as shown in Figure 1.1 

 

 

1. Type the URL (Uniform Resource Locator or Web address) for the workspace 

that will serve as the holding area for the shared document in the Location for 

New Workspace box. 

2. Click the Create button in the task pane. 

3. A connection box will appear that requires you to enter your user name and 

password for the shared workspace. After entering the information, click OK. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_part02.html#part02
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch01lev1sec2.html#ch01fig01#ch01fig01


4. The shared workspace will be created (on the Web site you designated) and a 

copy of the current document is placed in the workspace. 

As the creator of the site, you are designated as the site owner. This allows you to add 

new members to the site, add additional documents, and manage the workspace. You can 

also view who is currently online and working on the document. Figure 1.2 shows a 

document that is shared in a workspace. Note that the Shared Workspace task pane lists 

the current users of the workspace and whether or not they are currently online. Tools 

provided in the task pane allow you to quickly e-mail workspace users and to update the 

workspace status. 

 

Getting Help in Office 2003 

Microsoft Office 2003 uses a streamlined Help system that is primarily accessed using 

the new Help task pane. Options available in previous versions of Office such as the 

Office Assistant and the Ask a Question box are also available in Office 2003 for 

accessing help. 

You can open the Help task pane by selecting the Help menu and then accessing the Help 

command for the current application. For example, to access the Help task pane in Word, 

select Help and then Microsoft Word Help. The Help task pane appears as shown in 

Figure 1.3. 

Figure 1.3. The Help task pane allows you to search for help and access online 

Office resources. 

 

 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch01lev1sec2.html#ch01fig02#ch01fig02
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch01lev1sec3.html#ch01fig03#ch01fig03


 

Faxing over the Internet 

Another addition to Office 2003 is the ability to send faxes from your Office applications 

over the Internet. This feature requires that you sign up for an Internet fax service. These 

services provide you with the ability to send and receive faxes over the Internet. This 

means that you do not require a fax modem on your computer to work with faxes. 

Sending the current document from any Office application as an Internet fax is quite 

easy: You click the File menu, point at Send To, and then select Recipient Using Internet 

Fax Service. The first time you use this command, you will have the option of being 

taken to a Web page that allows you to sign up for a fax service. Pricing for this service 

varies by provider as do the steps required to prepare a fax cover page and send your 

Office document. Faxing is discussed in more detail in Lesson 8, "Faxing and E-Mailing 

in Office 2003." 

 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch08.html#ch08


Office 2003 and XML Data 

XML (Extensible Markup Language) is fast becoming the standard for data exchange on 

the World Wide Web. In Office 2003, instead of saving documents in their default 

formats, you can save Office documents as XML documents. 

 

XML or Extensible Markup Language is a markup language (HTML 

being an example of another markup language) that can be used to tag 

data so that it can be transferred between applications and also 

interpreted and validated. XML is rapidly becoming an important 

format for moving data between servers on the Web. 

 

Saving in XML format is particularly useful in situations where you want to convert 

Excel or Access data to an XML format for use on the Web. Although using XML data 

on the Web is beyond the scope of this book, you will find that if required, you can 

quickly save data in an Office application such as Excel in the XML format. 

Follow these steps: 

1. Select File, then Save As. The Save As dialog box will open. 

2. In the Save As dialog box, select the Save as Type drop-down box and select 

XML Data (see Figure 1.5). You can also change the filename if you want. 

 

 

1. Figure 1.5. Office data can be saved in the XML format. 

 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch01lev1sec6.html#ch01fig05#ch01fig05


 

 

Starting Office Applications 

The Microsoft Office applications can be quickly started from the Windows Start menu. 

Desktop icons can also be quickly created for an Office application to provide quick 

access to that application. 

To start an Office application from the Start menu, follow these steps: 

1. From the Windows XP desktop, click Start, point at All Programs, and then point 

at the Microsoft Office folder. The Office programs installed on your computer 

will appear as shown in Figure 2.1 (for Windows 2000, point at Programs, then 

Microsoft Office). 

Figure 2.1. Use the Start menu to start your Office applications. 

 

 

 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch02lev1sec1.html#ch02fig01#ch02fig01


 

 

1. To open a particular Office application, click that application's icon on the menu. 

The program window for that application appears. 

Starting an Application by Choosing a Document Template 

You can also start a particular Office application by choosing the type of Office 

document that you are going to create. This is done using the Start menu. 

1. From the Windows desktop, click Start, All Programs, then New Office 

Document. The New Office Document dialog box appears (see Figure 2.2). 

Figure 2.2. The New Office Document dialog box can be used to quickly 

start a new document in any Office application 

 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch02lev1sec1.html#ch02fig02#ch02fig02


 

 

Using the Menu System 

The menu bar that you find in the Office applications gives you access to all the 

commands and features a particular application provides. These specific menu systems 

are found below the title bar and are activated by selecting a particular menu choice. The 

menu then opens, providing you with a set of command choices. 

The Office 2003 applications use a personalized menu system that was first introduced in 

Microsoft Office 2000. It enables you to quickly access the commands you use most 

often. When you first choose a particular menu, you find a short list of menu commands. 

As you use commands, the Office application adds them to the menu list. 

To access a particular menu, follow these steps: 

1. Select the menu by clicking its title. The most recently used commands appear; 

hover the mouse pointer for just a moment and all the commands on a particular 

menu appear; if you don't like to hover, click the Expand icon (the double down-

pointing arrow on the bottom of the menu) to view all the menu choices. 

2. Select the command on the menu that invokes a particular feature. 

You will find that several of the commands found on the menu are followed by an ellipsis 

(…). These commands, when selected, open a dialog box or a task pane. Dialog boxes 

require you to provide the application with additional information before the particular 



feature or command can be used (more information on working with dialog boxes 

appears later in this lesson). 

Some of the menus also contain a submenu or a cascading menu that you can use to make 

your choices. The menu commands that produce a submenu are indicated by an arrow to 

the right of the menu choice. If a submenu is present, you point at the command (marked 

with the arrow) on the main menu to open the submenu. 

Activating Menus with the Keyboard You can also activate a particular menu by holding 

down the Alt key and then pressing the keyboard key that matches the underscored letter, 

also called a hotkey, in the menu's name. For example, to activate the File menu in Office 

applications, press Alt+F. 

If you would rather have access to all the menu commands (rather than just those you've 

used recently), you can turn off the personalized menu system. To do this, follow these 

steps in any Office application: 

1. Click the Tools menu, and then click Customize. 

2. In the Customize dialog box, click the Options tab. 

3. To show all the commands on the menus (without delay), click the Always Show 

Full Menus check box. 

4. Click OK to close the dialog box. 

Using Shortcut Menus 

A fast way to access commands that are related to a particular item on an Office 

document, such as selected text or a picture, is to right-click that item. This opens a 

shortcut menu that contains commands related to the particular item with which you are 

working. 

For example, if you select a chart on an Excel worksheet, right-clicking the chart (see 

Figure 2.3) opens a shortcut menu with commands such as Cut, Copy, and Paste. 

Figure 2.3. Shortcut menus provide quick access to application commands. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch02lev1sec3.html#ch02fig03#ch02fig03


 

Working with Toolbars 

Toolbars provide you with a very quick and straightforward way of accessing commands 

and features in the Office applications. When you first start one of the Office 

applications, you typically see the Standard and Formatting toolbars sharing one row, as 

shown in Figure 2.4. 

Figure 2.4. Toolbars, such as the Standard and Formatting toolbars in this 

PowerPoint window, provide quick access to an application's features and 

commands 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch02lev1sec4.html#ch02fig04#ch02fig04


 

To access a particular command using a toolbar button, click the button. Depending on 

the command, you see an immediate result in your document (such as the removal of 

selected text when you click the Cut button), or a dialog box might appear, requesting 

additional information from you. 

 

Finding a Toolbar Button's Purpose You can place the mouse pointer 

on any toolbar button to view a ScreenTip that describes that tool's 

function. 

 

Other toolbars, such as the Drawing toolbar and toolbars that are specific to a particular 

Office application, open when you access a particular application. You can also open 

them manually by right-clicking any visible toolbar and then selecting the toolbar you 

want to use from the list that is provided. You can also use this method to close a toolbar 

you no longer need. 

 

Missing Toolbar Buttons? The Standard and Formatting toolbars have 

been configured to share one row by default, so you might not be able 

to see every button on the toolbars. To find a hidden button, click the 

More Buttons button on the end of either toolbar. Another alternative is 

to click the Toolbar Options button on the Standard or Formatting 

toolbar and select Show Buttons on Two Rows. This gives each toolbar 

its own row. 



Understanding Dialog Boxes 

When you are working with the various commands and features found in Office 

applications, you will invariably come across dialog boxes. Dialog boxes are used when 

an Office application needs more information from you before it can complete a 

particular command or take advantage of a special feature. Dialog boxes always appear 

when you select a menu command that is followed by an ellipsis. Dialog boxes also 

appear when you invoke this same command using the appropriate toolbar button. 

Figure 2.5 shows Word's Font dialog box. This dialog box enables you to make selections 

using check boxes and drop-down lists. Other dialog boxes use option buttons, spinner 

boxes, and other methods of enabling you to quickly make selections in a particular box. 

Figure 2.5. Dialog boxes enable you to make your choices related to a particular 

feature 

In most cases, when you complete your selections in a dialog box, you click the OK 

button to close the box and complete the command. You also have the option of clicking 

the Cancel button if you want to close the dialog box without saving any changes you 

made. 
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In most cases, when you complete your selections in a dialog box, you click the OK 

button to close the box and complete the command. You also have the option of clicking 

the Cancel button if you want to close the dialog box without saving any changes you 

made. 

 

Understanding the Task Pane 

A major change to the previous version of Office, Office XP, was the introduction of task 

panes. Office 2003 also uses task panes, which have replaced many of the dialog boxes 

that were a common feature in Office 97 and Office 2000. Office 2003 has also added 

new task panes such as the Research task pane (which we discuss later in this lesson). 

A task pane is a multipurpose window pane that appears on the right side of the window 

of an Office application. The list that follows describes the global task panes that you will 

find in all the Office applications: 



• New File Task Pane— Enables you to start a new file in a particular application 

(for example, in Word it is called the New Document task pane; in Excel it is 

called the New Workbook task pane). It also provides access to various document 

templates and the capability to open recently used files. 

• Office Clipboard Task Pane— Enables you to view items that you copy and cut to 

the Office Clipboard. You can manage up to 24 items on the Clipboard and paste 

them within an application or between applications. 

• Clip Art Task Pane— Enables you to search the Office Clip Gallery and insert 

clip art into your Office application documents. 

• Search Task Pane— Enables you to search for files from any of the Office 

applications. 

• Research Task Pane— This new task pane allows you to take advantage of a 

number of research and reference services. A number of these references are 

accessed via online services such as Microsoft Encarta. 

You look at the Research, Search, Clip Art, and Clipboard task panes in more detail later 

in the lesson. 

Task panes also house features that handle specific purposes in each of the Office 

applications. For example, in PowerPoint, the Slide Layout task pane (shown in Figure 

3.1) is used to select a design format for a new or existing PowerPoint presentation slide. 

You learn about the different task panes in the Office applications as you use them in the 

different parts of this book. 

Figure 3.1. The task pane provides specific features in the different Office 

applications. 
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When you are working in an Office application, such as Word or Excel, you can open a 

task pane and switch between the different task pane features offered in that particular 

application. To open a task pane, follow these steps: 

1. In the Office application window, select the View menu and select Task Pane. 

The New File task pane appears on the right side of the application window (the 

New File task pane is the default task pane for the Office applications). 

2. To switch to a particular task pane that is available in the current Office 

application, click the task pane's drop-down arrow (see Figure 3.2). 

Figure 3.2. Use the task pane's menu to switch to a particular task pane 

in an application. 
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1. Click the item on the task pane menu that you want to use. 

You will find that the task pane also pops up when you select specific features in an 

application. For example, in Word, when you select Format and then Styles and 

Formatting, the Styles and Formatting task pane appears in the Word window. 

 

Help Is Now a Task Pane Office Help is now accessed through a task 

pane. Getting help in Office is discussed in Lesson 5, "Getting Help in 

Microsoft Office." 
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The Basic File Search Task Pane 

The Basic File Search task pane enables you to locate files stored on your computer or 

company network without leaving the Office application that is currently open. To use 

the Search task pane, follow these steps: 

1. From an Office application window, select the File menu and then select Search 

to open the Search task pane (see Figure 3.4). 

Figure 3.4. Use the Search task pane to locate files on your computer or 

network. 

 

 

1. Type the keyword or keywords that you want to use for the search into the Search 

text box. 

2. To specify the locations that should be searched, click the Selected Locations 

drop-down box. You can expand any of the locations listed, such as My 

Computer, by clicking the plus (+) symbol to the left of the location. This enables 
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you to view folders and subfolders at that location. Use the check boxes to the left 

of each location to specify whether that location should be searched. 

3. To specify the types of files that are located during the search, click the Selected 

File Types drop-down list. Select or deselect the check boxes for particular Office 

applications (such as Word or Excel) to specify the types of files that should be 

included in the search. 

4. When you are ready to run the search, click the Go button. 

Training the Speech Feature 

Microsoft Office 2003 provides you with the ability to enter information into the Office 

applications using a microphone. You can also enable access to an application's menu 

system using voice commands. The Speech feature was first made available with Office 

XP. 

Before you can really take advantage of the Speech feature, you must provide it with 

some training so that it can more easily recognize your speech patterns and intonation. 

After the Speech feature is trained, you can effectively use it to dictate text entries or 

access various application commands without a keyboard or mouse. 

The Speech feature is actually installed and then trained in Microsoft Word. So, you must 

run it for the first time from within Word. After you train the Speech feature in Word, 

you can then use it in your other applications, such as Excel and PowerPoint. Follow 

these steps to get the Speech feature up and running: 

1. In Microsoft Word, select the Tools menu and select Speech. You will be asked if 

you want to install the Speech feature; click Yes to continue. After the 

installation, the Welcome to Office Speech Recognition dialog box appears. To 

begin the process of setting up your microphone and training the Speech feature, 

click the Next button. 

2. The first screen of the Microphone Wizard that appears asks you to make sure that 

your microphone and speakers are connected to your computer. If you have a 

headset microphone, this screen shows you how to adjust the microphone for use. 

Click Next to continue. 

3. The next wizard screen asks you to read a short text passage so that your 

microphone volume level can be adjusted (see Figure 4.1). When you have 

finished reading the text, click Next to continue. 
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1. On the next screen, you are asked to read another passage. The text is then played 

back to you. This is to determine whether the microphone is placed at an 

appropriate distance from your mouth; when you get satisfactory playback, click 

Finish. 

When you finish working with the Microphone Wizard, the Voice Training Wizard 

appears. This wizard collects samples of your speech and, in essence, educates the 

Speech feature as to how you speak. 

To complete the voice training process, follow these steps: 

1. The opening Wizard screen provides you with a Sample button that allows you to 

hear how you should read the text that is supplied during the training session. 

After reading the directions provided on the opening screen, click Next to begin 

the voice training process. 

2. On the next screen, you are asked to begin reading a sample passage (see Figure 

4.2). If you need to pause during the process (the initial training takes about 15 

minutes), click the Pause button. 
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1. You are asked to read text on several subsequent screens. Words are selected as 

the wizard recognizes them. 

 

Some Words Might Not Be Recognized If the wizard becomes stuck 

on a word that it cannot recognize during the training session, click the 

Skip Word button. This skips the current word and allows you to 

continue the training session. 

2.  

 

3. When you complete the training screens, your profile is updated. Click Finish on 

the wizard's final screen. 

You are now ready to use the Speech feature. The next two sections discuss using the 

Voice Dictation and Voice Command features. 

You are now ready to use the Speech feature. The next two sections discuss using the 

Voice Dictation and Voice Command features. 



caution 

The Speech Feature Works Better Over Time Be advised that the voice 

feature's performance improves as you use it. If you pronounce your 

words carefully and consistently, the Speech feature tunes itself to your 

speech patterns. You might need to do additional training sessions to 

fine-tune the Speech feature. 

 

 

Using Voice Dictation 

When you are ready to start dictating text into an Office application such as Word, put on 

your headset microphone or place your standalone microphone in the proper position that 

you determined when you used the Microphone Wizard. When you're ready to go, select 

the Tools menu and then select Speech. The Language bar appears, as shown in Figure 

4.3. If necessary, click the Dictation button on the toolbar (if the Dictation button is not 

already activated or depressed). 
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After you enable the Dictation button, you can begin dictating your text into the Office 

document. Figure 4.3 shows text being dictated into a Word document. When you want 

to put a line break into the text, say "new line." Punctuation is placed in the document by 

saying the name of a particular punctuation mark, such as "period" or "comma." 

How Do I Insert the Word "Comma" Rather Than the Punctuation Mark? Because certain 

keywords, such as "period" or "comma," are used to insert punctuation during dictation, 

you must spell these words out if you want to include them in the text. To do this, say 

"spelling mode," and then spell out the word, such as c-o-m-m-a. As soon as you dictate 

an entire word, the spelling mode ends. 

When you have finished dictating into the document, click the Microphone button on the 

Language bar. When you click the Microphone button, the Language bar collapses, 

hiding the Dictation and the Voice Command buttons. You can also stop Dictation mode 

by saying "microphone." 

You can minimize the Language bar by clicking the Minimize button on the right end of 

the bar. This sends the Language bar to the Windows system tray. 

With the Language bar minimized in the system tray, you can quickly open it when you 

need it. Click the Restore icon in the system tray. 

Using the Dictation feature correctly requires that you know how to get the Speech 

feature to place the correct text or characters into an Office document. For more help with 

the dictation feature, consult the Microsoft Office Help system from any Office 

application. 

Using Voice Commands 

Another tool the Speech feature provides is voice commands. You can open and select 

menus in an application and even navigate dialog boxes using voicecommands. 

To use voice commands, open the Language bar (click Tools, Speech or restore the 

Language Bar from the system tray). Click the Microphone icon, if necessary, to expand 

the Language bar. Then, click the Voice Command icon on the bar (or say "voice 

command"). 

To open a particular menu such as the Format menu, say "format." Then, to open a 

particular submenu such as Font, say "font." In the case of these voice commands, the 

Font dialog box opens. 

You can then navigate a particular dialog box using voice commands. In the Font dialog 

box, for example, to change the size of the font, say "size"; this activates the Size box that 

controls font size. Then, say the size of the font, such as "14." You can also activate other 

font attributes in the dialog box in this manner. Say the name of the area of the dialog box 

you want to use, and then say the name of the feature you want to turn on or select. 
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When you have finished working with a particular dialog box, say "OK" (or "Cancel" or 

"Apply," as needed) and the dialog box closes and provides you with the features you 

selected in the dialog box. When you have finished using voice commands, say 

"microphone," or click the Microphone icon on the Language bar. 

Believe it or not, you can also activate buttons on the various toolbars using voice 

commands. For example, you could turn on bold by saying "bold." The Bold button on 

the Formatting toolbar becomes active. To turn bold off, say "bold" again. 

A Final Word About the Speech Feature 

The Speech feature actually provides a number of possibilities for using voice dictation 

and voice commands. You will probably want to practice on some documents that aren't 

important to your work as you become familiar with the different features provided. 

If you find that you aren't getting very good results with either voice dictation or voice 

commands, you can do some additional training for the Speech feature. On the Language 

bar, click the Tools icon and then select Training from the shortcut menu that appears. 

The Voice Training Wizard appears (see Figure 4.4). Do the additional training exercises 

that the wizard supplies. 
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Chapter 1. Working in Word 

In this lesson, you learn how to start Microsoft Word and navigate the Word window. 

You also learn how to use common tools such as menus, toolbars, and dialog boxes. 

 

 

Starting Word 

Microsoft Word is an efficient and full-featured word processor that provides you with all 

the tools you need to produce a wide variety of document types—everything from simple 

documents, such as memos and outlines, to complex documents, such as newsletters and 

Internet-ready HTML pages. You create your Word documents in the Word window, 

which provides easy access to all the tools you need to create all your documents. 

Before you can take advantage of Word's proficient document processing features, you 

must open the Word application window. To start the Word program, follow these steps: 

1. From the Windows XP desktop, click Start, All Programs (on Windows 2000, 

click Start, then Programs). The Programs menu appears (see Figure 1.1). 
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To start Word, point at the Microsoft Office icon and then click the Word icon. The Word 

application window appears 

 

Pin a Program to the Windows XP Start Menu For quick access to an application such as 

Word, right-click on the program icon when accessing the Programs menu. On the 

shortcut menu that appears, select Pin to Start menu. The application icon will now be 

available on the main Start menu, when you click Start. 

 

Understanding the Word Environment 

When you start Word, the Word application window opens (see Figure 1.2). You create 

your documents in the Word window. The Word window also provides items that help 

you navigate and operate the application itself. 

Figure 1.2. Create your documents and access Word's features and commands 

in the Word window. 
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Control the View If your view differs from the view shown in Figure 1.2 (the Normal 

view), or if you don't see all the Word window elements shown in the figure (particularly 

the ruler), you can easily change your view. Select View, and then choose the menu 

selection (such as Normal or Ruler) that matches your view to the figure. 

 

Notice that the largest area of the window is blank; this is where you create your new 

document. All the other areas—the menu bar, the toolbar, and the status bar—either 

provide a fast way to access the various commands and features that you use in Word, or 

they supply you with information concerning your document, such as what page you are 

on and where the insertion point is currently located in your document. 

 

 

Table 1.1. Elements of the Word Window 

 

 

Element Description 

Title bar Includes the name of the application and the current document, as 

well as the Minimize, Maximize, and Close buttons. 

Control Menu 

button 

Opens the Control menu, which provides such commands as 

Restore, Minimize, and Close. 

Minimize button Reduces the Word window to a button on the taskbar; to restore the 

window to its original size, click the button on the taskbar. 

Maximize/Restore 

button 

Enlarges the Word window to cover the Windows desktop. When 

the window is maximized, the Maximize button changes to a 

Restore button that you can click to return the window to its 

previous size. 

Close (X) button Closes the Word program. "X" is the icon for closing any window. 

Menu bar Contains menus of commands you can use to perform tasks in the 

program, such as Edit, Format, and Tools. 

Toolbar Includes icons that serve as shortcuts for common commands, such 

as Save, Print, and Spelling. 

Status bar Displays information about the current document, including page 
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Element Description 

number, the section in which you are located, and the current 

location of the insertion point (inches, line, and column). The status 

bar also shows you other information, such as whether you have 

turned on the Typeover (OVR) mode or turned on Word's track 

changes (TRK) feature. 

Document window This window is where you type and format your documents. 

Scrollbars The horizontal scrollbar is used to scroll your view of the current 

document in a left-to-right motion. The vertical scrollbar is used to 

scroll up and down through the current document. 

Task pane The column of information on the right side of the document is the 

task pane. This is where you can access features such as the 

Clipboard, styles, and formatting; you can also open another 

document or mail merge. 

 

Using Menus and Toolbars 

Word provides several ways to access the commands and features you use as you create 

your documents. You can access these commands by using the menus on the menu bar 

and the buttons on the various toolbars. 

You can also access many Word commands using shortcut menus. Right-clicking a 

particular document element (a word or a paragraph, for example) opens these menus, 

which contain a list of commands related to the item on which you are currently working. 

 

The Word Menu Bar 

The Word menu bar gives you access to all the commands and features that Word 

provides. As in all Windows applications, Word's menus reside below the title bar and 

are activated by clicking a particular menu name. The menu then drops open, providing 

you with a set of command options. 

Word (and the other Office applications) uses a menu system called personalized menus 

that enables you to quickly access the commands you use most often (while hiding those 

that you use less frequently). When you first choose a particular menu, you find only a 

short list of Word's most commonly used menu commands. When you've spent some 

time using Word, this list of commands will actually be the ones that you have used most 

recently on that particular menu. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_10071533.html


If a menu has a small double arrow at the bottom of its command list, you can click that 

to gain access to other, less commonly needed, commands. As you use hidden 

commands, Word adds them to the normal menu list. This means that you are basically 

building the list of commands available on the menu as you use Word. 

This personalized strategy is also employed by the toolbar system. As you use 

commands, they are added to the toolbar (this personalized toolbar feature is available 

only when you have the Standard toolbar and the Formatting toolbar on the same line in 

an application window). This provides you with customized menus and toolbars that are, 

in effect, personalized for you. 

To access a particular menu, follow these steps: 

1. Select the menu by clicking its title (such as View), as shown in Figure 1.3. The 

most recently used commands appear; wait just a moment for all the commands 

on a particular menu to appear (if the commands do not appear, click the down 

arrow at the bottom of the menu). 

 

2. Figure 1.3. Select a particular menu to view, and then point to a Word 

command. 
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1. Select the command on the menu that invokes a particular feature (such as Header 

and Footer). 

You will find that many of the commands found on Word's menus are followed by an 

ellipsis (…). These commands, when selected, open a dialog box that requires you to 

provide Word with additional information before the particular feature or command can 

be used. More information about understanding dialog boxes is included later in this 

lesson. 

Some of the menus also contain a submenu or cascading menu from which you make 

choices. The menu commands that produce a submenu are indicated by an arrow to the 

right of the menu choice. When a submenu is present, you point at the command (marked 

with the arrow) on the main menu to open the submenu. 

The menu system itself provides a logical grouping of the Word commands and features. 

For example, commands related to files, such as Open, Save, and Print, are all found on 

the File menu. 

Activating Menus with the Keyboard You can activate a particular menu by 

holding down the Alt key and then pressing the keyboard key that matches the 

underscored letter in the menu's name. This underscored letter is called the 

hotkey. For example, to activate the File menu in Word, press Alt+F. 

 

If you find that you would rather have access to all the menu commands (rather than 

accessing only those you've used recently), you can turn off the personalized menu 

system. To do this, follow these steps: 

1. Click the Tools menu, and then click Customize. 

2. In the Customize dialog box, click the Options tab. 

3. To show all the commands on the menus, click the Always Show Full Menus 

check box. 

4. Click OK to close the dialog box. 

 

Shortcut Menus 

A fast way to access commands related to a particular document element is to select that 

document object and then right-click. This opens a shortcut menu that contains 

commands related to the particular object with which you are working. 

Object Any element found in a document, such as text, a graphic, a hyperlink, or other 

inserted item. 



For example, if you select a line of text in a document, right-clicking the selected text 

(see Figure 1.4) opens a shortcut menu with commands such as Cut, Copy, and Paste, or 

it provides you with quick access to formatting commands, such as Font and Paragraph. 

Figure 1.4. By right-clicking areas in Word, you can use shortcut menus to 

quickly access Word commands related to the item that was clicked. 

 

Word Toolbars 

The Word toolbars provide a very quick and straightforward way to access often-used 

commands and features. When you first start Word, the Standard and Formatting toolbars 

reside as one continuous toolbar found directly below the menu bar (as shown in Figure 

1.2). You can quickly place the Standard and Formatting toolbars in their own row by 

selecting the Toolbar Options button on either toolbar, and then selecting Show Buttons 

on Two Rows (as shown in Figure 1.3 and 1.4). 

To access a particular command using a toolbar button, click the button. Depending on 

the command, you see either an immediate result in your document (such as the removal 

of selected text when you click the Cut button) or the appearance of a dialog box 

requesting additional information from you. 

Finding a Toolbar Button's Purpose You can place (hover but do not click) the mouse 

pointer on any toolbar button to view a description of that tool's function. If you also 

want to see the shortcut keys associated with a toolbar button, select Show Shortcut Keys 

in ScreenTips on the Options tab of the Customize dialog box. 
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tools that enable you to draw graphical elements in your documents (such as text boxes, 

lines, and rectangles). 

To place additional toolbars in the Word window, right-click any toolbar currently shown 

and select from the list that appears. Specific toolbars exist for working with tables, 

pictures, other Word features, and the World Wide Web. 

You can also easily add or remove buttons from any of the toolbars present in the Word 

window. Each toolbar is equipped with a Toolbar Options button that you can use to 

modify the buttons shown on that particular toolbar. 

To add or remove buttons from a specific toolbar, follow these steps: 

1. Click the Toolbar Options button on any toolbar; a drop-down area appears. 

2. Click Add or Remove Buttons and then select the name of the toolbar that appears 

on the pop-up menu. A list of all the buttons for the current toolbar appears, as 

shown in Figure 1.5. 

3. Figure 1.5. You can easily add or remove buttons from a toolbar using 

the button list. 

 

 

1. For a button to appear on the toolbar, a check mark must appear to the left of the 

button in this list. For buttons without a check mark next to them, clicking this 
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space puts the button on the toolbar. These buttons work as toggle switches; one 

click adds the check mark, another click removes it. 

2. When you have completed your changes to the current toolbar, click outside the 

button list to close it. 

The Word toolbars provide fast access to the commands you need most often. Buttons 

exist for all the commands that are available on the Word menu system. 

Exiting Word 

When you have completed your initial survey of the Word application window or 

whenever you have completed your work in the program, you will want to exit the 

software. More than one way exists to close the Word window, which is the same as 

exiting the program. 

You can exit Word by selecting the File menu and then Exit. Or you can close Word with 

one click of the mouse by clicking the Word Close (X) button in the upper-right corner of 

the application window. 

When you close Word, you might be prompted to save any work that you have done in 

the application window. If you were just experimenting as you read through this lesson, 

you can click No. The current document will not be saved, and the Word application 

window closes. All the ins and outs of saving your documents are covered in Lesson 2, 

"Working with Documents." 

 

 

 

 

 

Chapter 2. Working with Documents 

In this lesson, you learn how to start a new document and enter text. You also learn how 

to take advantage of Word document templates and Word document wizards. 
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Starting a New Document 

When you choose to start a new document in Word, you can take three routes. You can 

• Create a blank new document using Word's default template. 

• Create a document using one of Word's many other templates or a custom one 

you created yourself. 

• Create a document using one of the Word wizards, such as the Fax or Envelope 

Wizard. 

• Create a document based on an existing document; using this method you are 

essentially opening a copy of an existing document, and you can then save it 

using a new filename. 

Templates and wizards allow you to create more complex documents such as newsletters 

or Web sites. When you want to create a simple document, your best bet is to open a new 

blank document. 

 

Template A blueprint for a document that may already contain certain formatting options 

and text. 

Wizard A feature that guides you step by step through a particular process in Word, such 

as creating a new document 

When you create a new document from scratch, you are actually using a template—the 

Blank Document template. Documents based on the Blank Document template do not 

contain any premade text (as some of the other templates do), and the formatting 

contained in the document reflects Word's default settings for margins, fonts, and other 

document attributes (including any you customized specifically to your needs or 

preferences). To find more information on default Word settings involving font and 

document attributes, see Lesson 5, "Changing How Text Looks," and Lesson 9, "Working 

with Margins, Pages, and Line Spacing," respectively). 

As covered in Lesson 1, Word automatically opens a new blank document for you when 

you open the Word application window. You can also open a new document when you 

are already working in Word. 

To open a new document, follow these steps: 

1. Select File, New. The New Document task pane opens on the right side of your 

screen. The task pane makes it easy for you to quickly create a new blank 

document, XML document (a document in the eXtensible Markup Language), 

Web page, or Email. For our purposes, let's look at available templates: under 

Other templates, select On My Computer. Word opens the Templates dialog box 

with a range of templates from which to choose (see Figure 2.1). 
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Figure 2.1. When you choose New on the File menu, the task pane opens 

and you can choose to open templates on your computer. 

 

 

1. Make sure that the General tab is selected in the Templates dialog box, and then 

double-click the Word Blank Document icon. A new document appears in the 

Word application window. 

Although the steps shown here are designed for you to create a new blank document, you 

could have chosen any of the templates available in the Templates dialog box to create a 

new document. The fastest way to create a new blank document is to click the New Blank 

Document icon on the Word Standard toolbar. 

 

What Happened to My Previous Document? If you were already working on a document, 

the new document will, in effect, open on top of the document you were previously 

working on. You can get back to the previous document by clicking the appropriately 

named document icon on the Windows taskbar (if you haven't yet named the first 

document, it might appear as Document1 on the taskbar). You can also select the 

Windows menu to see a list of currently opened documents. Click any document in the 

list to switch to it. 

Multiple Document Icons Are Grouped When you open a number of Word documents 

that exceed the number of single buttons that can be shown on the Windows Taskbar 



(which depends on your screen resolution), the document buttons are grouped under one 

Microsoft Word icon on the Taskbar. Click the single Word icon and a list of the 

currently open documents appears. As you close documents, the open documents remain 

grouped under the one icon until you close all but one of the documents (or all the 

documents by right-clicking on the Word icon and then selecting Close Group). 

Using Document Templates 

You don't have to base your new documents on a blank template. Instead, you can take 

advantage of one of the special document templates that Word provides. These templates 

make it easy for you to create everything from memos to newsletters. 

Templates contain special text and document attributes; therefore, the look and layout of 

the document you create using a template are predetermined by the options contained in 

the template. This can include margins, fonts, graphics, and other document layout 

attributes. 

To base a new document on a Word template, follow these steps: 

1. Select the File menu, and then click New. The task pane opens in your current 

document window. 

2. Several templates such as the Blank Document, Web Page, and XML Document 

templates, appear at the top of the New Document task pane. You can select any 

of these templates. Or you can use the Search box under Templates on 

Microsoft.com to search for online templates that Microsoft stores on the Office 

Web site. You can also select templates on your computer or templates held on 

other Web sites. To create a new memo from a template stored on your computer, 

click the On My Computer link under the Other Templates heading. 

3. In the Templates dialog box that appears, choose the Memos tab (see Figure 2.2). 

Select your favorite style of memo and click OK (or double-click the icon of 

choice). 

4. Figure 2.2. The document category tabs in the Templates dialog box 

contain templates for different document types. 
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1. The new document based on the template appears as shown in Figure 2.3. 

Figure 2.3. The new document contains predetermined text and 

formatting attributes derived from the template. 
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Most new documents based on templates already contain text, such as headings, and a 

variety of document layouts and text attributes, such as a particular font. For example, the 

document based on the Contemporary Memo template already contains the layout for a 

memo, and it automatically enters the current date in the memo for you. 

You can easily enter text into the document using the Click Here and Type boxes that are 

placed in the document. Just click anywhere on the bracketed boxes provided and type 

the text you want to enter. 

Many templates (the Contemporary Memo template, for example) contain text that gives 

you advice on how to use the template. Any of this explanatory text can be selected and 

removed or replaced with your own text (for more about selecting and editing text, see 

Lesson 3, "Editing Documents"). 

Using Word Wizards 

If you find that you would like even more help as you create a new document, you can 

use any of a number of Word document wizards. These wizards actually walk you 

through the document creation process, and in many cases, they make sure that you enter 

the appropriate text in the proper place in the new document. 

The wizards are found on the same tabs that housed the templates located in the 

Templates dialog box (reached through the task pane). The wizards can be differentiated 

from standard templates by a small wizard's wand that appears over the top right-hand 

corner of a template's icon. 

To create a new document using one of the wizards, follow these steps: 

1. Select the File menu, and then click New to open the New Document task pane. 

2. Under the Other Templates heading, select the On My Computer link. In the 

Templates dialog box that appears, choose the new document tab of your choice 

(only the Legal Pleadings, Letterhead & Faxes, Memos, and other Documents 

tabs provide wizards). 

3. To start the document creation process using the wizard, double-click the 

appropriate wizard icon (for example, the Memo Wizard on the Memos tab). 

When you double-click the wizard icon, the wizard dialog box opens with an introductory 

screen and outlines the document creation process for the type of document you want to 

create. For example, the Memo Wizard shown in Figure 2.4 details the memo creation 

process on the left side of the wizard dialog box. 

Figure 2.4. The various document wizards, such as the Memo Wizard, outline the new 

creation process and then walk you through the steps of creating the document 
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If you find that you need help as you work with a wizard, you can click the Office 

Assistant button on the wizard dialog box. The Office Assistant, which appears as an 

animated paper clip by default, appears with context-sensitive help related to the wizard 

screen on which you are currently working. If the button is not available, cancel the 

wizard, select the Help menu, and then Show the Office Assistant; then repeat the steps 

necessary to open the particular document wizard. 

To move to the next step in the document creation process, click the Next button at the 

bottom of the wizard screen. 

The various document wizards walk you through the entire document creation process. 

After completing the steps for document creation, click the Finish button to close the 

wizard. A new document appears in the Word window based on the choices you made as 

you worked with the wizard. Figure 2.5 shows a new document created using the Memo 

Wizard. 

Figure 2.5. The Memo Wizard prompts you to input the appropriate information 

for a memo and provides the formatting for the new document. 
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The wizards you use vary in look and feel, depending on the type of document you are 

trying to create. For example, the Resume Wizard produces a decidedly different product 

than the Envelope Wizard does. A good rule to follow is to read each wizard screen 

carefully. Remember that you can always back up a step by clicking the Back button if 

you find that you've made an inappropriate choice (or you can close the unwanted 

document and start over). 

Creating a New Document From an Existing Document 

A new option that Word provides is the ability to quickly create a copy of an existing 

document. This allows you to open the existing document but have Word treat it as a new 

document without a filename. You can then edit the text and other items in the document 

as needed. 

To create a new document from an existing document, click File, then New. The New 

Document task pane opens. Select the From Existing Document link under the New 

heading. The New from Existing Document dialog box opens (see Figure 2.6). 

 

Figure 2.6. The New from Existing Document dialog box allows you to create a 

new document from an existing one. 
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Use the Look In drop-down box to specify the drive where the file is located. Then 

double-click to open the appropriate folder. Select the file and then click Create New in 

the bottom right of the dialog box. A new document will open, which is a copy of the 

document you specified in the New from Existing Document dialog box. After making 

changes to the new document, you will want to save it under a new document name. The 

next section discusses saving a new document. 

 

Saving a Document 

Whether you create your new document using the Blank Document template, a Word 

template, a document wizard, or from an existing document, at some point you will want 

to save the new document. Saving your work is one of the most important aspects of 

working with any software application. If you don't save your Word documents, you 

could lose them 

Save and Save Often You don't want to lose your valuable documents as you create them 

in Word. Power failures, an accidentally kicked-out power cord, or your computer 

locking up as you work can all lead to lost work. If you are really absent-minded about 

periodically saving your work, use the AutoSave feature. Select the Tools menu, then 

Options. Click the Save tab on the dialog box. Make sure the Save AutoRecover Info 

Every check box is selected. Use the minutes box to set the time interval between 

autosaves. This feature doesn't replace periodically saving your document using the Save 



command, but it will help you recover more of your document if there is a problem such 

as a power failure. I suggest setting AutoRecover to 10 or 15 minutes 

 

To save a document, follow these steps 

1. Click the Save button on the Word toolbar, or select the File menu and then Save. 

The first time you save your new document, the Save As dialog box appears. 

2. Type a filename into the File Name box. If you want to save the file in a format 

other than a Word document (.doc), such as a text file (.txt), click the Save As 

Type drop-down arrow and select a different file type. 

3. To save the file to a different location (the default location is My Documents), 

click the Save In drop-down arrow. After you select a particular drive, all the 

folders on that drive appear. 

4. Double-click the desired folder in the Save In box to open that folder. 

5. After you have specified a name and a location for your new document, select the 

Save button to save the file. Word then returns you to the document window. 

As you edit and enhance your new document, you should make a habit of frequently 

saving any changes that you make. To save changes to a document that has already been 

saved under a filename, just click the Save button. 

If you would like to keep a backup of a document (the version as it appeared the last time 

you saved it) each time you save changes to it, you need to set the backup option. 

1. Click the Tools command on the toolbar, and then select Options. 

2. In the Options dialog box, click the Save tab and then the Always Create Backup 

Copy check box. Click OK to return to the document. 

3. Name your file and save it for the first time to an appropriate location such as My 

Documents or another folder on your computer or your network. 

Now, when you use the Save command to save changes you've made to the document, a 

backup copy of the file (with the extension .wbk) is also saved. This backup copy is the 

previous version of the document before you made the changes. Each subsequent saving 

of the document replaces the backup file with the previous version of the document. 

Occasionally, rather than using the backup option, you might want to save the current 

document under a new filename or drive location. You can do this using the Save As 

command. To save your document with a new filename, follow these steps: 

1. Select File, Save As. 

2. In the Save As dialog box, type the new filename into the File Name box (make 

sure that you are saving the document in the desired path). 

3. Click Save. The file is saved under the new name 



Closing a Document 

When you have finished working with a document, you need to save your changes and 

then close the document. To close a document, select the File menu and then select Close. 

You can also close a document by clicking the Close (X) button on the right side of the 

document window. If you are working with multiple documents, closing one of the 

documents does not close the Word application. If you want to completely end your 

Word session, select the File menu, and then select Exit. Before closing a document, 

Word checks to see whether it has changed since it was last saved. If it has, Word asks 

whether you want to save these changes before closing. If you don't want to lose any 

recent changes, click Yes to save the document. 

Opening a Document 

Opening an existing document is a straightforward process. You will find that the Open 

dialog box shares many of the attributes that you saw in the Save As dialog box. 

To open an existing Word file, follow these steps 

1. Select the File menu, and then Open (or click the Open button on the Standard 

toolbar). The Open dialog box appears. 

2. By default, Word begins showing the files and folders in your My Documents 

folder. If the document you need is located elsewhere on your computer, click the 

Look In drop-down arrow to select the drive on which the file is located, and 

navigate to the folder containing the document you need. 

3. To open the file, click the file, and then click the Open button (you can also 

double-click the file). The file appears in a Word document window. 

If you are working with text files or documents that have been saved in a format other 

than the Word document format (.doc), you must select the file type in the Files of Type 

drop-down box to see them. 

 

Adding or Replacing Text and Moving in the Document 

After you have completed a draft of your document, you will find yourself in a situation 

where you want to add and delete text in the document as you edit your work. Word 

makes it very easy for you to add new text and delete text that you don't want. You also 

will find that, whether you use the mouse or the keyboard to move around in your 

document as you edit, Word offers a number of special keystrokes and other tricks that 

make moving within the document a breeze. 

The primary tool for placing the insertion point into a document that already contains text 

using the mouse is the I-beam. It looks like an uppercase "I." Place it anywhere in the 
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document and click the left mouse button. This places the insertion point in the document 

at the I-beam's current position. 

I-beam This is the shape that the mouse pointer takes when you place it over any text in a 

Word document. Use it to place the insertion point at a particular position in a document. 

Adding New Text 

You actually have two possibilities for adding text to the document: insert and typeover. 

To insert text into the document and adjust the position of the existing text, place the I-

beam where you want to insert the new text. Click the mouse to place the insertion point 

at the chosen position. Make sure that the OVR indicator on the Status bar near the 

bottom of the screen is not active (it will be gray rather than bolded). This means that you 

are in the insert mode. 

Insert Mode The default text mode in Word. New text is added at the insertion 

point and existing text is pushed forward in the document so that it remains as 

part of the document. 

 

Type your new text. It is added at the insertion point, and existing text (the text to the 

right of the inserted text) is pushed forward in the document. 

Replacing Text with Typeover 

If you want to add new text to a document and simultaneously delete text to the right of 

the insertion point, use the mouse to place the insertion point where you want to start 

typing over the existing text. Press the Insert key on the keyboard and add your new text. 

The added text types over the existing text, deleting it (see Figure 3.1). When you switch 

to Typeover mode using the Insert key, the Word status bar displays the message OVR. 

This means that you are currently in Typeover mode. 

Figure 3.1. When you are in Typeover mode, existing text is overwritten by the 

new text. 

 

 

Typeover Mode Press the Insert key to enter this mode; new text is added at the 

insertion point and types over the existing text, deleting it. 
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If you want to return to Insert mode, press the Insert key again (it toggles Word between 

the Insert and Typeover modes) and the OVR message on the status bar is dimmed (you 

can also double-click OVR on the status bar to toggle this feature on and off). 

Moving Around the Document 

Whether you are a mouse aficionado or prefer to stick close to your keyboard, Word 

provides several shortcuts and tools for moving around a document that you are trying to 

edit. 

When you use the mouse, you can move to a different position on the current page by 

using the I-beam. You also can use the mouse to move through your document using the 

vertical and horizontal scrollbars. For example, clicking the up scroll arrow on the 

vertical scrollbar moves you up through the document. Clicking the down scroll arrow 

moves you down through the document. If you want to quickly move to a particular page 

in the document, you can drag the scroll box to a particular place on the vertical scrollbar. 

As soon as you click on the scroll box, a page indicator box appears that you can use to 

keep track of what page you are on as you drag the scroll box up or down on the vertical 

scrollbar. 

The vertical scrollbar also provides Previous Page and Next Page buttons (the double-up 

arrow and double-down arrow buttons on the bottom of the scrollbar) that can be used to 

move to the previous page and next page, respectively. Use the mouse to click the 

appropriate button to move in the direction that you want to go in your document. 

The horizontal scrollbar operates much the same as the vertical scrollbar; however, it 

offers the capability to scroll only to the left and the right of a document page. This is 

particularly useful when you have zoomed in on a document and want to scrutinize an 

area of the page in great detail. 

You should be aware that clicking the mouse on the vertical scrollbar to change your 

position in a document allows you to view a different portion of a page or a different part 

of the document; however, it does not move the insertion point to that position on the 

page. To actually place the insertion point, you must move to a specific place or position 

in the document, and then click the mouse I-beam where you want to place the insertion 

point. 

When you're typing or editing text, you might find that the fastest way to move through 

the document is with the help of the keyboard shortcuts shown in Table 3.1. Keeping 

your hands on the keyboard, rather than reaching out for the mouse, can be a more 

efficient way to move in a document while you compose or edit 

Scroll Quickly with a Wheel Mouse You might want to purchase a wheel mouse, such as 

Microsoft's IntelliMouse, which provides a rolling device on the top of the mouse 

(between the click buttons). With your finger on the wheel device, you can literally "roll" 

the vertical scrollbar through the document at the pace of your choice—rapidly or slowly. 
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Table 3.1. Using the Keyboard to Move Through the 

Key Combination Movement 

Home Move to the beginning of a line 

End Move to the end of a line 

Ctrl+Right arrow Move one word to the right 

Ctrl+Left arrow Move one word to the left 

Ctrl+Up arrow Move to the previous paragraph 

Ctrl+Down arrow Move to the next paragraph 

PgUp Move up one window 

PgDn Move down one window 

Ctrl+PgUp Move up one page 

Ctrl+PgDn Move down one page 

Ctrl+Home Move to the top of a document 

Ctrl+End document 

Selecting Text 

Having a good handle on the different methods for selecting text in a document makes it 

easy for you to take advantage of many features, including deleting, moving, and 

formatting text. You can select text with either the mouse or the keyboard. Both methods 

have their own advantages and disadvantages as you work on your documents 

Selecting Text with the Mouse 

The mouse is an excellent tool for selecting text in your document during the editing 

process. You can double-click a word to select it and also use different numbers of mouse 

clicks (quickly pressing the left mouse button) or the mouse in combination with the Shift 

key to select sentences, paragraphs, or other blocks of text. You also can hold the left 

mouse button down and drag it across a block of text that you want to select. 

How you use the mouse to select the text depends on whether the mouse pointer is in the 

document itself or along the left side of the document in the selection bar. The selection 

bar is the white space on the left edge of your document window, just in front of your text 

paragraphs. When you place the mouse in the selection bar, the mouse pointer becomes 

an arrow (in contrast to placing the mouse in the document where the pointer appears as 

an I-beam). 



Selecting text lines and paragraphs from the selection bar makes it easy for you to 

quickly select either a single line or the entire document. Table 3.2 shows you how to 

select different text items using the mouse. Figure 3.2 shows the mouse pointer in the 

selection bar with a selected sentence. 

Figure 3.2. Place the mouse pointer in the selection bar to quickly select a line, a 

paragraph, or other text block. 

 

 

Text Selection Mouse Action 

Selects the word Double-click a word 

Selects text block Click and drag 

 or 

 Click at beginning of text, and then hold down the Shift key and 

click at the end of text block 

Selects line Click in selection bar next to line 

Selects multiple 

lines 

Click in selection bar and drag down through multiple lines 
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Text Selection Mouse Action 

Selects the 

sentence 

Hold Ctrl and click a sentence 

Selects paragraph Double-click in selection bar next to paragraph 

 or 

 Triple-click in the paragraph 

Selects entire 

document 

Hold down Ctrl and click in selection bar 

 

You will find these mouse manipulations are particularly useful when you are editing the 

document. Selected text can be quickly deleted, moved, or copied. 

Selecting Text with the Keyboard 

You can also select text using only the keyboard. Press the F8 function key to turn on the 

extend (or select) feature; the EXT indicator becomes active on the Word status bar as 

soon as you press one of the arrow keys on the keyboard (meaning it is no longer 

"grayed" out). 

To select text using the extend feature, use the arrow keys to move over and highlight 

characters, words, or sentences you want to select. You can quickly select entire words 

by placing the insertion point at the beginning of a word, pressing F8 and then pressing 

the spacebar. To select an entire sentence, turn on the extend feature, and then press the 

period (.) key. You can select entire paragraphs using this method by pressing the Enter 

key. To turn off the extend feature, press the Esc key. 

Finally, you can select text by pressing only the F8 function key. Press F8 once to turn on 

the select feature where you want it, press it twice to select a word, three times to 

highlight an entire sentence, four times to select a paragraph, and five times to select your 

entire document. 

Deleting, Copying, and Moving Text 

Another important aspect of editing is being able to delete, move, or copy text in your 

document. Each of these tasks can be easily accomplished in Word and uses the mouse or 

the keyboard to select the text that you want to delete, move, or copy. Then, it's just a 

matter of invoking the correct command to delete, move, or copy the selected text. 



Deleting Text 

Deleting text can be accomplished in more than one way. The simplest way to remove 

characters as you type is with the Backspace key or the Delete key. If no text is selected, 

these keys work like this: 

• Delete— Deletes the character to the right of the insertion point. 

• Backspace— Deletes the character to the left of the insertion point. 

You will probably find, however, that when you delete text you want to remove more 

than just one character, so use the keyboard or the mouse to select the text you want to 

delete. After the text is selected, press the Delete key. The text is then removed from the 

document. 

You can also delete text and replace it with new text in one step. After the text is selected, 

type the new text. It replaces the entire existing, selected text. 

Delete and Cut Are Different When you want to erase a text block forever, use the Delete 

key. When you want to remove text from a particular place in the document but want to 

have access to it again to place it somewhere else, use the Cut command on the Edit 

menu. When you cut an item, it is automatically placed on the Office Clipboard. These 

steps are covered later in this lesson. 

Copying, Cutting, and Pasting Text 

Copying or cutting text and then pasting the copied or cut item to a new location is very 

straightforward. All you have to do is select the text as we discussed earlier in this lesson 

and then invoke the appropriate commands. Use the following steps to copy and paste 

text in your document: 

1. Using the mouse or the keyboard, select the text that you want to copy. 

2. Select the Edit menu, and then select Copy, or press Ctrl+C to copy the text. 

3. Place the insertion point in the document where you want to place a copy of the 

copied text. 

4. Select the Edit menu and then select Paste, or press Ctrl+V. A copy of the text is 

inserted at the insertion point. 

After you paste your selected text, the Paste Smart Tag icon appears just below the text 

that you have pasted. When you click this icon, it provides a shortcut menu that allows 

you to keep the formatting that was applied to the source text that you copied, match the 

formatting supplied by the destination for the text (the paragraph you are placing the text 

in), or just paste the text into the new location with no formatting at all (which means it 

will assume the formatting that is provided at the current location). Figure 3.3 shows the 

Paste Smart Tag provided for pasted text. 
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Figure 3.3. The Paste Smart Tag allows you to choose how the text is pasted into 

the new location. 

 

 

What Are Smart Tags? Smart Tags are shortcuts that are assigned to particular 

types of information in a Word document. For example, you will see that 

people's names are labeled with a smart tag (a purple dotted line below the text) 

that makes it easy to add a person to your Outlook Contact folder. Text that has 

been pasted to a new location is also flagged with a smart tag that makes it easy 

to format the pasted text. 

 

Cutting text from the document and then pasting it to a new location is every bit as 

straightforward as using copy and paste. Select the text, and then press Ctrl+X or click 

the Cut button on the Standard toolbar. Click the I-beam to place the insertion point on 

the document, and then you can use Ctrl+V or the Paste button on the Standard toolbar to 

place the text in a new location. A Paste Smart Tag will appear below the pasted text as 

shown in Figure 3.3. 

Using the Office Clipboard to Copy and Move Multiple Items 

The Office Clipboard feature now resides in the task pane of your Office application 

windows as discussed in Lesson 3, "Using the Office Task Pane," which is found in Part I 
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of this book. If you want to copy or cut more than one item and then be able to paste 

them into different places in the document, you must use the Office Clipboard. Follow 

these steps: 

1. To open the Clipboard task pane, select the Edit menu and select Office 

Clipboard. The Clipboard appears in the task pane. 

2. As shown in Figure 3.4, select and copy each item to the Clipboard. 

3. Figure 3.4. The Clipboard can hold up to 24 separate items. 

 

1. After you have copied your items onto the Clipboard, place the insertion point 

where you want the first item to be pasted. Then, return to the Clipboard and with 

the mouse, point to your first item and click; Word automatically inserts the item 

into the document. 

2. Repeat step 3 as needed to paste other items from the Clipboard into your 

document. 

If you want to cut and paste (or move) multiple items, you must use the Office Clipboard. 

Follow these steps: 

1. To open the Clipboard, select the Edit menu and select Clipboard. The Clipboard 

appears in the task pane. 

2. Select and cut each item to the Clipboard. 
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3. After you have your cut items on the Clipboard, place the insertion point where 

you want the first item to be pasted. Then, return to the Clipboard and with the 

mouse, point to your first item and click; it will automatically be inserted into the 

document. 

4. Repeat step 3 as needed to paste other items from the Clipboard into your 

document. 

 

 

 



Deleting, Copying, and Moving Text 

Another important aspect of editing is being able to delete, move, or copy text in your 

document. Each of these tasks can be easily accomplished in Word and uses the mouse or 

the keyboard to select the text that you want to delete, move, or copy. Then, it's just a 

matter of invoking the correct command to delete, move, or copy the selected text. 

Deleting Text 

Deleting text can be accomplished in more than one way. The simplest way to remove 

characters as you type is with the Backspace key or the Delete key. If no text is selected, 

these keys work like this: 

• Delete— Deletes the character to the right of the insertion point. 

• Backspace— Deletes the character to the left of the insertion point. 

You will probably find, however, that when you delete text you want to remove more 

than just one character, so use the keyboard or the mouse to select the text you want to 

delete. After the text is selected, press the Delete key. The text is then removed from the 

document. 

You can also delete text and replace it with new text in one step. After the text is selected, 

type the new text. It replaces the entire existing, selected text. 

 

Delete and Cut Are Different When you want to erase a text block 

forever, use the Delete key. When you want to remove text from a 

particular place in the document but want to have access to it again to 

place it somewhere else, use the Cut command on the Edit menu. 

When you cut an item, it is automatically placed on the Office 

Clipboard. These steps are covered later in this lesson. 

 

Copying, Cutting, and Pasting Text 

Copying or cutting text and then pasting the copied or cut item to a new location is very 

straightforward. All you have to do is select the text as we discussed earlier in this lesson 

and then invoke the appropriate commands. Use the following steps to copy and paste 

text in your document: 

1. Using the mouse or the keyboard, select the text that you want to copy. 

2. Select the Edit menu, and then select Copy, or press Ctrl+C to copy the text. 

3. Place the insertion point in the document where you want to place a copy of the 

copied text. 

4. Select the Edit menu and then select Paste, or press Ctrl+V. A copy of the text is 



inserted at the insertion point. 

 

Use the Copy, Cut, and Paste Icons To quickly access the 

copy, cut, and paste features, use the Copy, Cut, and Paste icons on the 

Word toolbar, respectively. 

 

After you paste your selected text, the Paste Smart Tag icon appears just below the text 

that you have pasted. When you click this icon, it provides a shortcut menu that allows 

you to keep the formatting that was applied to the source text that you copied, match the 

formatting supplied by the destination for the text (the paragraph you are placing the text 

in), or just paste the text into the new location with no formatting at all (which means it 

will assume the formatting that is provided at the current location). Figure 3.3 shows the 

Paste Smart Tag provided for pasted text. 

Figure 3.3. The Paste Smart Tag allows you to choose how the text is pasted into 

the new location. 

 

 

What Are Smart Tags? Smart Tags are shortcuts that are assigned to 

particular types of information in a Word document. For example, you 

will see that people's names are labeled with a smart tag (a purple 

dotted line below the text) that makes it easy to add a person to your 

Outlook Contact folder. Text that has been pasted to a new location is 

also flagged with a smart tag that makes it easy to format the pasted 

text. 
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Cutting text from the document and then pasting it to a new location is every bit as 

straightforward as using copy and paste. Select the text, and then press Ctrl+X or click 

the Cut button on the Standard toolbar. Click the I-beam to place the insertion point on 

the document, and then you can use Ctrl+V or the Paste button on the Standard toolbar to 

place the text in a new location. A Paste Smart Tag will appear below the pasted text as 

shown in Figure 3.3. 

Using the Office Clipboard to Copy and Move Multiple Items 

The Office Clipboard feature now resides in the task pane of your Office application 

windows as discussed in Lesson 3, "Using the Office Task Pane," which is found in Part I 

of this book. If you want to copy or cut more than one item and then be able to paste 

them into different places in the document, you must use the Office Clipboard. Follow 

these steps: 

1. To open the Clipboard task pane, select the Edit menu and select Office 

Clipboard. The Clipboard appears in the task pane. 

2. As shown in Figure 3.4, select and copy each item to the Clipboard. 

Figure 3.4. The Clipboard can hold up to 24 separate items. 
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3. After you have copied your items onto the Clipboard, place the insertion point 

where you want the first item to be pasted. Then, return to the Clipboard and with 

the mouse, point to your first item and click; Word automatically inserts the item 

into the document. 

4. Repeat step 3 as needed to paste other items from the Clipboard into your 

document. 

If you want to cut and paste (or move) multiple items, you must use the Office Clipboard. 

Follow these steps: 

1. To open the Clipboard, select the Edit menu and select Clipboard. The Clipboard 

appears in the task pane. 

2. Select and cut each item to the Clipboard. 

3. After you have your cut items on the Clipboard, place the insertion point where 

you want the first item to be pasted. Then, return to the Clipboard and with the 

mouse, point to your first item and click; it will automatically be inserted into the 

document. 

4. Repeat step 3 as needed to paste other items from the Clipboard into your 

document. 



 

Open the Task Pane from the View Menu You can also open the task 

pane by selecting View and then Task Pane. Then use the Other Task 

Panes drop-down list to select the task pane you want to use such as 

the Clipboard. 

 

Using Drag and Drop 

One other way to move text is by selecting it and dragging it to a new location. This is 

called drag and drop. After the text is selected, place the mouse on the text block and 

hold down the left mouse button. A Move pointer appears, 

 

 

 

Copying and Moving Text Between Documents 

You can copy text easily between documents. All you have to do is open the appropriate 

documents and then use the methods already discussed for copying or moving text. You 

can even use drag and drop to move information from one document to another. 

To copy information from one document to another, follow these steps: 

1. Open the document you want to copy information from and the one you want to 

copy that information to (see Lesson 2, "Working with Documents," for more 

information on opening documents). 

2. Switch to the document that contains the text you want to copy by clicking the 

document's button on the Taskbar or selecting the Windows menu and then the 

name of the document. 

3. Select the text you want to copy, select the Edit menu, and then select the Copy 

command. 
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4. Using the instructions in step 2, switch to the document into which you want to 

paste the text. 

5. Select the Edit menu, and then select Paste. The text is pasted into your document. 

You can also use the preceding steps to move text from one document to another by 

substituting the Cut command for the Copy command. You can also use drag and drop to 

move text from one document to another. Working with multiple document windows can 

be tricky. You probably won't want to have more than two documents open if you want to 

use drag and drop, because you won't have enough space in the Word workspace to scroll 

through the documents and find the text you want to move or the final resting place for 

the text in the other document. 

To view multiple document windows (all the documents you currently have open), select 

the Window menu and then select Arrange All. Each document is placed in a separate 

window in the Word workspace. The windows might be small if you have several 

documents open. Locate the text you want to move and select it. Drag it from the current 

document window to the document window and position where you want to place it. 

You can also use the preceding steps to move text from one document to another by 

substituting the Cut command for the Copy command. You can also use drag and drop to 

move text from one document to another. Working with multiple document windows can 

be tricky. You probably won't want to have more than two documents open if you want to 

use drag and drop, because you won't have enough space in the Word workspace to scroll 

through the documents and find the text you want to move or the final resting place for 

the text in the other document. 

To view multiple document windows (all the documents you currently have open), select 

the Window menu and then select Arrange All. Each document is placed in a separate 

window in the Word workspace. The windows might be small if you have several 

documents open. Locate the text you want to move and select it. Drag it from the current 

document window to the document window and position where you want to place it. 

Keep Your Business Documents Standard The standard point size for most 

business documents is 12 points, which is 1/6 of an inch tall. So, when selecting 

a new font, it's generally a good idea to make sure that you use 12 points for 

documents such as business letters and memos. 

 

You can change the font or fonts used in a document whenever you need to, and you can 

also manipulate the size of the characters and their attributes, including bold, underlining, 

and italic. You can select a new font before you begin typing your document, or you can 

select text and change its fonts and text attributes at any time. 



Changing Font Attributes 

The easiest way to change font attributes is through the use of the buttons provided on the 

Word Formatting toolbar. Figure 5.1 shows the Word Formatting toolbar with some of 

the most common font attribute buttons displayed. 

Figure 5.1. The Word Formatting toolbar gives you quick access to control the font 

attributes in your documents 

 

 

 

You can quickly change the font of selected text by clicking the Font box and selecting a 

new font from the list that appears. Other attributes, such as bold, italic, and underline, 

require that you select the text and then click the appropriate button once to add that 

attribute to the text. For example, you might want to apply special formatting to a 

heading so that it stands out from the rest of the text. You can do that by adding bold to 

the text. 

To add bold to text in a document, follow these steps: 

1. Select the word or other text to be bold. 

2. Click the Bold button on the Formatting toolbar. The text appears in bold. 

3. Click any other part of the document to deselect the text and view the results of 

your formatting. 

You can use this same technique to underline and italicize text in your documents 

You can also use the various font buttons to select font attributes for the new text you 

type into a new document or insert into an existing document. Select the appropriate font 

attributes on the Formatting toolbar, and then type the text. To turn off a particular 

attribute, such as bold or italic, click the appropriate button a second time. To change to a 

new font or size, use the appropriate drop-down box. 

When you are typing in a document, you might find that selecting font attributes from the 

toolbar actually slows you down because you must remove one hand from the keyboard 

to use the mouse to make your selection. You can also turn on or off a number of the 
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formatting attributes using shortcut keys on the keyboard. Table 5.1 shows some of the 

common keyboard shortcuts for formatting attributes. 

Table 5.1. Font Attribute Shortcut Keys 

Attribute Shortcut Keys 

Bold Ctrl+B 

Italic Ctrl+I 

Underline Ctrl+U 

Double underline Ctrl+Shift+D 

Subscript Ctrl+equal sign (=) 

Superscript Ctrl+Shift+plus sign (+) 

To use any of the shortcut key combinations, press the keys shown simultaneously to turn 

the attribute on, and then repeat the key sequence to turn the attribute off. For example, to 

turn on bold while you are typing, press the Ctrl key and the B key at the same time. 

Press these keys again to turn the bold off. 

Working in the Font Dialog Box 

Although the Formatting toolbar certainly provides the quickest avenue for controlling 

various font attributes, such as the font and the font size, you can access several more 

font attributes in the Font dialog box. The Font dialog box gives you control over 

common attributes, such as font, font size, bold, and so on, and it also provides you with 

control over special font attributes, such as superscript, subscript, and strikethrough. 

To open the Font dialog box, click the Format menu, and then select Font. The Font 

dialog box appears, 

Figure 5.2. The Font dialog box provides you with control over several font attributes not 

found on the Formatting toolbar. 
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As you can see, the Font dialog box enables you to choose from several font attributes. 

You can control the font, the font style, and other character attributes such as 

strikethrough, superscript, and shadow. 

• To change the font, click the Font drop-down box and select the new font by 

name. 

• To change the font style to italic, bold, or bold italic, make the appropriate 

selection in the Font Style box. 

• To change the size of the font, select the appropriate size in the Size scroll box. 

• For underlining, click the Underline Style drop-down box and select an 

underlining style. 

• To change the color of the font, click the Font Color drop-down box and select a 

new color. 

• To select any special effects, such as strikethrough, superscript, or shadow, select 

the appropriate check box in the lower half of the dialog box. 



As you make the various selections in the Font dialog box, a sample of what the text will 

look like appears in the Preview box at the bottom of the dialog box. After you have 

made all your selections in the Font dialog box, click OK. 

Aligning Text 

Another important basic attribute of the text in your documents is how that text is 

oriented on the page. When you first start typing in a new document, all the text begins at 

the left margin and moves to the right as you type; this means the text is left-justified 

using the default align left feature. Left-justified text is characterized by text that is 

straight or unvarying on the left margin but has a ragged right-edged margin. 

Text that serves a special function in a document, such as a heading, would probably 

stand out better in the document if it is placed differently than the rest of the text. Word 

makes it easy for you to change the alignment of any text paragraph. Several alignment 

possibilities are available: 

• Align Left— The default margin placement for normal text, aligned on the 

left. 

• Align Right— Text is aligned at the right margin and text lines show a ragged 

left edge. 

• Center— The text is centered between the left and right margins of the page 

(with both margins having irregular edges). 

• Justify— The text is spaced irregularly across each line so that both the left 

and the right margins are straight edged and uniform (often used in printed 

publications such as the daily newspapers). 

You can align the text in your document to suit your particular needs on a document page 



 

 

The easiest way to change the alignment of text in the document is to use the alignment 

buttons on the Formatting toolbar. Also, a button exists in the Paragraph dialog box for 

each of the alignment possibilities. 

These justification buttons can be used to align new text or selected text. Again, if you 

are typing new text with a particular justification, your selected justification will still be 

in force even after you press Enter. You must change the justification as needed. 

Using Borders and Colors 

In this lesson, you learn how to use borders and colors to emphasize text in your 

documents. 

Adding Borders in Word 

In Lesson 5, "Changing How Text Looks," you learned that you can use various font 

attributes, such as font size, bold, italic, and underline, to emphasize and otherwise 

denote certain text in your document. You also learned that alignment, such as centering, 

can be used to set off certain text lines on a page. Word provides you with the capability 

to add borders to your text and even place a shadow on the edge of a border for greater 

emphasis. You can add borders to text on a page or to an entire page. 
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Adding Borders to Text 

A border can be placed around any text paragraph (any line followed by a paragraph 

mark). This means that one line of text or several lines of text can have a border placed 

around them. 

Remember How Word Views a Paragraph Whenever you type a line or 

several lines of text and then press Enter, you are placing an end-of-paragraph 

mark at the end of the text. Word views any line or lines followed by a 

paragraph mark as a separate paragraph. If you need to view the paragraph 

marks in your document, click the Show/Hide button on the Word Standard 

toolbar. 

 

To place a border around a text paragraph, follow these steps: 

1. Place the insertion point in the paragraph that you want to place the border 

around. If you want to place a border around multiple paragraphs, select all the 

paragraphs. 

2. Select the Format menu, and then Borders and Shading. The Borders and Shading 

dialog box appears,. 

 

1. Figure 6.1. The Borders and Shading dialog box enables you to place a 

border around your text. 



 

 

1. Make sure the Borders tab is selected on the dialog box. You are provided with 

several settings for how the border should appear around the text. 

2. In the Setting area of the dialog box, select the type of box you want around your 

text; choose Box, Shadow, 3-D, or Custom by clicking the appropriate setting 

sample. The Custom option enables you to create a border that uses different line 

styles for the various sides of the border. 

3. Several line styles are available for your border. Click the Style scroll box to 

scroll through the various line styles, and then click the style you want to use. 

4. To change the color of the border lines, click the Color drop-down arrow and 

select a color from the color palette that appears. 

5. As you select the various parameters for your border (in cases where you have 

selected Box, Shadow, or 3-D as the border setting), you can view a preview of 

the border in the Preview box. The Preview box also makes it easy for you to 

place an incomplete border around a paragraph in cases where you might only 

want a line above or below the text (refer to Figure 6.1). 

6. When you have finished selecting the settings for the border, click the OK button. 

The border appears around the paragraph or paragraphs in the document, 
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Placing a Border Around a Page 

If you find that you would like to place a border around an entire page or pages in your 

document, you need to use the Page Border feature. 

Follow these steps to place a border around the entire page: 

1. Open the Borders and Shading dialog box (click the Format menu and select 

Borders and Shading) and click the Page Border tab (see Figure 6.4). 

2. Figure 6.4. Borders can be placed around an entire page. 

 

1. Select the Border setting and style as you would for a paragraph border. 

2. Click the Apply To list drop-down arrow and select one of the following: 

o Whole Document— Places a border around each page in the document. 

o This Section— Places a border around each page in the current section of 

the document. 

o This Section-First Page Only— Places a border around the first page of 

the current section. 

o This Section-All Except First Page— Places a border around each page of 

the current section except the first page of the section. 
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To put a border around pages in a section, you must place sections in your document. 

Sections enable you to break a large document into smaller parts that can have radically 

different formatting attributes. For more about sections and how to create them,. 

 

Adding Shading to the Paragraph 

You can place a color or a grayscale pattern behind the text in a paragraph or paragraphs. 

This color or pattern is called shading and can be used with or without a border around 

the text. 

To add shading to text, you must select the text for a particular paragraph—just make 

sure the insertion point is in the paragraph. After you've designated the text that you want 

to place the shading behind, follow these steps: 

1. Select Format, Borders and Shading. The Borders and Shading dialog box 

appears. 

2. Select the Shading tab, as shown in Figure 6.5. 

Figure 6.5. You can apply shading to a paragraph or selected text. 

 

1. To select a fill color, click one of the colors on the color palette in the Fill area. 
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2. To select a pattern for the fill color, click the Style drop-down arrow and select a 

pattern from the list. 

3. Use the Apply To drop-down arrow to designate whether the current paragraph or 

selected text should be shaded. 

4. When you have completed your selections, click OK. 

Changing Font Colors 

When using the shading options, you might find that the current text color does not show 

up that well on the fill color or pattern that you selected. You can quickly change the font 

color for selected text anywhere in your document. 

To change the color of text, follow these steps: 

1. Select the text that you want to change to a different font color. 

2. Select the Format menu and select Font. The Font dialog box appears. 

3. In the Font dialog box, click the Font Color drop-down arrow and select the color 

you want to use (Word automatically defaults to black-colored fonts because this 

is typically what you use in business documents that you print). 

4. When you have completed your selection, click OK. 

You might find that you have to play around with the fill color and the font color to get 

an ideal combination on the page. You might even have to print out a sample page to see 

whether the colors work well on a printed page. Intensity of color . 

 

Working with Tabs and Indents 

In this lesson, you learn how to set and use tabs and indents in your documents. 

Aligning Text Using Tabs 

Although the left and right alignment of text in your document is governed by the 

margins set in the document, there are times when you want to align the text to 

emphasize a list of items or otherwise offset text from the rest of the items on the page. In 

Chapter 5, "Changing How Text Looks," you worked with centering and justification as a 

way to change the alignment of text. Another way to align text in a document is to use 

tabs. Tabs are set every half inch by default in a new document. Every time you press the 

Tab key on the keyboard, you offset the text line from the left margin one tab stop. 

You can customize tab stops to align text lines in columns. Word gives you complete 

control over where the tab stops are set in your document. Word also provides different 

tabs that enable you to align text in different ways: 

• Left Tab— Aligns the beginning of the text line at the tab stop 
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• Center Tab— Centers the text line at the tab stop 

• Right Tab— Right-aligns the text line at the tab stop 

• Decimal Tab— Lines up numerical entries at their decimal point 

Each of these tab types makes it easy for you to create lists that are offset from other text 

elements in the document. Your tab stops fall between the left and right margins on each 

page of the document. Each paragraph in the document can potentially have a different 

set of tab stops with different kinds of tabs set at the stops. 

Setting Tabs in the Tabs Dialog Box 

One way to set tabs in your document is using the Tabs dialog box. Select the Format 

menu, and then select Tabs. The Tabs dialog box requires that you specify a tab position 

in the Tab Stop Position box (the position you specify is the number of inches from the 

left margin); use the spinner box arrows to specify the position for the tab or type a 

position directly in the box. 

After the tab stop position is set, click the appropriate Alignment option button to select 

the type of tab you want to create at the tab stop (see Figure 7.1). If you want to have a 

leader (a repeating element, such as a dash) fill the empty space to the left of the tab stop, 

select one of the leader option buttons in the Leader box. After you have specified a 

position and a tab type (and an optional leader), add the tab by clicking Set. 

Figure 7.1. You can set and remove tab stops in the Tabs dialog box. 
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As you create the tabs, they will appear in the Tabs list on the left of the dialog box. If 

you want to remove a particular tab from the list, select it, and then click the Clear button. 

If you want to clear all the tabs listed (and start over), click the Clear All button. 

After you have finished setting your tabs, click OK. Although you can certainly set all the 

tabs for a document or section in the Tabs dialog box, it is not necessarily the best place 

to quickly set the tabs for your documents. It does not provide you with a visual display 

of how the tabs will look in the document. However, if you are creating tabs that include 

leading characters (such as dot leaders often seen in a table of contents) and you want to 

precisely set the tab positions to previously determined settings, the Tabs dialog box 

gives you complete control over all the settings. 

Setting Tabs on the Ruler 

An excellent alternative to setting tabs in the Tabs dialog box is to use the Word Ruler 

and actually set the tabs on the Ruler itself. This enables you to visually check the 

position of the tab stops and makes it easy for you to change the type of tab at a particular 

tab stop and delete unwanted tabs. 

To view the Ruler in the Word document window, select View, and then Ruler. The 

Ruler appears at the top of your document. 

Quickly View the Ruler If the Ruler is not displayed in the Word window, place 

the mouse pointer at the top of your current document, below the toolbars. If you 

wait for just a moment, the Ruler drops down onto the document. This allows 

you to view current tab settings. When you remove the mouse, the Ruler folds 

up. 

 

To set a tab on the Ruler, click the Tab button on the far left of the Ruler to select the tab 

type (Left, Center, Right, or Decimal). Each time you click the Tab button, you are 

cycled to the next tab type. If you go past the type of tab you want to set, keep clicking 

until the tab type appears on the Tab button. 

After you have the appropriate tab type selected on the Tab button, place the mouse 

pointer on the ruler where you want to create the tab stop. Click the mouse and the tab is 

placed on the ruler. It's that simple. 

Figure 7.2 shows the Ruler with each of the tab types set. The figure also shows how text 

aligns at each of the tab types. 

Figure 7.2. Setting tabs on the Ruler allows you to view their position and type. 
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Moving or Removing Tabs If you want to delete a tab on the Ruler, use the mouse to drag 

the tab off the Ruler. If you need to reposition a particular tab, click and drag it to a new 

location on the Ruler. 

I Adjust the Tabs But It Works for Only One Line Remember that Word treats each line 

followed by a paragraph mark as a separate paragraph. When you adjust the tab 

positioning on the ruler, it affects only the paragraph containing the insertion point. To 

adjust the tabs for several paragraphs, select all the lines (or the entire document if you 

want) and then adjust the tabs on the Ruler. 

Working with Indents 

Although tabs enable you to align text at various tab stops on the Ruler, you might want 

to indent or offset lines and paragraphs from the left or right margins. Word provides 

different indent settings that indent the text at a particular setting on the Ruler. 

Indent The offset of a particular paragraph or line of text from the left or right 

margin. 

 

The easiest way to indent a paragraph from the left margin is to use the Increase 

Indent button on the Formatting toolbar. Place the insertion point in the paragraph you 

want to indent, and then click the Increase Indent button on the toolbar. Remember that 

you can also use the Click and Type feature for left indents (see the previous chapter, 

"Using Borders and Colors"). 



Each time you click the button, you are increasing the indent one-half inch. You can 

also decrease the left indent on a particular paragraph. Click the Decrease Indent button 

on the Formatting toolbar. 

Setting Indents on the Ruler 

You can also indent a paragraph from both the left and right margins using the Ruler. The 

Ruler has a left and right indent marker on the far left and far right, respectively (see 

Figure 7.3). 

Figure 7.3. The Left Indent and Right Indent markers can be used to indent 

paragraphs from the left and right margins, respectively. 

 

To indent a paragraph from the left margin, use the mouse to drag the Left Indent marker 

to the appropriate position. Grab the marker at the very bottom, because the top of the 

marker is the First Line indent marker. These two markers separate if you don't grab both 

markers together at the bottom. You can also indent a paragraph from the right margin 

using the Right Indent marker. Slide the marker to the appropriate position on the ruler to 

create your indent. 

Creating Hanging Indents 

The hanging indent is a special kind of indent. With this type of indent, the text (a single 

line or multiple lines) that wraps under the first line of the paragraph is indented more 
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than the first line. Hanging indents are created by separating the First Line Indent marker 

from the Left Indent marker on the ruler. 

To create a hanging indent, follow these steps: 

1. Place the insertion point in the paragraph that you want to indent. 

2. Drag the Left Indent marker (drag it by the square bottom of the marker) to the 

position where you want to indent the second and subsequent lines of the 

paragraph. 

3. Drag the First Line Indent marker (drag it by the top of the marker) back to the 

position where you want the first line to begin. 

 

Examining Your Documents in Different Views 

In this lesson, you learn how to examine your document using the different document 

displays offered in Word. 

Changing the Document Display 

Word provides you with several viewing possibilities as you work on your documents in 

the Word application window. Each of these display modes provides a different look at 

your document. For example, the Normal view provides you with a look at all the font 

and paragraph formatting in the document, but does not give you a view of the document 

as it would appear on the printed page. Instead, the Print Layout view supplies this 

viewpoint. 

Using the different document views to your advantage can help you visualize and create 

great-looking documents in Word. Special views are even supplied for creating outlines 

and creating Web pages in Word. You take advantage of these different views using the 

View menu. Table 8.1 shows the various views available to you and describes, in general 

terms, for what they are best used. 

Table 8.1. The Word Views 

View Typical Use 

Normal Use for general word processing tasks. 

Web 

Layout 

Use for designing HTML documents and viewing Web pages. 

Print 

Layout 

Use for document layout and documents containing graphics and embedded 

or linked objects. 

Outline Use to view document as an outline. 
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Table 8.1. The Word Views 

View Typical Use 

Reading 

Layout 

Allows you to view the document in a side-by-side screen view. This is a 

view mode only, so you cannot edit the text when in this view. 

Full Screen Use when you want to use the entire screen to view the document and avoid 

seeing the toolbars and other marginal information. 

The Normal View 

The Normal view provides you with a view that is perfect for most word processing 

tasks. It is the default view for Word; to change to the Normal view (from any of the 

other views), select View, and then Normal. 

Switch to Normal with a Click You can also change from view to view in 

Word using the View toolbar in the lower-left corner of the Word window. To 

go to the Normal view, click the Normal icon. 

 

This view displays character and paragraph formatting that you place in the document 

(see Figure 8.1). Normal view, however, does not display the document headers and 

footers or show graphics in the document as they will print. Also, items created using the 

Drawing toolbar are not displayed in the Normal view. 

Figure 8.1. The Normal view shows all the formatting in the document but does 

not show graphics, margins, and other special elements as they will appear on 

the printed page. 
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In the Normal view, you see the following: 

• Page breaks appear as dashed lines. 

• Headers and footers are displayed in the header/footer-editing area and you are 

temporarily switched to the print Layout (when Header and Footer is selected on 

the View menu). Only the header or footer can be edited at this point. When you 

close the Header and Footer toolbar you are returned to the Normal view. 

• Footnotes and endnotes are displayed in a footnote or endnote editing area (when 

Footnotes is selected on the View menu). Only the footnote or endnote can be 

edited at this point. 

• Margins and column borders are not displayed in this view. 

Web Layout View 

The Web Layout view is perfect for designing HTML documents that you want to use as 

Web pages. The Web Layout view displays your document as it would appear in your 

Web browser window. To switch to the Web Layout view, select View, and then Web 

Layout. 

HTML Hypertext Markup Language—This document format is used for the creation of 

Web pages for the World Wide Web. The special document format is read using a Web 

browser or some other application (such as Word) that can display HTML documents. 



In the Web Layout view, text is wrapped to fit in the window and 

graphics are placed as they will appear onlinePrint Layout View 

The Print Layout view shows your document exactly as it will appear on the printed page. 

Working in this view allows you to fine-tune your document and work with graphic 

placement and text formatting as you prepare your document for printing. 

To switch to the Print Layout view, select View, Print Layout. This view enables you to 

view headers, footers, footnotes, endnotes, and the margins in your document. Graphics 

are also positioned and sized as they will appear on the printed page. Figure 8.3 shows 

the same document that appeared earlier in Figure 8.1. Notice that in the Page Layout 

view, the margins of the document and (more importantly) a graphic in the document 

appear. 

Print Layout View 

The Print Layout view shows your document exactly as it will appear on the printed page. 

Working in this view allows you to fine-tune your document and work with graphic 

placement and text formatting as you prepare your document for printing. 

To switch to the Print Layout view, select View, Print Layout. This view enables you to 

view headers, footers, footnotes, endnotes, and the margins in your document. Graphics 

are also positioned and sized as they will appear on the printed page. Figure 8.3 shows 

the same document that appeared earlier in Figure 8.1. Notice that in the Page Layout 

view, the margins of the document and (more importantly) a graphic in the document 

appear. 

Outline View 

The Outline view allows you to create and edit your document in an outline format. 

Using the Word built-in heading styles is the key to creating the document in this view 

(for more about styles, see Lesson 10, "Working with Styles"). Each heading (Heading 1, 

2, 3, and so on) is treated as a different level in the outline. For example, a heading 

assigned the Heading 1 style would be a Level 1 heading in the outline. You can promote 

and demote headings using the appropriate buttons on the Outline toolbar (a special 

toolbar that appears when you are in Outline view). 

The Outline toolbar also provides an Outline Levels drop-down box that allows you to 

quickly change the level of the text where the insertion point currently resides. These 

levels coincide with different styles used by the outline feature. For example, Level 1 is 

equivalent to the Heading 1 style. 

You can also collapse and expand the outline to better organize your document. 

Collapsing the document to all Level 1 Headings allows you to ignore the body text in the 

document and concentrate on the overall organization of the document. 
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Move a Heading and Associated Text You can drag a heading to a new position, and the 

subheading and body text associated with the heading move to the new position as well. 

This makes it very easy for you to reorganize the text in your document. 

Reading Layout 

A new view that has been added to Word is the Reading Layout view. This view splits 

the window into two side-by-side panes. Each pane shows one document screen (it does 

not show an entire page 

You can advance through the document screen by screen using the Page Down button on 

the vertical scrollbar. You can view thumbnails of each document screen by clicking the 

Thumbnails button provided on the Reading Layout toolbar. To quickly read one of the 

thumbnails provided, click the thumbnail and it and the preceding screen will appear in 

the Reading window. 

Although you cannot edit the text in the Reading Layout view, it does allow you to read 

the text in a document and quickly advance from screen to screen. When you have 

completed reading the text in the document, click the Stop Reading button on the toolbar 

to return to the previously selected view (such as Normal or Print Layout). 

Using the Full Screen View 

In situations where you want to concentrate on the text and other items in your document, 

it is great to be able to clear all the visual clutter from the screen (toolbars, scrollbars, and 

other Word tools) and view only your document. For example, you might be 

proofreading a particular page and want to place as much of the page's text on the screen 

as you can. You can switch to a view where your document occupies all the space 

available on the screen. Select View, Full Screen. 

You can still add or edit the text in your document when you are in the Full Screen view. 

You can also quickly return to the previous view you were using (such as Normal view or 

Print Layout view) before you switched to the Full Screen view. Click the Close Full 

Screen box that appears in the document window and you return to the previous view 

Zooming In and Out on Your Document 

You can use the Zoom command to zoom in and out on your documents. This allows you 

to increase the magnification of items on the page, such as small fonts, or to step back 

(zoom out) from the document to view its general layout. 

You can use Zoom in any of the Word views (except the Reading Layout view). In 

Normal, Print Layout, Web Layout, and Outline views, the effect of zooming in or out 

just changes the magnification of the onscreen elements. When you use Zoom on the 

Print Layout view, you get a very good look at how the document is laid out on the 

printed page. 



To zoom in or out on your current document, select View, Zoom. The Zoom dialog 

box appears  

Figure 8.6. The Zoom dialog box can be used to change the current zoom level 

of your document. 

 

A series of option buttons is used to change the zoom setting for the current document. 

When you click a particular option button (such as the 200% option button), you see a 

preview of this magnification in the Preview box. 

You can also set a custom zoom level in the Percent box. Use the click arrows in the box 

to increase or decrease the current zoom percentage. When you have selected the zoom 

level for the current document, click OK. 

View Multiple Pages on Your Screen When you are in the Print Layout view, you can 

use the Zoom dialog box to view two or more pages at the same time. Click the Many 

Pages option button (when in Zoom option), and then click the Computer icon below the 

option button. Drag over the page boxes to select the number of pages you want to 

display, and then click OK. 

Working with the Document Map 

The Document Map view is somewhat similar to the Outline view in that it gives you a 

quick reference to the overall structure of your document. A special pane appears in the 

document window (on the left) that shows the headings in your document. You can use 



the Document Map to quickly move from one area of a document to another by clicking 

the appropriate heading. 

To open the Document Map, select View, Document Map; the map pane appears in 

the document window (see Figure 8.7). You can change the width of the document 

map pane by placing the mouse on the border between the pane and your document. 

The mouse arrow changes to a sizing tool—a double-headed arrow. Drag the sizing 

tool to create a custom document map width. 

Splitting the Document Window 

Another useful way to view your documents is to split the current document window into 

two panes. This allows you to view the same document in both panes, which is 

particularly useful when you want to view two different parts of the same document. 

You can use the two panes to drag and drop information from one part of a document into 

another. Remember that changes you make in either of the split panes will affect the 

document. 

To split the document screen into two panes, select Window, Split. A horizontal split 

appears across the document window. Notice that as you move the mouse in the 

document window, the split bar moves with it. Place the mouse where you want to split 

the document window, and then click the left mouse button. 

A set of vertical and horizontal scrollbars appears for each pane in the split window 

(see Figure 8.8). Use the scrollbars in each pane as needed 

Figure 8.8. You can split the document screen to view different areas of a long 

document. 
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When you have finished working in the split document window, select Window, and 

then Remove Split. The splitter bar is removed from the document 

 

 

 

Working with Margins, Pages, and Line Spacing 

In this lesson, you learn how to set margins, insert page breaks into your documents, and 

control line spacing and line breaks in your documents 

Setting Margins 

Margins control the amount of white space between your text and the edge of a printed 

page. Four margins—Left, Right, Top, and Bottom—can be set for your pages. The 

default margin settings for documents based on the Word Normal template are shown in 

Table 9.1. 
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Table 9.1. Default Margin Settings for the Normal Template 

Margin Setting (in Inches) 

Left 1.25 

Right 1.25 

Top 1 

Bottom 1 

You can change any of the margin settings for your document or a portion of your 

document at any time. The Page Setup dialog box provides you with access to all these 

margin settings. You also have control over how your margins affect the layout of 

multiple pages in a document. For example, you can set up your pages to be laid out in 

book folio fashion (two pages arranged horizontally on each piece of paper) or two pages 

per sheet arranged vertically. 

To change the margin settings for your document, follow these steps: 

1. Select File, Page Setup. The Page Setup dialog box appears as shown in Figure 

9.1. 

Figure 9.1. Use the Margins tab of the Page Setup dialog box to set your 

document margins and arrange them on multiple pages if necessary. 
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1.  

Margins Can Be Different for Different Parts of the Document You can set 

different margin settings for different portions of your document. The easiest 

way to do this is to divide your document into sections. Each section can then 

have a different set of margins. For information on creating sections in your 

documents, see Lesson 20, "Working with Larger Documents." 

2.  

 

3. Click the Margins tab if necessary. Use the click arrows in the Top, Bottom, Left, 

or Right margin boxes to increase or decrease the current setting. Or double-click 

in any of the boxes and type in a new value. 
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Maximum and Minimum Margins Be advised that your printer defines the minimum 

margins for a page. For example, most inkjet printers limit you to a minimum top and 

bottom margins of .25" and .5", respectively, and left and right margins of .25". If you set 

margins less than the minimum, a dialog box appears when you close the Page Setup 

dialog box, letting you know that your margins are outside the printable area of the page. 

Click the Fix button on this dialog box to set the margins to the minimum for your 

printer. For maximum margins, Word notifies you by a dialog box if you select margins 

that overlap or negate any usable space on the page. 

1. After you have selected the new margin settings, you can apply the margins to the 

entire document, to a section of the document (this option is available only if you 

have more than one section in the document), or to the document from the current 

page forward in the document. Using the last choice allows you to have different 

margin settings in the same document without requiring you to divide the 

document into sections (for more about sections, see Lesson 20). Click the Apply 

To drop-down box and select Whole Document (the default setting), This Point 

Forward, or This Section (if available). 

2. After you have finished selecting your new margin settings and the amount of the 

document that they will affect, click OK. 

The new margins take effect in your document. The best way to view how these margins 

will look when you print the document is to switch to the Print Layout view (if you are 

not already in this view). Select View, Print Layout. The margins you've selected appear 

on the top, left, right, and bottom of your document in the Word document window. 

When you are in the Print Layout view, you can also adjust the margins in your document 

using the Ruler. To view the Ruler, select View, Ruler. The vertical ruler is visible in the 

Print Layout View only. 

In the Print Layout view, horizontal and vertical rulers appear in the document window. 

The margins appear as shaded areas on the edge of the respective ruler. For example, the 

left margin is a gray-shaded area on the left side of the horizontal ruler (see Figure 9.2). 

Figure 9.2. Drag the respective margin-sizing arrow to increase or decrease a 

margin. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch56.html#ch56
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch45lev1sec1.html#ch45fig02#ch45fig02


 

 

To adjust a margin, place the mouse pointer between the gray margin and the white 

document area on the ruler. A margin-sizing arrow appears. Drag the gray margin to 

increase or decrease the respective margin. Figure 9.2 shows the margin-sizing arrow on 

the top margin on the vertical ruler. 

Controlling Paper Types and Orientation 

Other page attributes that you need to control in your documents are the paper size and 

the page orientation. Word's default settings assume that you will print to paper that is a 

standard 8.5 by 11 inches. The default page orientation is portrait, meaning that the 

maximum distance from the left edge to the right edge of the page is 8.5 inches. 

You can select different paper sizes, which is particularly important if you want to print 

to envelopes or a different paper size, such as legal-size paper. You can also change the 

orientation of your text and images as they appear on a page from portrait to landscape, 

where the page contents are rotated so that the distance between the left and right edges 

on a standard sheet of paper would be 11 inches. 

Paper size and page orientation are both set in the Page Setup dialog box. Follow these 

steps to edit the settings for these page attributes: 

1. Select File, Page Setup. The Page Setup dialog box opens. 

2. Click the Paper tab on the dialog box (see Figure 9.3). 
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3. Figure 9.3. The Paper tab of the Page Setup dialog box enables you to set 

your paper size and source. 

 

 

1. To select a new paper size, click the Paper Size drop-down box and select the 

paper type. For nonstandard paper sizes, select Custom Size in the Page Size box, 

and then type the paper's width into the Width box and its height into the Height 

box. 

2. To change the orientation of the page to portrait or landscape, select the Margins 

tab and click the Portrait or the Landscape option button as needed (refer to 

Figure 9.1). 

3. Finally, in the Apply To drop-down box, select Whole Document to apply the 

new settings to the new document or This Point Forward to apply the settings to 

the document from the current page forward. 

4. When you complete editing the settings, click OK. 
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Inserting Page Breaks 

As you create your document, Word automatically starts a new page when you fill the 

current page with text or other document items (such as graphics, tables, and so on). 

However, you can insert your own page breaks in the document as needed. These types 

of page breaks are often referred to as hard, or manual, page breaks. 

To insert a page break into your document, follow these steps: 

1. Place the insertion point in the document where you want to force a page break. 

2. Select Insert, Break. The Break dialog box appears. 

3. Make sure the Page Break option button is selected, and then click OK. 

A page break is placed in your document. In the Normal view, the page break appears as 

a dashed line across the page, with "Page Break" denoted at the center of the line. In the 

Print Layout view, you can move to the new page by clicking the Next Page button on the 

bottom of the vertical scrollbar. 

To remove a page break, switch to the Normal view (select View, Normal). The page 

break appears as a dotted line in the document and is denoted as a "page break." Select 

the page break with a mouse and press Delete to remove it. 

Changing Line Spacing 

Another setting that greatly influences the amount of whitespace on the page is line 

spacing. When you consider whether you want your text single-spaced or double-spaced, 

those text attributes are controlled by changing the line spacing. 

Line spacing can be set for each paragraph in the document or for selected text. Setting 

line spacing for a blank document allows you to set a default line spacing for all text 

paragraphs that will be placed in the document. 

To set the line spacing for a new document, a paragraph, or selected text, follow these 

steps: 

1. Select the Line Spacing drop-down arrow on the Formatting toolbar. A list of line 

spacing possibilities such as 1.0, 1.5, 2.0, and so on will appear. Select the line 

spacing you want to use. 

2. (optional) If you want to set a custom line spacing, select More from the Line 

Spacing button's drop-down list. The Paragraph dialog box appears (see Figure 

9.4) with the Indents and Spacing tab selected. 

3. Figure 9.4. The Indents and Spacing tab allows you to fine-tune the line 

spacing for your text. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch45lev1sec4.html#ch45fig04#ch45fig04
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch45lev1sec4.html#ch45fig04#ch45fig04


 

 

1. (optional) To change the line spacing on the Indents and Spacing tab, click the 

Line Spacing drop-down box and select one of the following choices: 

o Single— Spacing accommodates the largest font size found on the lines 

and adds a small amount of whitespace (depending on the font used) 

between lines. 

o 1.5— The line spacing is 1 and 1/2 times greater than single spacing. 

o Double— Twice the size of single line spacing. 

o At Least— (The default setting) line spacing adjusts to accommodate the 

largest font on the line and special items, such as graphics. 

o Exactly— All lines are equally spaced, and special font sizes or items such 

as graphics are not accommodated. These items, if larger than the setting 

used here, appear cut off in the text. You can still accommodate these 

items by using the Multiple box (described next) to shift all the text lines 

to a higher spacing percentage that accommodates special items. 

o Multiple— You specify the line spacing by a particular percentage. This 

feature is used in conjunction with the Exactly option to set a line spacing 

percentage that accommodates special font sizes or graphics found in the 



document. For example, if you want to decrease the line spacing by 20%, 

you enter the number 0.8. To increase the line spacing by 50%, you enter 

1.5. 

2. The Line Spacing option selected in step 3 is influenced by the point size entered 

in the At box (this applies only when you have selected At Least, Exactly, or 

Multiple). Use the click arrows to increase or decrease the point size of the line 

spacing, if needed. 

When you complete setting the line spacing parameters, click OK. 

 

Using AutoFormatting to Change Text Attributes 

In this lesson, you learn how to quickly change the look of your text with AutoFormat 

and apply text attributes automatically as you type. 

Understanding AutoFormatting 

AutoFormat is a great feature that helps you create professional-looking documents. 

AutoFormatting actually examines the text elements that you have placed in your 

document (such as headings, tables, lists, regular body text, and other items) and then 

automatically formats these elements using an appropriate Word style. Even though this 

formatting is automatic, you can accept or reject the changes AutoFormatting makes. You 

can also make additional changes to the document as you see fit by using other styles or 

font and paragraph formatting attributes (for more about styles, see Lesson 10, "Working 

with Styles"). 

You will also find that AutoFormat does more than just apply styles to your document 

elements. It can remove extra paragraph breaks between paragraphs and apply the 

hyperlink styles to e-mail addresses or Web addresses that you place in your documents. 

You can use AutoFormat in two ways. You can turn on AutoFormatting so that items are 

formatted as you type, or you can create a new document and then use AutoFormat to 

format the entire document at once. 

Formatting As You Type 

You can have your document elements formatted as you type. However, this feature 

requires that you supply Word with certain cues so that the correct formatting is applied 

to the text. For example, if you turn on AutoFormat As You Type and want to create a 

bulleted list that is automatically formatted by the AutoFormat feature, you must begin 

the bulleted line with a dash, an asterisk, or a lowercase "o" so that Word knows to apply 

the bulleted list formatting. 
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Many AutoFormat As You Type features are enabled by default, although others are not. 

To customize the AutoFormat As You Type feature, follow these steps: 

1. Select Tools, then AutoCorrect Options. The AutoCorrect dialog box appears. 

2. Select the AutoFormat As You Type tab on the dialog box (see Figure 11.1). 

Figure 11.1. Use the AutoFormat As You Type tab to select the automatic formatting 

options. 

 

 

1. A series of check boxes on the AutoFormat As You Type tab allows you to select 

which document elements will be formatted as you type. Again, you need to type 

certain characters for a particular element so that the AutoFormat feature 

recognizes and then formats the text. Some of the most often used AutoFormat 

possibilities are as follows: 

o Automatic Bulleted Lists— Select this check box to create bulleted lists 

automatically. Start each line in the list with an asterisk (*), a dash (-), or a 

lowercase "o." 
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o Automatic Numbered Lists— Select this check box to create numbered 

lists. When you start a line with a letter or number, it is turned into a 

numbered list item. If the Format Beginning of List Item Like the One 

Before It check box is selected, paragraphs following the first numbered 

line are numbered sequentially. 

o Built-In Heading Styles— Select this check box to have all headings that 

you apply to an outline or a legal document be automatically assigned the 

appropriate built-in heading style (using Headings 1–9). 

o Border Lines— Select this check box to have borders automatically placed 

between paragraphs. You must type three dashes (-) for a thin border, 

three underscores (_) for a bold line, or three equal signs (=) for a double-

line border. 

o Tables— Select this check box to automatically create tables. You must 

type a series of plus symbols (+) and dashes (-) to signify the number of 

columns (+) and the distance between the columns (-). 

Other AutoFormatting check boxes include features that format your quotation 

marks, ordinals (1st), and fractions (1/2). Select (or deselect) the various 

AutoFormat As You Type options and then click OK to close the dialog box. 

Although formatting as you type might seem like a real timesaver, you must remember 

which special characters to use to automatically begin a particular formatting type. 

Applying AutoFormat to a Document 

The alternative to AutoFormatting as you type is to create the document and then format 

it after the fact with AutoFormat. Waiting to format a document until after its completion 

allows you to concentrate on the document content as you type. You then can concentrate 

on the look and feel of the document by selecting from the various AutoFormatting 

options. Heads, numbered or bulleted lists, and other items you have designated 

throughout the text are identified and formatted. 

To AutoFormat a document, follow these steps: 

1. Make sure that you are in the Print Layout view (select View, then Print Layout; 

this allows you to see the various formatting tags applied to the document when 

you review the autoformat changes; see Lesson 8, "Examining Your Documents 

in Different Views,"for more information). Select Format, then AutoFormat. The 

AutoFormat dialog box appears 

Figure 11.2. The AutoFormat dialog box allows you to immediately format the 

document or review each of the suggested formatting changes 
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1. You can increase the accuracy of the formatting process by choosing a particular 

document type. Click the General Document Type drop-down arrow and select 

from the document types listed on the drop-down list (the default setting is 

General Document; you can also select Letter or Email as the document type from 

the list). 

2. Now you can AutoFormat the document. If you want to AutoFormat the current 

document without reviewing the formatting changes, click the AutoFormat Now 

radio button and then click OK. The document is automatically formatted. 

3. If you want to review the AutoFormatting process after the changes are made, 

click the AutoFormat and Review Each Change radio button. Then click OK. 

 

 

Adding Document Text with AutoText and Using Special 
Characters 

In this lesson, you learn how to quickly add repeating text elements to your documents 

using the AutoText feature. You also learn how to add special characters to your 

document, such as the copyright symbol 

Understanding AutoText 

AutoText provides you with a way to build a library of words and text phrases that you 

use often in your documents. AutoText makes it easy for you to quickly insert items from 

your AutoText list into any document. Creating AutoText entries is also very 



straightforward. An AutoText entry can consist of a company name, your name, or an 

entire paragraph that you commonly place in your documents. 

Creating AutoText Entries 

You can create an AutoText entry using text from an existing document, or you can type 

the text that you want to add to the AutoText list in a blank document. Then it's just a 

matter of copying the text to your AutoText list. 

To create an AutoText entry, follow these steps: 

1. Type the text you want to use for the AutoText entry or open the document 

containing the text that will serve as the AutoText entry. 

2. Select the text. 

3. Select the Insert menu, point at AutoText, and then select New from the cascading 

menu. The Create AutoText dialog box appears as shown in Figure 12.1. 

Figure 12.1. Creating the Wally's AutoText saves you from typing Wally's Friendly 

Fish Market. 

 

1. Type the name that you want to use to retrieve this AutoText entry in the text box 

provided (for one-word text entries, the selected text can also serve as the entry 

name). 

2. After providing the name for the AutoText entry, click OK. 

Your selected text is added to the AutoText list. You can repeat this procedure and add as 

many text items to the AutoText list as you want. 

 

 

 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch48lev1sec1.html#ch48fig01#ch48fig01


Inserting AutoText Entries 

After you add an AutoText entry or entries to the list, you can insert them into any Word 

document. One method of inserting an AutoText entry into the current document is to 

pull the entry directly from the AutoText list. 

To insert an AutoText entry into a document, follow these steps: 

1. Place the insertion point in the document where you want to insert the AutoText 

entry. 

2. Select the Insert menu, point at AutoText, and then select AutoText. The 

AutoCorrect dialog box appears as shown in Figure 12.2 (with the AutoText tab 

selected). 

Figure 12.2. Insert your AutoText entries from the AutoCorrect dialog 

box. 
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1. The AutoText tab of the AutoCorrect dialog box displays an alphabetical list (as 

well as various default entries that Word provides) of the AutoText entries that 

you have added to the AutoText list. Select the entry you want to insert and click 

Insert. Or double-click any entry on the list to insert it into the document. 

Deleting AutoText Entries 

You can easily delete items on the AutoText list when you no longer need them. This is 

done on the AutoText tab of the AutoCorrect dialog box. 

To delete an AutoText entry, follow these steps: 

1. Select the Insert menu, point at AutoText, and then select AutoText from the 

cascading menu. The AutoCorrect dialog box appears. 

2. Select any of the entries in the AutoText list. 

3. Click Delete to remove the entry from the list. 

After you have completed your deletion of AutoText entries, click OK to close the 

AutoText dialog box. 

Using Special Characters and Symbols 

Special characters and symbols are characters that can't be found on your keyboard and 

that are not part of what is considered to be the standard character set. Characters such as 

the German "u" with an umlaut (ü) are special characters, and an item such as the 

trademark is an example of a symbol. 

Many special characters and symbols exist. Table 12.1 lists some of the commonly used 

special characters and symbols. 

Table 12.1. Common Special Characters and Symbols 

Special Character 

or Symbol 

Use 

Copyright symbol © Used in a copyright notice in a document. 

Trademark symbol 

™ 

Placed to the right of official trademarks placed in a document. 

Em dash — Used to bracket asides or sudden changes in emphasis in a 

sentence—rather than using a comma. It appears as a long dash. 

En dash – Slightly shorter than an em dash, this dash is commonly used to 

separate numbers from capital letters, such as Figure B–1. 
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Table 12.1. Common Special Characters and Symbols 

Special Character 

or Symbol 

Use 

Wingdings A group of special icons that can be used in your documents for 

emphasis or as bullets. 

Foreign language 

font (á) 

Characters that include special accents. 

The basic special characters and symbols are held in three groups: 

• Symbol— This group contains mathematical symbols, arrows, trademark and 

copyright symbols, and letters from the Greek alphabet. 

• Normal Text— This group provides you with special characters containing 

accents and other special marks. 

• Wingdings— Special icons and symbols for many purposes. 

Additional special character sets might be available to you, depending on which fonts 

have been installed on your computer (you can purchase software with unique fonts and 

symbols, as well). 

Adding Headers, Footers, and Page Numbers 

In this lesson, you learn how to add headers, footers, and page numbers to your 

documents. 

Understanding Headers and Footers 

Another aspect of creating a document is using headers and footers to insert information 

that you want repeated on every page of the document or in the pages of a particular 

document section. 

Header The header resides inside the top margin on the page; it holds information such as 

the date or draft number that appears at the top of every page of the document. Every 

section of a document could potentially have a separate header. 

Footer The footer resides inside the bottom margin of the page; it holds information such 

as the page number or other information that appears at the bottom of every page of the 

document. Every section of a document could potentially have a separate footer. 

Headers and footers provide you with a way to include a document title, the current date, 

or the current page number on the top or bottom of each page in the document. Headers 

can include text, graphics, or other items. 



Adding Headers and Footers 

You can add a header or footer to a document in any view. To add a header or footer, 

follow these steps: 

1. Select View, Header and Footer. You are temporarily switched to the Print Layout 

mode and placed in the header area of the document (see Figure 13.1). The 

regular text area is dimmed and unavailable while you work in the header or 

footer box. 

Figure 13.1. The header area of the page is where you type your header text. The 

Header and Footer toolbar provides you with tools to insert page numbers, the date, 

and to switch between your headers and footers. 

 

1. Type your text into the header area. If you want to create a footer, click the 

Switch Between Header and Footer button on the Header and Footer toolbar, 

which is also available in the document window. 

2. You can add a page number, the current date, the current time, and other elements 

using the appropriate buttons on the Header and Footer toolbar (see Table 13.1). 

3. When you need to align or format the text, use the appropriate buttons on the 

Word Formatting toolbar (while in the header/footer areas) as you would for text 

on the document page. 
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4. When you have finished entering your header and footer text, click the Close 

button on the Header and Footer toolbar. 

You are returned to your document text. In the Normal view, you are not able to see your 

header or footer. In the Print Layout view, however, header and footer text appears 

dimmed. 

You can edit your headers and footers by selecting View, Header and Footer. Move to the 

appropriate header or footer using the navigation buttons on the Header and Footer 

toolbar shown in Table 13.1. To quickly enter a header or footer box, in the Print Layout 

view double-click the header or footer text. 

Table 13.1. The Header and Footer Toolbar Buttons 

Button Purpose 

 Inserts the page number 

 Inserts the page count or number of total pages 

 Edits the format of the page number 

 Inserts the current date 

 Inserts the current time 

 Opens the Page Setup dialog box to the Layout tab, where you can change the 

header and footer settings 

 Hides the document text while you work on your header and footer 

 Sets up the next header the same as the current header (or footer) 

 Switches between your header and footer 

 Moves to the previous header or footer in the document 

 Moves to the next header or footer in the document 

Several toolbar choices, such as Same As Previous and Move to Previous or Next (header 

or footer) relate to documents that have several sections and so have different headers or 

footers within the same document. You can also have more than one header or footer in 

the document if you choose to have different headers or footers for odd- and even-

numbered pages. 

Adding Page Numbering to a Document 

Headers and footers enable you to place repeating information in your documents, 

including the date, other important text, and most important—page numbers. When you 
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want to place only page numbers on your document pages, you can skip the Header and 

Footer command and quickly add page numbers using the Insert menu. 

To place page numbers in your document, follow these steps: 

1. Select Insert, Page Numbers. The Page Numbers dialog box appears (see Figure 

13.3). 

Figure 13.3. Use the Page Numbers dialog box to select the position and 

alignment of page numbers in your document 

 

1. To select the position for your page numbers, select the Position drop-down arrow 

and select Top of Page (Header) or Bottom of Page (Footer). 

2. You can select the alignment for the page numbers using the Alignment drop-

down box. Select Center, Left, or Right to position the page numbers. When you 

are using mirror margins on a document that will be printed on both sides of the 

paper, select Inside or Outside (relative to a central binding, like that of a book) to 

position your page numbers. 

3. To select the format for your page numbers, click the Format button. The Format 

dialog box appears. 

4. Use the Page Number Format drop-down box (shown in Figure 13.4) to choose 

the format for your page numbers (Arabic numerals—1, 2, 3—is the default). 

When you have selected your number format, click OK to return to the Format 

dialog box. 

Figure 13.4. Use the Page Number Format drop-down box to choose the 

format for your page numbers 

1. To have the page numbering start on a specific page in the document, click the 

Start At option button and then use the spinner box to specify the page number. 

2. Click OK to close the Page Number Format dialog box. 
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The page numbers are placed in the header or footer of your document according to your 

positioning and formatting choices. You can edit the page numbers and add text if you 

want by selecting View, Header and Footer. 

Printing Documents 

In this lesson, you learn how to preview your documents and then print them. 

Sending Your Document to the Printer 

When you have finished a particular document and are ready to generate a hard copy, 

Word makes it easy for you to get your document to the printer. In fact, you have three 

choices: 

• You can send the document directly to the printer (no questions asked) by 

clicking the Print button on the Standard toolbar. 

• You can open the Print dialog box (select File, Print) and set any print options that 

you want, such as printing a particular range of pages or printing multiple copies 

of the same document. 

• You also have the option of previewing your hard copy before printing. This 

enables you to view your document exactly as it will appear on the printed page. 

To preview your document before printing, click the Print Preview button on 

the Word Standard toolbar. The Print Preview window opens for the current 

document (see Figure 14.1). 

• Figure 14.1. The Print Preview mode enables you to view your document 

the way it will print. 
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You will find that the Print Preview window provides several viewing tools that you can 

use to examine your document before printing. 

• Zoom In or Out— In the Print Preview window, the mouse pointer appears as 

a magnifying glass. Click once on your document to zoom in, and then click a 

second time to zoom out. To turn this feature off (or on again), click the 

Magnifier button. 

• Zoom by Percentage— You can change to different zoom levels on the 

current document by using the Zoom drop-down arrow. 

• View Multiple Pages— You can also zoom out and view several pages at 

once in the Preview window. Click Multiple Pages, and then drag to select the 

number of pages to be shown at once. 

• Shrink to Fit— If you have a two-page document and only a small amount of 

text appears on the second page, you can condense all the text to fit on the first 

page only; click the Shrink to Fit button. 

When you have completed viewing your document in the Print Preview mode, you 

can click the Print button to print the document, or if you want to edit the document 

before printing, click the Close button on the toolbar. 



Changing Print Settings 

In some situations, you might want to print only the current page or a certain range of 

pages. These options are controlled in the Print dialog box. The Print dialog box supplies 

you with several options, including the printer to which you send the print job, the 

number of copies, and the page range to be printed. 

To open the Print dialog box, select File, then Print. The Print dialog box is shown in 

Figure 14.2. 

Figure 14.2. The Print dialog box gives you control over the options for your 

document. 

 

 

Depending on your home or office situation, you might have your computer connected to 

more than one printer (especially if you are on a network). The Print dialog box has a 

drop-down box that lists all the printers to which you have access. To select a printer 

other than the current printer, click the drop-down arrow in the Name box and choose 

your printer from the list. 
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The Print dialog box also enables you to select the range to be printed. This range can 

consist of a page, a group of specific pages in a sequence, or all the pages in the 

document. 

• All Pages— To print all the pages in the document, make sure the All option 

button is selected. 

• Current Page— To print a single page, click the Current Page option button (this 

prints the page that the insertion point is parked on). 

• Page Range— To designate a range of pages, click the Pages option button and 

type the page numbers into the Pages box. 

 

Specifying Page Ranges To print a continuous range of pages, use the 

1–5 format (where 1 is the start and 5 is the end of the range). For 

pages not in a continuous range, use the 5,9,13 format (where each 

distinct page number to be printed is separated by a comma). You can 

also mix the two formats. For example, you could specify 1–5,9,13. 

•  

• Number of Copies— In the Copies area of the Print dialog box, use the increment 

buttons in the Number of Copies box to select the number of copies you want to 

print. You can also double-click inside the Number of Copies box and type in a 

particular value for the number of copies you want. 

• Collate— In addition to specifying the number of copies, you can select whether 

to collate your document by checking the Collate box in the copies area. Collate 

means that the document is printed in the proper order for stapling or binding. 

For example, a 10-page document would be printed from page 1 through 10 and 

then the subsequent copies would also print in this "collated" arrangement. If you 

do not choose to collate, all the copies of page 1 will be printed, then page 2, and 

so on. 

You can also choose to print all the pages in a chosen range or print only the odd or even 

pages. Click the Print drop-down box (near the bottom left of the dialog box) and select 

All Pages in Range, Odd Pages, or Even Pages, as required. 

Another print option worth mentioning is the Zoom print option in the Print dialog box. 

This feature enables you to place several document pages on one sheet of paper. To use 

Zoom print, click the Pages per Sheet drop-down box in the Zoom area of the Print dialog 

box and select the number of document pages you want to place on a sheet of paper. To 

select a scale for the print job (the scale is the relative size of the mini-pages on the 

printout page, such as 8.5 by 11 inches or legal size), click the Scale to Paper Size drop-

down box. 

After you select these two options, proceed with your print job. Be advised, however, that 

the more pages you place on a single sheet, the smaller the text appears. 



Finally, you can print special items that you have placed in your document, such as 

comments, styles, and AutoText entries. When you choose to print one of these items, 

you are supplied with a page or pages separate from the main document that lists the 

comments, styles, or other items you've selected. 

Select the Print What drop-down arrow and select from the list of items as follows: 

• Document— Prints the document. 

• Document Properties— Prints a summary of the information found in the 

document properties dialog (click File, Properties). 

• Document Showing Markup— Shows the document with markup from tracking 

changes by multiple authors. 

• List of Markup— Prints a list of changes added to a document involving multiple 

authors. 

• Styles— Lists the styles in the document. 

• AutoText Entries— Provides a list of the AutoText entries in the document. 

• Key Assignments— Shows the shortcut key assignments for the document. 

If you want to print more than one of these optional items with the document printout, 

you must select them in the Print options dialog box 

 

 

Creating Numbered and Bulleted Lists 

In this lesson, you learn how to create and edit numbered and bulleted lists. 

Understanding Numbered and Bulleted Lists 

You can add emphasis to a list of points or delineate a list of items in a document by 

adding numbers or bullets to the items in the list. Numbered lists are great for steps or 

points that should be read in order. Bulleted lists work best when you want to separate 

and highlight different items or points in a list, but the items do not have to appear in any 

particular order. 

The style and look of the numbers or bullets that you apply to a list can easily be 

edited, and you can even change the starting number for a numbered list. The list then 

renumbers itself automatically. Also, as you add new lines to numbered or bulleted 

lists, the items are automatically set up with the same numbering style (with the 

proper number in the list sequence) or bullet style. 



Creating a Numbered or a Bulleted List 

You can create numbered or bulleted lists from scratch or add numbers or bullets to an 

existing list. 

To create a new numbered list, follow these steps: 

1. Place the insertion point where you want to begin the numbered list in your 

document. 

2. Select Format, Bullets and Numbering. The Bullets and Numbering dialog box 

appears. 

3. For a numbered list, select the Numbered tab (see Figure 15.1). 

Figure 15.1. Use the Numbered tab on the Bullets and Numbering dialog 

box to select a number style for your numbered list. 

 

1. On the Numbered tab, click the style box for the particular style that you want to 

use for the numbers in the list. If you want to customize any of the default styles 

offered, select the style box and then click the Customize button. The Customize 

Numbered List dialog box appears (see Figure 15.2). 

Figure 15.2. The Customize Numbered List dialog box enables you to set 

the number style, format, and start number for the list 
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1. Use this dialog box to change the number style, the format, the start number, the 

font for the numbers, or the number position. A preview of your changes appears 

at the bottom of the dialog box. 

2. When you have selected your options for the number style for your list, click OK. 

You are returned to the Bullets and Numbering dialog box. Click OK to return to 

the document. 

You can also easily create a bulleted list using the Bullets and Numbering dialog box; 

follow these steps: 

1. To start a bulleted list, open the Bullets and Numbering dialog box, as previously 

discussed (select Format, Bullets and Numbering). Click the Bulleted tab. 

2. Select the bullet style you want to use by clicking the appropriate box. If you need 

to customize your bullet style, click the Customize button. The Customize 

Bulleted List dialog box will open  

Using Word Tables 

In this lesson, you learn how to create and format tables in your Word document. You 

also learn how to place math formulas in a table. 



Understanding Tables and Cells 

A Word table is made up of vertical columns and horizontal rows—a tabular format. A 

tabular format gives you flexibility to arrange text and graphics in an organized fashion 

using columns and rows. Tables enable you to enter and work with information in a self-

contained grid. Information is entered into a table cell. 

Cell A table cell is the intersection of a column and row. 

 

Word makes it easy for you to create a table of any size with any number of columns and 

rows in your document and then edit it. In addition to editing text or graphics in a table, 

you have access to several formatting options related to the table itself, such as row and 

column attributes and the capability to easily add or delete rows and columns from the 

table. 

Creating Tables 

Word offers you several approaches for actually placing the table into the document. You 

can insert the table into the document or draw the table using the Draw Table command. 

Let's take a look at inserting a table, which allows you to quickly specify the number of 

rows and columns to be used. We can then look at drawing a table into a document. 

Inserting a Table 

One option for placing a table into your document is inserting the table. Inserting a table 

enables you to select the number of rows and columns in the table. The height and the 

width of the rows and columns are set to the default (one line space [based on the current 

font height] for the row height and 1.23 inches for the column width). Using the Insert 

command for a new table is the simplest way to select the number of rows and columns 

for the table. Also, to place the table, you need only place the insertion point at the 

position where the new table is to be inserted. The insertion point marks the top-left 

starting point of the table. 

Inserted tables are static; you can move them to a new location in a document only by 

selecting the entire table and then using cut and paste. If you want to have better control 

over the placement of the table, you might want to draw a table (as described in the next 

section). This type of table can be dragged to any location in the document because it is 

created inside a portable frame. 

To insert a table into your document, follow these steps: 

1. Place the insertion point in the document where you want to place the table; select 

Table, and then point to Insert. Select Table from the cascading menu. The Insert 

Table dialog box appears (see Figure 16.1). 
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Figure 16.1. The Insert Table dialog box enables you to specify the number of 

columns and rows for your new table. 

 

1. Use the spin arrows in the Number of Columns text box to set the number of 

columns. Use the click arrows in the Number of Rows text box to set the number 

of rows. 

2. If you want to set the number of columns and rows as the default for subsequent 

tables, click the Remember Dimensions for New Tables check box. 

3. To set the table so that it automatically adjusts the column widths to 

accommodate the text that you type in the column, select the AutoFit to Contents 

option button. If you are going to save the Word document containing the table as 

a Web document (and use it on a Web site), select the AutoFit to Window option 

button. This allows the table to automatically adjust within a Web browser 

window so that it can be viewed when the browser window is sized. 

4. When you have completed your settings for the table, click OK. 

The table is inserted into your document. 

Drawing a Table 

An alternative to inserting a table into your document is to draw the table. This method 

creates a table that resides inside a table frame. The frame can then be dragged to any 

position in the document. You actually draw the table with a drawing tool and use the 

tool to add rows and columns to the table. 

When you draw the table, you will find that it is created without any rows or columns. 

You then must manually insert the rows and columns using the Table Drawing tool. 



Although you can build a highly customized table using this method, it is not as fast as 

inserting a table with a prescribed number of rows and columns, as described in the 

previous section. 

To draw a table in your document, follow these steps: 

1. Select Table, Draw Table. The mouse pointer becomes a "pencil" drawing tool. 

The Tables and Borders toolbar also appears in the document window. 

2. Click and drag to create the table's outside borders (its box shape). Release the 

mouse when you have the outside perimeter of the table completed. 

3. To add rows and columns to the table, use the pencil to draw the row and column 

lines (hold down the left mouse button and drag the mouse; see Figure  

Figure 16.2. With the table drawing tool, you can draw a table in your document, and 

then draw in the row and column lines. The borders all snap to right-angled lines on 

an unseen grid so that your table will always have straight lines. 

 

 

1. When you have completed your table, click the Draw Table button on the Tables 

and Borders toolbar to deactivate the Draw Table feature (this button is a toggle 

and can also turn the drawing tool back on when clicked). 

The Tables and Borders toolbar provides you with buttons that enable you to edit the 

attributes of the table. Several of the buttons on the Tables and Borders toolbar are useful 

for customizing your table: 
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• Distribute Rows Evenly— This button makes the row heights in the table all 

the same. 

• Distribute Columns Evenly— This button makes all the column widths 

consistent. 

• Eraser— This button enables you to turn on the eraser; drag it across any row 

or column line in the table to erase it. 

• Line Style— This drop-down box enables you to change the weight and style of 

the row or column lines you create. 

You can also move the table anywhere on the document page (it's not anchored in one 

place like tables that are placed on the page using the Insert Table command). Place the 

mouse on the upper-left edge of the table and a Move icon (a four-headed arrow) appears. 

Drag the icon to a new location on the page. When you release the mouse, the table is 

placed in the new location. 

Entering Text and Navigating in a Table 

Entering text into the table is very straightforward. Click in the first cell of the table (the 

open box where the first column and first row of the table meet) and enter the appropriate 

text. To move to the next cell (horizontally, then vertically), press the Tab key. You can 

continue to move through the cells in the tables by pressing Tab and entering your text. If 

you want to back up a cell, press Shift+Tab. This moves you to the cell to the left of the 

current cell and selects any text entered in that cell. 

Several other keyboard combinations are useful as you work in your table: 

• Alt+Home— Takes you to the first cell in the current row 

• Alt+Page Up— Takes you to the top cell in the current column 

• Alt+End— Takes you to the last cell in the current row 

• Alt+Page Down— Takes you to the last cell in the current column 

Of course, you can use the mouse to click any cell of the table at any time. 

Inserting and Deleting Rows and Columns 

Even after creating your table, you still have complete control over the number of rows 

and columns in it. You can delete empty or filled rows and columns depending on your 

particular need. 

To insert a row or column into the table, place the insertion point in a cell that is in the 

row or column next to where you want to place a new row or column. Select the Table 

menu and then point to Insert to see the available options. Options can be selected from a 

cascading menu: 

• Rows Above— Insert a new row above the selected row. 



• Rows Below— Insert a new row below the selected row. 

• Columns to the Left— Insert a new column to the left of the selected column. 

• Columns to the Right— Insert a new column to the right of the selected column. 

You can also easily delete columns or rows from your table. Select the rows or columns, 

and then select the Table menu. Point at Delete, and then select Columns or Rows from 

the cascading menu, as appropriate. The columns or rows selected are removed from the 

table. 

Formatting a Table 

Formatting a table can involve several things: You can change the width of a column or 

the height of a row, and you can also format the various table borders with different line 

weights or colors. Some of the table attributes can be modified directly on the table, but 

other attributes are best handled by modifying settings in the Table Properties dialog box 

or by using the AutoFormat dialog box. 

Modifying Cell Size 

An important aspect of working with your rows and columns is adjusting column widths 

and row heights to fit the needs of the information that you place inside the table cells. 

Both of these formatting tasks are mouse work. However, when you want to enter an 

actual value for all the column widths or row heights, you can use the Table Properties 

dialog box discussed in this section. 

Place the mouse pointer on the border between any columns in your table. A sizing tool 

appears (see Figure 16.3). Drag the sizing tool to adjust the width of the column. 

You can also adjust the column widths and the row heights in the table using the Table 

Properties dialog box. If you want to adjust the row or column attributes for just one row 

or column, make sure the insertion point is in that row or column. If you want to adjust 

the values for the entire table, click anywhere in the table, choose the Table menu, point 

at Select, and then choose Table. This selects the entire table. 

Follow these steps to open the dialog box and adjust the various properties associated 

with the current table: 

1. Select Table, Table Properties. The Table Properties dialog box appears. 

2. To adjust column widths using the dialog box, select the Column tab. 

3. Make sure the Specify Width check box is selected, and then use the width click 

arrows to adjust the width (see Figure 16.4). 

Figure 16.4. Adjust your column widths using the Column tab of the 

Table Properties dialog box. 
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1. If you want to change the width of the next column, click the Next Column 

button. The Previous Column button enables you to adjust the width of the 

previous column. 

2. When you have completed adjusting column widths, click the OK button. 

You can adjust row heights in a like manner. Use the Row tab of the Table Properties 

dialog box. You can use the Specify Height box to specify the row height and the 

Previous Row and Next Row buttons to specify the row for which you want to adjust the 

height. 

Formatting Table Borders 

Formatting your table borders is a matter of selecting the cells (or the entire table) and 

then selecting the formatting parameters. After you've selected the appropriate cells, 

select the Format menu, and then select Borders and Shading. 

Figure 16.5. Use the Borders and Shading dialog box to select the border options for your 

table. 

 

 

To select the border style, choose from one of the following: 



• Box— This places a box around the outside of the table. 

• All— This places a box around the table, gridlines inside the table, and also 

applies any shadow and color parameters that have been set in Word. 

• Grid— This places a border around the table and places a border (grid) on the row 

and column lines. 

• Custom— When you select Custom, you must then specify on the Preview table 

the border lines you want to format. To change the style, color, and width of your 

border lines, use the Style, Color, and Width drop-down boxes to select the 

options for your border lines. When you have completed your selections, click 

OK to return to the table. 

The border options that you selected are used to format the cells that you selected in the 

table. 

 

Automatically Formatting the Table 

You can also format your table in a more automatic fashion using the Table AutoFormat 

feature. This feature enables you to select from a list of predetermined table formats that 

configure the borders and provide text and background colors in the cells; you can even 

select a particular font for the text contained in the cells. 

To AutoFormat your table, click any cell of the table and then follow these steps: 

1. Select Table, Table AutoFormat. The Table AutoFormat dialog box appears. 

2. To preview the various formats provided, click a format in the Formats scroll box. 

A preview of the format is shown. 

3. When you have found the format that you want to use (you can choose from about 

50), select the format and then click Apply. 

Placing a Formula in a Table 

You can also place formulas in your tables that can do a variety of calculations. You can 

add cells to show a total, calculate an average, and do statistical calculations such as max 

and min, which return the maximum or minimum (respectively) from a list of numbers. 

Before working with formulas, however, you should become familiar with how cell 

addresses are determined. Each column in the table is given a letter designation starting 

with A. So, the first column is A, the second is B and so on. The first row in the table is 

1. The second row would be 2 and so on. The first cell in a table, which is in column A 

and row 1 would be cell A1. Each cell's address is the column letter followed by the row 

number. 

To specify a group of cells to be acted on by a formula, you have to specify the first cell 

in the group and then the last cell in the group. So if you were adding cells B2, B3, B4, 



and B5, you would designate the cell group as B2:B5. This tells Word where the cells to 

act on begin and end. 

Another thing you should know is that table formulas have to be created in a very specific 

way. Each formula must start with an equal sign (=) followed by the name of the formula 

(such as SUM for adding or AVERAGE for average). The cells to be acted on are then 

entered in parentheses following the name of the formula. A formula that provides you 

the average of cells B2:B5 would look like this: 

=AVERAGE(B2:B5) 

To place a formula in a table, follow these steps: 

1. Click in the table cell where you will place the formula. 

2. Select Table, Formula. The Formula dialog box appears as shown in Figure 16.6. 

3. Figure 16.6. The Formula dialog box allows you to insert a formula into 

a Word table. 

 

1. In many cases, the Formula dialog box will use cell position to interpret the best 

formula to insert into the table. For example, in Figure 16.6, Word "sees" that you 

have a column of numbers above the formula cell and so will probably want to 

add (SUM) cells above. If this is the appropriate formula, click OK and the 

formula (and its result) will be inserted into the table. 

2. If you want to paste a different formula into the table cell, select and Delete the 

formula provided. 

3. In the Formula box, type an equal sign (=) and then click the Paste Function drop-

down list to insert a new formula. 

4. To specify the cells to be acted on by the formula, place the starting and ending 

addresses of the cell grouping (separated by a colon). 

5. Click OK to place the formula in the table. 
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Adding Graphics to Documents 

In this lesson, you learn how to insert graphics, such as clip art, into your document and 

how to use the Word drawing tools to create your own graphics. 

Inserting a Graphic 

Adding a graphic to your document is really just a matter of identifying the place in the 

document where you want to place the picture and then selecting a specific graphic file. 

Word provides you with a large clip-art gallery of ready-made graphics (in the Windows 

metafile format, .wmf), and you can also place images into your document that you find 

on the World Wide Web, that you receive attached to e-mail messages, that are imported 

from a scanner or digital camera, and more. 

Word also embraces several graphic file formats, including the following file types: 

• CompuServe GIF (.gif) 

• Encapsulated PostScript (.eps) 

• Various paint programs (.pcx) 

• Tagged Image File format (.tif) 

• Windows bitmap (.bmp) 

• JPEG file interchange format (.jpg) 

• WordPerfect graphics (.wpg) 

To add a graphic file to your document, you insert the image using the Insert menu. 

Follow these steps to add a graphic to your document: 

1. Place the insertion point where you want to place the graphic in the document. 

2. Select Insert, Picture, and then select From File on the cascading menu. The Insert 

Picture dialog box appears. 

3. Use the Look In box to locate the drive and folder that contains the picture file. 

After you locate the picture, click the file to view a preview (see Figure 18.1). 
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1. After you select the picture you want to insert into the document, click Insert in 

the lower-right corner of the Insert Picture dialog box. 

The picture is placed in your document, and the Picture toolbar appears in the document 

window. The Picture toolbar provides several tools you can use to modify and edit the 

graphics in your document. See the "Modifying Graphics" section in this lesson for more 

information on this toolbar. 

Probably the first thing you will want to do to any graphic or picture that you insert into a 

document is to size the image so that it fits better on the page in relation to your text. 

Most inserted graphics, even those from the Office clip-art library, tend to be inserted 

into a document in a fairly large size. 

To size a graphic, click it to select it. Sizing handles (small boxes) appear on the border 

of the graphic. Place the mouse on any of these sizing handles. The mouse pointer 

becomes a sizing tool with arrows pointing in the directions in which you can change the 

size; drag to size the graphic. To maintain the height/width ratio of the image (so you 

don't stretch or distort the image), use the sizing handles on the corners of the image and 

drag diagonally. 

Using the Word Clip Art 

If you don't have a collection of your own pictures and graphics to place in your 

document, don't worry; Word provides a large collection of clip-art images you can use to 



liven up your documents. The clip-art library is organized by theme. For example, if you 

want to peruse the animal clip art that Word provides, you can select the Animal theme. 

To insert Word clip art into your document, follow these steps: 

1. Place the insertion point where you want to place the graphic in the document. 

2. Select Insert, Picture, and then select Clip Art on the cascading menu. The Clip 

Art task pane appears (see Figure 18.2). 

Figure 18.2. The Clip Art task pane gives you access to the Word clip art 

gallery. 

 

1. Type the name of a clip-art theme, such as Animals, into the Search For box. 

2. (Optional) By default, the search will be conducted on all your media collections, 

including the Office and Web Collections. If you want to exclude certain 

collections from the search (to speed up the search process), click the Search In 

drop-down arrow and clear the check mark from any of the locations listed. 

3. (Optional) If you want to exclude certain file types from the search (to speed up 

the search process), select the All Media File Types drop-down box and deselect 

any of the file types (ClipArt, Photographs, and so on) as required. 
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Sound and Action Imagery Available, Too You can insert sound or 

movie clips into your document from the Clip Art task pane. By default 

they are included in the results for any search you conduct. 

4.  

 

5. Click the Go button, and various clip-art images that fit your search criteria 

appear. 

6. When you have located the clip art you want to place in the document, click the 

image. An image drop-down box appears. Select Insert to place the image in your 

document (see Figure 18.3). 

Figure 18.3. Click a particular clip-art category to view the clip-art 

images. 

 

If used appropriately, pictures and clip art can definitely improve the look and feel of 

your documents, particularly special documents such as flyers, newsletters, and 

brochures. If you find that the clip-art library provided doesn't have what you need, click 

the Clip Art on Microsoft.com link near the bottom of the task pane. Your Web browser 

opens and takes you to Microsoft's online clip-art library, which offers additional clip-art 

images for your use. 

Using the Word Drawing Toolbar 

You can also create your own graphics in your documents using the drawing tools 

provided on the Word Drawing toolbar. This toolbar provides several tools, including 

line, arrow, rectangle, oval, and text box tools. You can also use the appropriate tools to 
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change the fill color on a box or circle, change the line color on your drawing object, or 

change the arrow style on arrows you have placed on the page. 

To display the Drawing toolbar, select View, point at Toolbar, and then select Drawing 

from the toolbar list. 

 

Quickly Access Toolbars You can also right-click any toolbar in the 

Word window to access the toolbar list; then select Drawing 

  

 

The Drawing toolbar appears at the bottom of the document window just above the Word 

status bar. Figure 18.6 shows the Drawing toolbar and the tools available on it. 

Word provides you with an add-on program called WordArt that enables you to 

create special text effects in your document. You can create text that wraps around a 

circle, as well as a number of other special text "looks." In Word, click the WordArt 

button on the Drawing toolbar to start the WordArt program. WordArt can also be used in 

other Office programs, such as PowerPoint, to create visually exciting text items. 

Another useful Drawing tool is the Insert Diagram or Organization Chart button. 

Click this button to add predesigned organizational charts and other special diagrams to a 

document. 

Creating a New Object 

To draw a particular object, click the appropriate button on the toolbar. Then, drag 

the mouse to create the object in your document. To draw a square or circle, click the 

Rectangle tool or the Oval tool and hold down the Shift key as you draw the object with 

the mouse. If you find that you aren't very good at actually drawing graphical objects, 

click the AutoShapes drop-down arrow (near the left side of the drawing toolbar) and 

select a particular object shape from the list provided. 

Modifying Drawn Objects 

You can also control the various attributes for a particular object that you've drawn. You 

must first select the object using the selection pointer (click the Select Objects tool, and 

then click the object). You can manipulate the object's line style, fill color, and line color. 

Just choose the appropriate tool on the toolbar, and make your selection from the list of 

possibilities. 
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You can also size and move objects that you draw. Select an object, and use the sizing 

handles to increase or decrease the size of the particular object. If you want to move the 

object to a new position, place the mouse pointer in the middle of the selected object and 

drag it to a new position. 

If you draw several related objects, you can select all the objects at once and drag them 

together to a new location. Select the first object and then hold down the Shift key and 

select subsequent objects, as needed. When you drag any of the objects to a new location, 

all the selected objects move together. 

At times you will want to delete a particular object from your document. Simply select 

the object and then press Delete to remove it. 

You will find that the Drawing toolbar provides you with all the tools (except natural 

artistic ability) you need to create fairly sophisticated custom images. A little practice 

with the various tools goes a long way in helping you create objects that add interest to 

your documents. 

 

 

Creating Personalized Mass Mailings 

In this lesson, you learn how to create form letters, envelopes, and mailing labels for 

mass mailings using the Word merge feature. 

Understanding the Mail Merge Feature 

Word makes it easy for you to take a list of names and addresses and merge them with a 

form letter, an envelope template, or mailing labels. This enables you to quickly create 

items for mass mailings that appear to be customized for each person on the mailing list. 

Although the Mail Merge Wizard walks you through the merge process, the entire 

procedure can be somewhat confusing. Two different documents are used during the 

merge process: a main document and a data source. The main document is your form 

letter or mailing label template, and the data source is a Word document that provides the 

list of names and addresses that are inserted into the main document during the merge. 

The data source can be created prior to the mail merge or during the process. 

The information in the data source is inserted into the form letter or mailing label using 

placeholder codes called merge fields. Each merge field in the main document relates to a 

piece of information in the data source document, such as first name or street address, 

and the merge field gets its name from that particular field in the data source. 



 

Merge Fields Codes serve as placeholders in your main document; for 

example, { FirstName} is an example of a merge field code that serves 

as a placeholder for the first-name information that is pulled from the 

data source. 

 

 

Data Source The file of information, such as a list of names and 

addresses, to be merged into the main document (such as form letters, 

envelopes, or mailing labels). Data sources in Word typically take the 

form of a table, with each row in the table containing the name and 

address of a different individual. 

 

The best way to understand how the various elements of the merge process—the main 

document, the data source, and field codes—relate is to actually perform a merge. 

Working through a merge that creates form letters for the entire list of people in a data 

source is a good place to start because creating other merge documents, such as labels 

and envelopes, is a similar process. 

Because the merge process really consists of four different actions—creating the main 

document, creating the data source, inserting the merge fields into the main document 

(based on the data in the data source), and finally running the merge—this lesson breaks 

down each of these actions in their own section. We begin with starting the Mail Merge 

Wizard and creating the main document. 

Specifying the Main Document 

The first step in the merge process is to specify a main document for the merge. The main 

document can be the currently open document in the Word workspace, or you can open a 

pre-existing document during the merge process. To begin the merge process and 

designate a main document for the merge, follow these steps: 

1. Open a new, blank document in the Word window; click the New Blank 

Document icon on the Standard toolbar. 

2. Select Tools, point at the Letters and Mailing arrow, and then select Mail Merge 

Wizard. The Mail Merge task pane opens, as shown in Figure 19.1. 

Figure 19.1. The Mail Merge task pane walks you through the steps of 

merging a main document with a data source. 
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1. Under Select Document Type on the Mail Merge task pane, choose the type of 

main document you want to create using one of the following option buttons: 

Letters, E-Mail Messages, Envelopes, Labels, or a Directory. A directory, in this 

case, is a list of names and addresses that the wizard creates (like a phone book). 

It does not create a separate item for each person in the data source as the other 

options do. 

2. After selecting the appropriate option button (for this example, Letters has been 

selected), click the Next: Starting Document link at the bottom of the task pane. 

3. The next wizard step provided in the task pane provides three different option 

buttons; select one of the following: 

o Use the Current Document— This option enables you to build your main 

document using the new, blank document that was opened in step 1 (and 

this will be the approach that we use in the steps that follow in this 

section). 

o Start from a Template— When this option button is selected, a Select 

Template link appears in the Mail Merge task pane. Click Select 

Template, and the Select Template dialog box appears. This dialog box 

enables you to base your main document on any of Word's document 

templates. After selecting a particular template on one of the dialog box 

tabs, click OK to return to the Mail Merge task pane. 



o Start from Existing Document— If you select this option button, a Start 

from Existing File box appears in the task pane. Click the Open button at 

the bottom of the box. The Open dialog box appears. Use it to select the 

existing Word document that will serve as the main merge document. 

Click OK to close the Open dialog box and return to the task pane. 

4. After selecting one of the options (as discussed in step 5), click the Next: Select 

Recipients link at the bottom of the task pane. This allows you to either create or 

specify the document that contains the names and addresses (the data source) that 

you will use for the merge. We discuss the data source document in the next 

section. 

A few things should be said about the options available in step 4. When you select one of 

these options, you are only setting the stage for how the main document will look when it 

is completed (meaning when the merge fields and any text that the document will include 

have been inserted). 

If you use a blank document, you will have to add any special formatting or document 

layout features that you want to include in the document (as well as all the text that the 

document will contain). If you use an existing document, it can already contain the body 

text for the form letter and various formatting attributes. Using the document template 

option enables you to use one of Word's templates to determine the overall look of the 

document. Templates also often insert placeholder text in a document, allowing you to 

quickly replace it with text of your own. Of course, there's no guarantee that the style of 

templates Word provides by default will suit your needs. 

No matter how you create the main document (using the options we discussed in this 

section), field or merge codes will need to be inserted. The actual field codes used will be 

determined by the data source document, which we discuss in the next section. 

Creating or Obtaining the Data Source 

The next step in the process is to open or create a data source document. This document 

not only provides the names and addresses that will be merged into your form letter, but 

it also dictates the merge fields that are placed in the main document (as placeholders for 

the actual data that will be placed in the form letters during the merge). 

Creating a data source during the Mail Merge process is very straightforward because the 

Mail Merge Wizard provides you with a form that you use to enter people's names, 

addresses, and other information. When you enter the information for a particular person, 

you are creating a record. Each record pertains to one person. 

However, you also can use existing data sources for the merge. For example, you can use 

Access database tables (see Part VI, "Access," for information on creating databases in 

Access), your Outlook Contacts list, or any Word data source document that you created 

for a previous merge. 
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To provide you with a complete, from-scratch look at the merge process, we will create a 

new data source document in this section of the lesson. The following steps pick up from 

the preceding section, where we specified the main document for the merge. 

 

Record Information in the data source that contains information about 

a particular person (or place or thing). 

 

 

Merge Field A code that tells Word to automatically insert information 

into your main document during the merge. For example, the Last 

Name field inserts your letter recipient's last name. 

1. In the Mail Merge task pane (which currently shows Step 3 of 6, as shown in 

Figure 19.2), choose one of the following options to specify the data source for 

the merge: 

o Use an Existing List— This option is selected by default. If you have a 

Word document that contains a table or an Access table that contains the 

name and address information you want to use for the merge, select the 

Browse button in the task pane. This opens the Select Data Source dialog 

box. Locate your data source file, select it, and then click Open to return to 

the Word window and the Mail Merge task pane. The Mail Merge 

Recipients dialog box appears in the Word window, providing a data 

source list based on the source file (it will look the same as the Mail 

Merge Recipients dialog box shown later in Figure 19.4). 

Figure 19.4. Use the Mail Merge Recipients dialog box to sort or 

select the recipients of the form letter. 
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o Select from Outlook Contacts— This option enables you to select the 

names and addresses for the merge from your Outlook Contacts. When 

this option is selected, a Choose Contacts Folder link appears in the task 

pane. Click the link and specify the location of your Contacts folder in the 

Select Contact List Folder dialog box that opens (in almost all cases it 

finds your Contacts folder for you). Click OK to return to Word and the 

task pane. The Mail Merge Recipients dialog box appears containing a list 

of your contacts (it is the same as the dialog box shown later in Figure 

19.4). 

o Type a New List— This option enables you to create a new data source 

(you will use this option to explore how you create a new data source). 

After selecting this option, click the Create button in the task pane to open 

the New Address List dialog box (you explore this dialog box in step 2). 

Figure 19.2. You can use an existing document or your Outlook Contacts 

list as the data source, or you can create a new data source from scratch. 
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1. After selecting one of the options listed in step 1 and clicking the Create link, 

either the Mail Merge Recipients dialog box appears (when you select either the 

existing list or Outlook Contacts list options; we discuss the Mail Merge 

Recipients dialog box in step 5) or, in the case of the Type a New List option 

(which we select here as we explore this feature), the New Address List dialog 

box appears (see Figure 19.3). 

Figure 19.3. Use the New Address List dialog box to create the new data 

source for the merge. 

 

1. Enter the name, address, and other information that you want to place in the 

record for the first recipient. When you have finished entering the data, click the 

New Entry button on the New Address List dialog box to enter the next record. 

2. Enter additional records as needed. When you have finished entering your 

records, click the Close button on the New Address List dialog box. The Save 

Address List dialog box opens. 

3. Enter a name for the file and specify a location (if necessary—by default, the 

address list is saved in a special My Data Sources folder that was created when 

you installed Office). Click Save to save the data source file. 

4. The Mail Merge Recipients list appears (see Figure 19.4). If you used your 

Outlook Contacts list or an existing data source, this dialog box appears after you 

completed step 1 in this section. 
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5. If you want to deselect any of the recipients in the Mail Merge Recipients dialog 

box, clear the check box to the left of their records. If you want to sort the list by a 

particular field (such as last name), click that column's heading. 

6. After selecting recipients or sorting the recipient list, click OK to close the Mail 

Merge Recipients dialog box. 

After creating your recipient list as discussed in this section, you are ready to complete 

the main document and enter the merge fields. These topics are discussed in the next 

section. 

Completing the Main Document and Inserting the Merge Fields 

Now that you have specified the recipients for the merge, you can add text, such as the 

body of the letter, to the main document. The merge fields that pull information from the 

data source can also be inserted. 

Inserting merge fields is a very straightforward process. You can insert individual merge 

fields for information, such as first name and last name, or you can allow Word to 

automatically insert several fields into the letter. For example, you can click the Address 

Block icon that the Mail Merge task pane provides. This inserts the merge fields for the 

recipient's name and the appropriate address merge fields. 

Follow these steps: 

1. After specifying or creating a data source (as detailed in the last section), click the 

Next: Write Your Letter link at the bottom of the task pane. 

2. The Write Your Letter (step 4 of 6) part of the merge process appears in the Mail 

Merge task pane (see Figure 19.5). 

Figure 19.5. You can insert merge fields into the form letter using the 

icons in the task pane. 
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1. A good practice is to go ahead and click in the blank main document and type 

your letter text, such as the body of the letter. You can also add the closing of the 

letter or any other information. 

2. You can insert the merge fields after typing the text for the letter. Place the 

insertion point in the main document where you want to place the first merge 

field. For example, to place recipients' addresses in a form letter, place the 

insertion point four lines above the greeting. Click the Address Block icon in the 

task pane. The Insert Address Block dialog box appears. 

3. The Insert Address Block dialog box provides you with different formats for 

inserting the recipient's name and their address information. Choose one of the 

formats listed (see Figure 19.6). 

Figure 19.6. You can insert merge fields into the form letter using the 

icons in the task pane 
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1. Option buttons related to the inclusion of the country/region field in the address 

block are also included. Select the appropriate option button, and click OK to 

close the dialog box. Word inserts the Address Block code into the letter. 

Now that you've inserted an Address field, move the insertion point to the position where 

you want to place the next set of merge fields—for example, the Greeting line. 

To insert a Greeting line, click the Greeting Line icon on the task pane. The Greeting 

Line dialog box appears. Use the drop-down lists to select the format for your letter's 

greeting line, including the punctuation used at the end of the line, such as a comma or a 

colon, and to insert the appropriate merge fields, such as Last Name, that would be 

included on the greeting line. Then, click OK. 

You can insert any other merge fields, as needed, into the document. If you want to insert 

individual merge fields into the letter, click the More Items icon on the task pane. The 

Insert Merge Field dialog box appears. Select a merge field, and then click Insert. When 

you have finished inserting any needed merge fields, click Close. 



Finally, you might want to insert a date at the top of your form letter (the main 

document). Press Ctrl+Home to go to the top of the document, and then select Insert, 

Date and Time. Select your date format in the Date and Time dialog box, and then click 

OK to insert the date. 

Figure 19.7 shows a main document that has been completed. Note that it contains merge 

fields for the address block and greeting line. 

Figure 19.7. Your finished main document will include merge fields, a date, and 

the body text for the letter 

 

 

After you've finished your form letter (including the insertion of the appropriate merge 

fields), you are ready to complete the merge. The next section discusses the completion 

of the merge and the viewing of your finished form letters. 

Merging the Documents 

The next step in the merge process is to have Word create the merged documents so that 

you can preview the letters that are created. This enables you to be sure that the merge 

worked correctly (based on the merge fields you placed in the main document). It also 

enables you to edit any of the form letters created before you print them. Although the 
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Mail Merge task pane allows you to preview each letter separately, the merge process 

actually creates a single document that places each form letter on a separate page. 

Follow these steps: 

1. Click the Next: Preview Your Letters link at the bottom of the task pane (refer to 

Figure 19.6; this is step 4 of 6 and picks up where the previous section left off). 

2. The first form letter appears in the Word window (see Figure 19.8). Check to be 

sure that the merge fields have placed the appropriate information into the form 

letter. To view the next recipient's letter, click the Next button (>>) at the top of 

the task pane 

Figure 19.8. You can view each form letter created by the merge 

 

1. Continue to view the form letters that were created during the merge (using the 

Next button; if you want to go back to a previous letter, click the Previous button, 

<<). If you come across a letter to a recipient that you do not want to keep as part 

of the merge, click the Exclude This Recipient button. The form letter is deleted 

and the form letter for the next recipient appears in the Word window. 

2. When you have finished viewing the form letters created by the merge and are 

ready to complete the merge process, click the Next: Complete the Merge link at 

the bottom of the task pane. 

3. To send the form letters to your printer, click the Print icon on the task pane. 

Word sends the letters to your printer. 

4. If you want to save the form letters so that you can print them in the future (or 

save them for later reference), click the Save button on the Standard toolbar. 

Provide a name and location for the document in the Save As dialog box. Then, 

click Save to save the document. 
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After you print the form letters or save the merged document, the merge process is 

complete. At this point, you can close the task pane, if you want to. Click its Close (X) 

button. 

 Creating Envelopes and Mailing Labels 

The procedure for using the merge feature discussed in this lesson assumes that you are 

using a form letter as your main document and creating copies of the letter for each 

person listed in the data source. You can also use the merge feature to create other 

document types, such as envelopes and labels. 

The procedure for creating envelopes, mailing labels, or letters is almost the same. In 

each case, you use the Mail Merge Wizard to specify the type of document that you are 

creating, and then the wizard walks you through the entire merge process. The steps that 

follow discuss how to create envelopes using the Mail Merge Wizard, but you can just as 

easily create mailing labels using this process. 

To create envelopes using the Mail Merge Wizard, follow these steps: 

1. Open a new blank document (click the New Blank Document icon on the 

Standard toolbar). Select Tools, point at Letters and Mailing, and then select Mail 

Merge Wizard. The Mail Merge task pane opens. 

2. Under Select Document Type, select Envelopes. 

3. Click Next: Starting Document at the bottom of the task pane. 

4. On the next task pane screen, select the Change Document Layout option button 

(if necessary). To select the envelope type to use for the merge, click the 

Envelope Options icon. The Envelope Options dialog box will appear (see Figure 

19.9). 

Figure 19.9. Choose the type of envelope you need in the Envelope 

Options dialog box. 
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1. Select the envelope type you want to use for the merge using the Envelope Size 

drop-down list. If you want to edit any of the fonts for the envelope, use the 

appropriate Font button on the dialog box. When you have finished setting your 

envelope options, click OK. 

2. To proceed to the next step in the merge, click Next: Select Recipients at the 

bottom of the task pane. 

3. You will need to open or create a data source document. After you open or create 

a new data source (as discussed earlier in this lesson), the Mail Merge Recipients 

dialog box appears. Click OK to close this dialog box. 

4. To proceed to the next step in the merge process and place the merge fields on the 

envelope, click Next: Arrange Your Envelope. 

5. Insert the merge fields on the envelope using the Address Block or More Items 

icons provided in the Mail Merge task pane. To center the recipient address on the 

envelope, press Enter as required and then click the Center icon on the Formatting 

toolbar. 

6. After placing the merge fields on the envelope, click Next: Preview Your 

Envelopes. Use the Next (>>) or Previous (<<) buttons as needed to view all the 

envelopes. Remove any envelopes that you do not want to create by clicking the 

Exclude This Recipient button on the task pane. 

7. To complete the merge, click Next: Complete the Merge at the bottom of the task 

pane. 



At this point, you can click the Print icon on the task pane to send the envelopes to your 

printer. You also can save the envelope document created (each recipient's envelope is 

placed on a separate page in the merged document) and then print individual pages as 

needed (click the Save button on the Standard toolbar). 

A macro is a shortcut to a task you do repeatedly. Think about the Centre align operation. 

You first highlight the word you want centred, then click the centre icon in the toolbar. 

This is a macro. It's the short way of performing the centre task.  

But you don't have to do it that way. There is a longer way. You can centre your text by 

clicking on Format from the menu bar. When the menu drops down, click Paragraph. 

You'll get a dialogue box popping up. Click the down arrow in the Alignment box, and 

then click on centre. Click OK on the dialogue box and your text is centred. That's the 

long way round.  

Clicking the centre icon on the toolbar is much easier - it's a very useful Macro built in to 

Microsoft Word. 

Macro in ms word-- 

A Macro is a way to create a shortcut for a task that you do a lot. 

You can create your own macros. The macro we're going to create in the next section is a 

very simple one, but macros don't have to be simple. You can open up the Visual Basic 

editor and create a very complex macro indeed. Some malicious people even create Word 

macros that can do very nasty things to your computer! 

So, after that little scare story, let's create our very own macros. This one is very simple, 

and definitely won't set off the alarm bells in your Anti-Virus software.  

You can create a macro by using the macro recorder to record a sequence of actions, or 

you can create a macro from scratch by entering Visual Basic for Applications code in 

the Visual Basic Editor. 

You can also use both methods. You can record some steps and then enhance them with 

additional code. 

By recording steps 

1. On the Tools menu, point to Macro, and then click Record New Macro. 

2. In the Macro name box, type a name for the macro. 

3. In the Store macro in box, click the template or document in which you want to 

store the macro. 

4. In the Description box, type a description for the macro. 

5. If you don't want to assign the macro to a toolbar, a menu, or shortcut keys, click 

OK to begin recording the macro.  
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To assign the macro to a toolbar or menu, click Toolbars, and then click the Commands 

tab. In the Commands box, click the macro you are recording, and drag it to the toolbar 

or menu you want to assign it to. Click Close to begin recording the macro. 

To assign the macro to shortcut keys, click Keyboard. In the Commands box, click the 

macro you are recording. In the Press new shortcut key box, type the key sequence, and 

then click Assign. Click Close to begin recording the macro. 

6. Perform the actions you want to include in your macro.  

When you record a macro, you can use the mouse to click commands and options, but not 

to select text. You must use the keyboard to record these actions. For example, you can 

use F8 to select text and press END to move the cursor to the end of the line.  

7. To stop recording your macro, click Stop Recording . 
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Starting Excel 

Excel is a spreadsheet program that can help you create worksheets and invoices and do 

simple and sophisticated number crunching; it is designed to help you calculate the 

results of formulas and help you organize and analyze numerical data. 

To start Excel from the Windows desktop, follow these steps: 

1. Click the Start button, and the Start menu appears. 

2. Point at All Programs (in Windows XP; in Windows 2000 select Programs), and 

the Programs menu appears. 

3. Select the Microsoft Office program group and then Microsoft Office Excel 2003 

to start the program. 

 

 

 

Understanding the Excel Window 

When you click the Microsoft Excel icon, the Excel application window appears, 

displaying a blank workbook labeled Book1 (see Figure 1.1). On the right side of the 

Excel window is the Getting Started task pane. This task pane enables you to connect to 

Microsoft online. It also allows you to open existing Excel workbooks or create new 

workbooks (which is discussed later in the lesson). 

Figure 1.1. Excel provides a new workbook and the menus and toolbars 

necessary for doing some serious number crunching 
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When you work in Excel, you use workbook files to hold your numerical data, formulas, 

and other objects, such as Excel charts. Each Excel workbook can consist of several 

sheets; each sheet is called a worksheet 

 

An Excel file is called a workbook. Each workbook consists of several worksheets made 

up of rows and columns of information 

 

You enter your numbers and formulas on one of the workbook's worksheets. Each 

worksheet consists of 256 columns. The columns begin with column A and proceed 

through the alphabet. The 27th column is AA, followed by AB, AC, and this convention 

for naming subsequent columns continues through the entire alphabet until you end up 

with the last column (column 256), which is designated IV. 

Each worksheet also consists of 65,536 rows. The intersection of a column and a row on 

the worksheet is called a cell. Each cell has an address that consists of the column and 

row that intersect to make the cell. For example, the very first cell on a worksheet is in 

column A and row 1, so the cell's address is A1. 

 

Worksheet One sheet in an Excel workbook. Each worksheet consists of 256 columns 

and 65,536 rows (plenty of space to create even the most enormous spreadsheets). 

 

 



Cell Where a row and column intersect, each cell has an address that consists of the 

column letter and row number (A1, B3, C4, and so on). You enter data and formulas in 

the cells to create your worksheets. 

 

shows cell A1 highlighted in worksheet 1 (designated as Sheet1 on its tab) of Workbook 

1 (designated in the title bar as Book1; this will change to a particular filename after you 

name the workbook using the Save function). 

The Excel window shown here includes many of the various elements available in other 

Office applications, such as Word or PowerPoint. These elements include a menu bar 

(from which you select commands), a status bar (which displays the status of the current 

activity), and toolbars (which contain buttons and drop-down lists that provide quick 

access to various commands and features). 

In addition, the window contains several elements that are unique to Excel 

 

Elements of the Excel Window 

Element Description 

Formula bar When you enter information into a cell, it appears in the Formula bar. You 

can use the Formula bar to edit the data later. The cell's location also 

appears in the Formula bar. 

Column 

headings 

The letters across the top of the worksheet, which identify the columns in 

the worksheet. 

Row 

headings 

The numbers down the side of the worksheet, which identify the rows in 

the worksheet. 

Cell selector The dark outline that indicates the active cell. (It highlights the cell you 

are currently working in.) 

Worksheet 

tabs 

These tabs help you move from worksheet to worksheet within the 

workbook 

 

Starting a New Workbook 

As you've already seen, when you start Excel, it opens a new blank workbook. It is ready 

to accept data entry, which is discussed in Lesson 2, "Entering Data into the Worksheet." 

The empty workbook that appears when you start Excel is pretty much a blank canvas, 

but Excel also enables you to create new workbooks based on a template. A template is a 
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predesigned workbook that you can modify to suit your needs. Excel contains templates 

for creating invoices, expense reports, and other common business accounting forms. 

To create a new workbook, follow these steps: 

1. Open the File menu and select New. The New Workbook task pane appears on 

the right side of the Excel window (if you did not close it as outlined earlier, it 

should already be open). 

2. The New Workbook task pane enables you to create new blank workbooks or 

create workbooks based on an existing workbook or a template (see Figure 1.2). 

Figure 1.2. The New Workbook task pane provides quick access to 

commands for creating new Excel workbooks 

 
 

To create a blank workbook, click the Blank Workbook icon. A new blank workbook 

opens in the Excel window. 

 

You can also quickly start a new blank workbook by clicking the New button on 

the Standard toolbar. 

 

Blank templates are fine when you have a design in mind for the overall look of the 

workbook. However, for some help with workbook layout and formatting, you can base 

your new workbook on an Excel template. To use an Excel template, follow these steps: 
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1. Click the On My Computer link in the Templates pane of the New Workbook task 

pane. The Templates dialog box appears. 

2. Click the Spreadsheet Solutions tab on the Templates dialog box. The various 

workbook template icons appear (see Figure 1.3). 

Figure 1.3. The Spreadsheet Solutions templates 

 

 
 

1. Select a template by clicking its icon, and then click OK or press Enter. A new 

workbook opens onscreen with a default name based on the template you chose. 

For example, if you chose the Timecard template, the new workbook is named 

Timecard1, as shown at the top of Figure 1.4. 

Figure 1.4. A new workbook based on a template provides a basic layout for a particular 

business form 
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Saving and Naming a Workbook 

Whether you build your workbook from a blank template or use one of the Excel 

templates, after you enter some data into the workbook, you should save the file (you 

learn about data entry in Lesson 2). Also, because changes that you make to the 

workbook are not automatically saved, you should occasionally save the edited version of 

your work. 

The first time you save a workbook, you must name it and specify a location where it 

should be saved. Follow these steps to save your workbook: 

1. Open the File menu and select Save, or click the Save button on the Standard 

toolbar 

 

1. Type the name you want to give the workbook in the File Name text box. You can 

use up to 218 characters, including any combination of letters, numbers, and 

spaces. 

2. Normally, Excel saves your workbooks in the My Documents folder. To save the 

file to a different folder or drive (such as a network drive), select a new location 

using the Save In list. 

3.  

The Folder I Want to Save In Doesn't Exist! You can create a new folder from 

the Save As dialog box: click the Create New Folder button on the toolbar of the 

Save As dialog box, type a name for the new folder, and then press Enter. 

4.  
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5. Click Save to save your workbook and close the Save As dialog box. 

To save changes that you make to a workbook that you have previously saved, just click 

the Save button on the Standard toolbar. You can also press the shortcut key combination 

of Ctrl+S to save changes to your workbook. 

 

Saving a Workbook Under a New Name or Location 

There might be an occasion when you want to save a copy of a particular workbook 

under a different name or in a different location. Excel makes it easy for you to make 

duplicates of a workbook. Follow these steps: 

1. Select the File menu and select Save As. The Save As dialog box opens, just as if 

you were saving the workbook for the first time. 

2. To save the workbook under a new name, type the new filename over the existing 

name in the File Name text box. 

3. To save the new file on a different drive or in a different folder, select the drive 

letter or the folder from the Save In list. 

4. To save the new file in a different format (such as WK4, which is a Lotus 1-2-3 

format), click the Save As Type drop-down arrow and select the desired format. 

5. Click the Save button or press Enter. 

Opening an Existing Workbook 

If you have a workbook you've previously saved that you would like to work on, you 

must open the file first, before you can make any changes. Follow these steps to open an 

existing workbook: 

1. Open the File menu and select Open, or click the Open button on the Standard 

toolbar. 

2. If the file is not located in the current folder, open the Look In drop-down list box 

and select the correct drive and folder. 

3. Select the file you want to open in the files and folders list. 

4. To see a preview of the workbook before you open it, click the Views button and 

select Preview. Excel displays the contents of the workbook in a window to the 

right of the dialog box. 

5. Click Open to open the currently selected workbook. 

Closing Workbooks 

When you have finished with a particular workbook and want to continue working in 

Excel, you can easily close the current workbook. Click the Close (X) button in the upper-

right corner of the workbook. (There are two Close buttons; the one on top closes Excel, 

and the one below it closes the current workbook window.) You can also close the 



current workbook by selecting File, Close. If you have changed the workbook since the 

last time you saved it, you will be prompted to save any changes. 

Exiting Excel 

When you have finished working with Excel, you need to exit the application. This closes 

all workbooks that are currently open. To exit Excel, select the File menu and select Exit. 

Or you can click the Close (X) button at the upper-right corner of the Excel window. 

If you have changed any of the workbooks that you were working with, you are prompted 

to save changes to these workbook files before exiting Excel. 

 

Entering Data into the Worksheet---- 

Understanding Excel Data Types 

When you work in Excel, you enter different types of information, such as text, numbers, 

dates, times, formulas, and functions (which is a special built-in formula provided by 

Excel). Excel data basically comes in two varieties: labels and values. 

A label is a text entry; it is called a label because it typically provides descriptive 

information such as the name of a person, place, or thing. A label has no numerical 

significance in Excel; it's just there to describe accompanying values. 

Label Any text entry made on an Excel worksheet. 

 

A value is data that has numerical significance. This includes numbers, dates, and times 

that you enter on your worksheet. Values can be acted on by formulas and functions. 

Formulas are discussed in Lesson 3, "Performing Simple Calculations," and Excel 

functions in Lesson 5, "Performing Calculations with Functions." 

Values Entries, such as numbers and dates, that have numerical significance and can be 

acted upon by formulas or functions. 

Entering Text 

Text is any combination of letters, numbers, and spaces. By default, text is automatically 

left-aligned in a cell, whereas numerical data is right-aligned. 

Entering Numbers As Text To enter a number that you want treated as text (such 

as a ZIP code), precede the entry with a single quotation mark ('), as in '46220. 

The single quotation mark is an alignment prefix that tells Excel to treat the 
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following characters as text and left-align them in the cell. You do not have to 

do this to "text" numerical entries, but it ensures that they will not be mistakenly 

acted upon by formulas or functions. 

 

To enter text into a cell, follow these steps: 

1. Use your mouse or the keyboard arrows to select the cell in which you want to 

enter text. 

2. Type the text. As you type, your text appears in the cell and in the Formula bar 

3. Figure 2.1. Data that you enter into a cell also appears in the Formula 

bar as you type it. 

 

 

1. Press Enter. Your text appears in the cell, left-aligned. The cell selector moves 

down one cell. You can also press Tab or an arrow key to enter the text and move 

to the next cell to the right (or in the direction of the arrow). 



Tips on Entering Column and Row Labels 

Column and row labels identify your data. Column labels appear across the top of the 

worksheet beneath the worksheet title (if any). Row labels are entered on the left side of 

the worksheet. 

Column labels describe what the numbers in a column represent. Typically, column 

labels specify time intervals such as years, months, days, quarters, and so on. Row labels 

describe what the numbers in each row represent. Typically, row labels specify data 

categories, such as product names, employee names, or income and expense items in a 

budget. 

When entering your column labels, enter the first label and press the Tab key instead of 

pressing Enter. This moves you to the next cell on the right so that you can enter another 

column label. When entering row labels, use the down-arrow key or Enter instead of the 

Tab key. Figure 2.2 shows the various labels for a quarterly sales summary. 

Figure 2.2. Column and row headings serve as labels for the data you enter on 

the worksheet. 

 

If you need to enter similar data (such as a series of months or years) as column or row 

labels, you can enter them quickly as a series; this technique is discussed later in this 

lesson. 

Adding Comments to Cells 

You can add comments to particular cells, although the comments are not really 

considered cell content (such as labels and values). These comments allow you to 
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associate information with a cell—information that does not appear (by default) with the 

worksheet when sent to the printer. 

Comments are similar to placing a Post-it note on a cell, reminding you that an 

outstanding issue is related to that cell. For example, if you need to check the value that 

you've placed in a particular cell to make sure that it's accurate, you can place a comment 

in the cell (see Figure 2.3). Cells containing comments are marked with a red triangle in 

the upper-right corner of the cell. To view a comment, place the mouse pointer on the 

comment triangle. 

Figure 2.3. Comments can be added to cells as a kind of electronic Post-it note 

 

To insert a comment into a cell, follow these steps: 

1. Click the cell in which you want to place the comment. 

2. Select Insert, Comment. A comment box appears next to the cell. 

3. Type your information into the comment box. 

4. Click anywhere else in the worksheet to close the comment box. 

You can also easily remove comments from cells. Select the cell, and then select Edit and 

point at Clear. On the cascading menu, select Comments to remove the comment. 
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Entering Numbers 

Data that serves as the values in your workbooks can include the numeric characters 0–9. 

Because formulas are also considered values (you learn about simple calculations in 

Lesson 3), other valid value characters include symbols such as +, –, /, and *. You can 

also use characters such as a comma (,), a percent sign (%), or a dollar sign ($) in your 

values. You will find, however, that you can save yourself a few data-entry keystrokes 

and add these characters using different Excel formatting options (you learn about Excel 

formatting in Lesson 9, "Changing How Numbers and Text Look"). 

For example, you could enter the dollar amount $700.00 including the dollar sign and the 

decimal point. However, it's probably faster to enter the 700 into the cell and then format 

all the cells that contain dollar amounts after you have entered all the data. 

To enter a value, follow these steps: 

1. Click in the cell where you want to enter the value. 

2. Type the value. To enter a negative number, precede it with a minus sign or 

surround it with parentheses. 

3. Press Enter or the Tab key; the value appears in the cell right-aligned. Figure 2.4 

shows various values entered into a simple worksheet 

4. Figure 2.4. Values are right-aligned in a cell. 
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Entering Dates and Times 

Dates that you enter into an Excel workbook have numerical significance. Excel converts 

the date into a number that reflects the number of days that have elapsed since January 1, 

1900. Even though you won't see this number (Excel displays your entry as a normal 

date), the number is used whenever you use this date in a calculation. Times are also 

considered values. Excel sees them as the number of seconds that have passed since 12 

a.m. 

Follow these steps to enter a date or time: 

1. Click in the cell where you want to enter a date or a time. 

2. To enter a date, use the format MM/DD/YY or the format MM-DD-YY, as in 

5/9/03 or 5-9-03. 

To enter a time, be sure to specify a.m. or p.m., as in 7:21 p or 8:22 a. 

Copying Data to Other Cells 

Another way to enter labels or values onto a sheet is to use the Fill feature. You can copy 

(fill) an entry into surrounding cells. For example, suppose you have a list of salespeople 

on a worksheet, and they will each get a $100 bonus. You can enter the 100 once and 

then use the Fill feature to insert multiple copies of 100 into nearby cells. To use the Fill 

feature for copying, follow these steps: 

1. Click the fill handle of the cell (the small block in the lower-right corner of the 

cell) that holds the data that you want to copy (see Figure 2.5). 

Figure 2.5. Drag the fill handle to copy the contents of a cell into 

neighboring cells. 
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1. Drag the fill handle down or to the right to copy the data to adjacent cells. A data 

tag appears to let you know exactly what data is being copied into the cells. 

2. Release the mouse button. The data is "filled" into the selected cells. 

When you release the mouse, a shortcut box for Fill options appears at the end of the cells 

that you filled. Copy Cells is the default option for the Fill feature, so you can ignore the 

shortcut box for the moment. It does come into play when you enter a series in the next 

section. 

 

Entering a Series of Numbers, Dates, and Other Data 

Entering a value series (such as January, February, and March or 1, 2, 3, 4, and so on) is 

accomplished using the Fill feature discussed in the preceding section. When you use the 

Fill feature, Excel looks at the cell holding the data and tries to determine whether you 

want to just copy that information into the adjacent cells or use it as the starting point for 

a particular series of data. For example, with Monday entered in the first cell of the 

series, Excel automatically inserts Tuesday, Wednesday, and so on into the adjacent cells 

when you use the Fill feature. 

Sometimes Excel isn't quite sure whether you want to copy the data when you use Fill or 

create a series. This is where the Fill options shortcut box comes in. It enables you to 



select how the Fill feature should treat the data that you have "filled" into the adjacent 

cells. Figure 2.6 shows the creation of a data series using Fill. 

 

Figure 2.6. Fill can also be used to create a series of data in adjacent cells. 

 

 

When you create a series using Fill, the series progresses by one increment. For example, 

a series starting with 1 would proceed to 2, 3, 4, and so on. If you want to create a series 

that uses some increment other than 1, you must create a custom series. 

Entering a Custom Series 

If you want to create a series such as 10, 20, 30, where the series uses a custom increment 

between the values, you need to create a custom series. Excel provides two ways to create 

a custom series. To create a custom series using Fill, follow these steps: 

1. Enter the first value in the series into a cell. 

2. Enter the second value in the series into the next cell. For example, you might 

enter 10 into the first cell and then 20 into the second cell. This lets Excel know 

that the increment for the series is 10. 

3. Select both cells by clicking the first cell and dragging over the second cell. 
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4. Drag the fill handle of the second cell to the other cells that will be part of the 

series. Excel analyzes the two cells, sees the incremental pattern, and re-creates it 

in subsequent cells. 

You can also create a custom series using the Series dialog box. This enables you to 

specify the increment or step value for the series and even specify a stop value for the 

series. 

1. Enter the first value in the series into a cell. 

2. Select the cells that you want included in the series. 

3. Select the Edit menu, point at Fill, and then select Series. The Series dialog box 

opens  

4. Figure 2.7. The Series dialog box enables you to create a custom series. 

 

1. Enter the Step Value for the series. You can also enter a Stop Value for the series 

if you did not select the cells used for the series in step 2. For example, if you 

want to add a series to a column of cells and have clicked in the first cell that will 

receive a value, using a Stop Value (such as 100 for a series that will go from 1 to 

100) will "stop" entering values in the cells when it reaches 100—the Stop Value. 

2. Click OK to create the series. 

Taking Advantage of AutoComplete 

Another useful feature that Excel provides to help take some of the drudgery out of 

entering information into a workbook is the AutoComplete feature. Excel keeps a list of 

all the labels that you enter on a worksheet by column. For example, suppose you have a 

worksheet tracking sales in Europe and you are entering country names, such as 

Germany, Italy, and so on, multiple times into a particular column in the worksheet. After 

you enter Germany the first time, it becomes part of the AutoComplete list for that 

column. The next time you enter the letter G into a cell in that column, Excel completes 

the entry as "Germany." 



You can also select an entry from the AutoComplete list. This allows you to see the entire 

list of available entries. Follow these steps: 

1. Enter your text and value data as needed onto the worksheet. 

2. If you want to select a text entry from the AutoComplete list, to fill an empty cell, 

right-click that cell. A shortcut menu appears. 

3. Select Pick from List from the shortcut menu. A list of text entries (in alphabetical 

order) appears below the current cell. 

4. Click a word in the list to insert it into the current, empty cell. 

 

 

Performing Simple Calculations— 

Understanding Excel Formulas 

One way to add calculations to an Excel workbook is to create your own formulas. 

Formulas are typically used to perform calculations such as addition, subtraction, 

multiplication, and division. More complex calculations are better left to Excel functions, 

which is a built-in set of formulas that provide financial, mathematical, and statistical 

calculations. You learn more about functions in Lesson 5, "Performing Calculations with 

Functions." 

Formulas that you create typically include cell addresses that reference cells on which 

you want to perform a calculation. Formulas also consist of mathematical operators, such 

as + (addition) or * (multiplication). For example, if you wanted to multiply two cells, 

such as C3 and D3, and then divide the product by 3, you would design a formula that 

looks like this: 

=(C3*D3)/3 

Notice that the formula begins with the equal sign (=). This lets Excel know that the 

information that you are placing in the cell is meant to do a calculation. The parentheses 

are used to let Excel know that you want C3 multiplied by D3 before the result is divided 

by 3. Creating appropriate formulas requires an understanding of the order of 

mathematical operations, or what is often called the rules of precedence. The natural 

order of math operations is covered in the next section. 

Formula Operators 

As previously mentioned, you can create formulas that add, subtract, and multiply cells in 

the worksheet. Table 3.1 lists some of the operators that you can use and how you would 

use them in a simple formula 
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Table 3.1. Excel's Mathematical Operators 

Operator Performs Sample 

Formula 

Result 

^ Exponentiation =A1^3 Enters the result of raising the value in cell 

A1 to the third power 

+ Addition =A1+A2 Enters the total of the values in cells A1 and 

A2 

– Subtraction =A1–A2 Subtracts the value in cell A2 from the value 

in cell A1 

* Multiplication =A2*A3 Multiplies the value in cell A2 by cell A3 

/ Division =A1/B1 Divides the value in cell A1 by the value in 

cell B1 

shows some formulas that have been created for an Excel worksheet. So that you can see 

how I wrote the formulas, I've configured Excel so that it shows the formula that has been 

placed in a cell rather than the results of the formula (which is what you would normally 

see). 

Figure 3.1. You can create formulas to do simple calculations in your 

worksheets. 



 

Order of Operations 

The order of operations, or operator precedence, simply means that some operations take 

precedence over other operations in a formula. For example, in the formula =C2+D2*E2, 

the multiplication of D2 times E2 takes precedence, so D2 is multiplied by E2 and then 

the value in cell C2 is added to the result. 

You can force the precedence of an operation by using parentheses. For example, if you 

want C2 and D2 added before they are multiplied by E2, the formula would have to be 

written =(C2+D2)*E2. 

The natural order of math operators follows: 

1. Exponent (^) and calculations within parentheses 

2. Multiplication (*) and division (/) 

3. Addition (+) and subtraction (–) 

In the case of operations such as multiplication and division, which operate at the same 

level in the natural order, a formula containing the multiplication operator followed by 

the division operator will execute these operators in the order they appear in the formula 

from left to right. If you don't take this order into consideration, you could run into 

problems when entering your formulas. For example, if you want to determine the 

average of the values in cells A1, B1, and C1, and you enter =A1+B1+C1/3, you'll get the 

wrong answer. The value in C1 will be divided by 3, and that result will be added to 



A1+B1. To determine the total of A1 through C1 first, you must enclose that group of 

values in parentheses: =(A1+B1+C1)/3. 

 

Entering Formulas 

You can enter formulas in one of two ways: by typing the entire formula, including the 

cell addresses, or by typing the formula operators and selecting the cell references. Take a 

look at both ways. 

To type a formula, perform the following steps: 

1. Select the cell where you will place the formula. 

2. Type an equal sign (=) into the cell to begin the formula. 

3. Enter the appropriate cell references and operators for the formula. Figure 3.2 

shows a simple multiplication formula. The formula also appears in the Formula 

bar as you type it. The cells that you specify in the formula are highlighted with a 

colored border. 

Figure 3.2. The formula appears in the cell and in the Formula bar as 

you type it. 

 

1. Press Enter when you have finished the formula, and Excel calculates the result. 

To enter a formula by selecting cell addresses, follow these steps: 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch60lev1sec2.html#ch60fig02#ch60fig02


1. Click in the cell where you will place the formula. 

2. Type the equal sign (=) to begin the formula. 

3. Click the cell whose address you want to appear first in the formula. You can also 

click a cell in a different worksheet or workbook. The cell address appears in the 

cell and in the Formula bar. 

4. Type a mathematical operator after the value to indicate the next operation you 

want to perform. The operator appears in the cell and in the Formula bar. 

5. Continue clicking cells and typing operators until the formula is complete. 

6. Press Enter to accept the formula and have Excel place its results into the cell. 

Using the Status Bar AutoCalculate Feature 

Using a feature that Excel calls, you can view the sum of a column of cells simply by 

selecting the cells and looking at the status bar. The values in the selected cells are added. 

You can also right-click the AutoCalculate area of the status bar and choose different 

formulas, such as average, minimum, maximum, and count. 

This feature is useful if you want to quickly check the total for a group of cells or 

compute the average. It also allows you to "try out" an Excel function (discussed in 

Lesson 5) before actually entering it into a cell. You can also view the average, 

minimum, maximum, and count of a range of cells. To display something other than the 

sum, highlight the group of cells you want the operation performed on, right-click the 

status bar, and select the option you want from the shortcut menu that appears (see Figure 

3.3). 

Figure 3.3. You can view the results of different built-in formulas in the status 

bar. 
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Displaying Formulas 

Normally, Excel does not display the formula in a cell. Instead, it displays the result of 

the calculation. You can view the formula by selecting the cell and looking in the 

Formula bar. However, if you're trying to review all the formulas in a large worksheet, it 

would be easier if you could see them all at once (and even print them). If you want to 

view formulas in a worksheet, follow these steps: 

1. Open the Tools menu and choose Options. 

2. Click the View tab. 

3. In the Window options area of the View tab (near the bottom of the tab), click to 

select the Formulas check box. 

4. Click OK. 

Editing Formulas 

Editing a formula is the same as editing any entry in Excel. The following steps show 

how you do it: 

1. Select the cell that contains the formula you want to edit. 

2. Click in the Formula bar to place the insertion point in the formula, or press F2 to 

enter Edit mode (the insertion point is placed at the end of the entry in that cell). 

3. Press the left-arrow key or the right-arrow key to move the insertion point within 

the formula. Then, use the Backspace key to delete characters to the left, or use 

the Delete key to delete characters to the right. Type any additional characters. 

4. When you finish editing the data, click the Enter button on the Formula bar or 

press Enter to accept your changes 

 

Manipulating Formulas and Understanding Cell References— 

Copying Formulas 

Copying labels and values in Excel is no big deal. You can use the Copy and Paste 

commands (discussed in Lesson 8, "Editing Worksheets") or you can use some of the Fill 

features discussed in Lesson 2, "Entering Data into the Worksheet." Copying or moving 

formulas, however, is a little trickier. 

Suppose that you create the formula =D8*E8 and place it into cell F8, as shown in Figure 

4.1. You have designed the formula to reference cells D8 and E8. However, Excel looks 

at these cell references a little differently. Excel sees cell D8 as the entry that is located 

two cells to the left of F8 (where the formula has been placed, in this example). It sees 

cell E8 as being the location that is one cell to the left of F8. 

Figure 4.1. Formulas you place in Excel use relative referencing for calculations. 
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Excel's method of referencing cells is called relative referencing. The great thing about 

this method of referencing cells is that when you copy a formula to a new location, it 

adjusts to the relative cell references around it and provides you with the correct 

calculation. 

For example, you could copy the formula in cell F8 to cell F9, and Excel would use 

relative referencing to change the cell addresses in the formula. The original formula 

=D8*E8 would appear as D9*E9 when copied to cell F9. 

Relative referencing is very useful in most situations where you copy a formula to several 

cells in the same column. However, it can get you into trouble when you cut and paste a 

formula to a new location or copy the formula to a location where it can no longer 

reference the appropriate cells to provide you with the correct calculation. 

In these situations, you must use absolute referencing so that the formula references only 

specified cells and does not change the cell references in the formula when pasted to the 

new location. Absolute referencing is discussed in the next section. 

You can copy formulas using the Copy and Paste commands (see Lesson 8); however, 

when you need to copy a formula to multiple locations, you can also use the Fill feature 

discussed in Lesson 2. 

Because Excel uses relative referencing by default, the formula adjusts to each of its new 

locations. An alternative way to "copy" a formula to multiple adjacent cells is to select all 
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cells that will contain the formula before you actually write the formula in the first cell. 

Follow these steps: 

1. Select all the cells that will contain the formula (dragging so that the cell that you 

will write the formula in is the first of the selected group of cells). 

2. Enter the formula into the first cell. 

3. Press Ctrl+Enter and the formula is placed in all the selected cells. 

Using Relative and Absolute Cell Addresses 

As mentioned at the beginning of this lesson, when you copy a formula from one place in 

the worksheet to another, Excel adjusts the cell references in the formulas relative to their 

new positions in the worksheet. There might be occasions when you don't want Excel to 

change the reference related to a particular cell that appears in a formula (or in an Excel 

function, which is discussed in Lesson 5, "Performing Calculations with Functions"). 

Absolute Versus Relative An absolute reference is a cell reference in a formula 

that does not change when copied to a new location; you designate it as 

absolute. A relative reference is a cell reference in a formula that is adjusted 

when the formula is copied. 

 

For example, suppose you have a worksheet that computes the commission made on sales 

by each of your salespeople. Sales have been so good that you've decided to give each 

person on the sales team a $200 bonus. Figure 4.2 shows the worksheet that you've 

created. 

Figure 4.2. Some formulas require absolute references 
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Notice that the bonus amount is contained in only one cell on the worksheet (cell E15). 

Therefore, when you create the formula used in F6 and then copied to cells F7 through 

F11, you need to make sure that the bonus amount in cell E15 is always referenced by the 

formula. This is a case where you must "absolutely" reference the bonus amount in cell 

E15. 

To make a cell reference in a formula absolute, add a $ (dollar sign) before the column 

letter and before the row number that make up the cell address. For example, in Figure 

4.2, the formula in F6 must read as follows: 

=E6+$E$15 

The address, $E$15, refers to cell E15, meaning that cell E15 is absolutely referenced by 

the formula. This cell reference remains "locked" even when you copy the formula to the 

other cells in the E column. 

To create an absolute reference in a formula (or a function, which is discussed in Lesson 

5), create your formula as you normally would (as detailed in Lesson 3, "Performing 

Simple Calculations"). After typing or pointing out a cell address in a formula that needs 

to be an absolute reference, press F4. A dollar sign ($) is placed before the cell and row 

designation for that cell. Once data is labeled as absolute, you will find that if you move 

the data to a different cell (or cells), the formula will update itself to reference the new 

location. 

Some formulas might contain cell addresses where you will make the column designation 

absolute, but not the row (or vice versa). For example, you could have a formula $A6/2. 
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You are telling Excel that the values will always be contained in column A (it is 

absolute), but the row reference (6) can change when the formula is copied. Having a cell 

address in a formula that contains an absolute designation and a relative reference is 

called a mixed reference. 

Mixed References A reference that is only partially absolute, such as A$2 or 

$A2. When a formula that uses a mixed reference is copied to another cell, only 

part of the cell reference (the relative part) is adjusted. 

 

Absolute referencing and mixed references are also required by some of Excel's built-in 

functions 

 

Performing Calculations with Functions— 

What Are Functions? 

You already learned in Lesson 3, "Performing Simple Calculations," how to create your 

own formulas in Excel. When you work with more complex calculations, you are better 

off using Excel's built-in formulas—functions. 

Functions are ready-made formulas that perform a series of operations on a specified 

range of values. For example, to determine the sum of a series of numbers in cells A1 

through H1, you can enter the function =SUM(A1:H1). Excel functions can do all kinds 

of calculations for all kinds of purposes, including financial and statistical calculations. 

Every function consists of the following three elements: 

• The = sign, which indicates that what follows is a function (formula). 

• The function name, such as SUM, that indicates which operation will be 

performed. 

• A list of cell addresses, such as (A1:H1), which are to be acted upon by the 

function. Some functions can include more than one set of cell addresses, which 

are separated by commas (such as A1,B1,H1). 

You can enter functions into the worksheet by typing the function and cell references (as 

you did with your own formulas), or you can use the Insert Function feature, which walks 

you through the process of creating a function in a worksheet (you will work with the 

Insert Function feature in a moment). Table 5.1 lists some of the Excel functions that you 

will probably use most often in your worksheets 
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Commonly Used Excel Functions 

Function Example Description 

AVERAGE =AVERAGE(B4:B9) Calculates the mean or average of a 

group of cell values. 

COUNT =COUNT(A3:A7) Counts the number of cells that hold 

values in the selected range or group of 

cells. This can also be used to tell you 

how many cells are in a particular 

column, which tells you how many rows 

are in your spreadsheet. 

IF =IF(A3>=1000,"BONUS","NO 

BONUS") 

Allows you to place a conditional 

function in a cell. In this example, if A3 

is greater than or equal to 1000, the true 

value, BONUS, is used. If A3 is less than 

1000, the false value, NO BONUS, is 

placed in the cell. 

MAX =MAX(B4:B10) Returns the maximum value in a range of 

cells. 

MIN =MIN(B4:B10) Returns the minimum value in a range of 

cells. 

PMT =PMT(.0825/12,360,180000) Calculates the monthly payment on a 30-

year loan (360 monthly payments) at 

8.25% a year (.0825/12 a month) for 

$180,000. 

SUM =SUM(A1:A10) Calculates the total in a range of cells. 

 

Excel provides a large number of functions listed by category. There are Financial 

functions, Date and Time functions, Statistical functions, and Logical functions (such as 

the IF function described in Table 5.1). The group of functions that you use most often 

depends on the type of worksheets you typically build. For example, if you do a lot of 

accounting work, you will find that the Financial functions offer functions for computing 

monthly payments, figuring out the growth on an investment, and even computing the 

depreciation on capital equipment. 

Although some commonly used functions have been defined in Table 5.1, as you become 

more adept at using Excel you might want to explore some of the other functions 

available. Select Help, Microsoft Excel Help. On the Contents tab of the Help window, 

open the Function Reference topic. Several subtopics related to Excel functions and their 

uses are provided. 
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Using AutoSum 

Adding a group of cells is probably one of the most often-used calculations in an Excel 

worksheet. Because of this fact, Excel makes it very easy for you to place the SUM 

function into a cell. Excel provides the AutoSum button on the Standard toolbar. 

AutoSum looks at a column or row of cell values and tries to select the cells that should 

be included in the SUM function. 

To use AutoSum, follow these steps: 

1. Select the cell where you want to place the SUM function. Typically, you will 

choose a cell that is at the bottom of a column of values or at the end of a row of 

data. This makes it easy for AutoSum to figure out the range of cells that it should 

include in the SUM function. 

2. Click the AutoSum button on the Standard toolbar. AutoSum inserts =SUM 

and the cell addresses that it thinks should be included in the function 

 

AutoSum inserts the SUM function and selects the cells that will be totaled by the 

function. 

 

 
 

1. If the range of cell addresses that AutoSum selected is incorrect, use the mouse to 

drag and select the appropriate group of cells. 



2. Press the Enter key. AutoSum calculates the total for the selected range of cells. 

Using the Insert Function Feature 

After you become familiar with a function or a group of functions, you place a particular 

function in an Excel worksheet by typing the function name and the cells to be referenced 

by the function (the same as you have done for formulas that you create as outlined in 

Lesson 3). However, when you are first starting out with functions, you will find it much 

easier to create them using the Insert Function feature. The Insert Function feature leads 

you through the process of inserting a function and specifying the appropriate cell 

addresses in the function. 

For example, suppose you want to compute the average, maximum, and minimum of a 

group of cells that contain the weekly commissions for your sales force. Figure 5.2 shows 

how these three functions would look on a worksheet (the display has been changed in 

Excel to show you the functions rather than their results). You could use the Insert 

Function feature to create any or all of these functions. 

Figure 5.2. Functions such as Average, MIN, and MAX can be placed into a 

worksheet using the Insert Function feature. 
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To use the Insert Function feature, follow these steps: 

1. Click in the cell where you want to place the function. 

2. Click the arrow button next to the AutoSum button and select More Functions. 

The Insert Function dialog box appears (see Figure 5.3). 

Figure 5.3. The Insert Function dialog box helps you select the function 

you want to use 

 
 

1. To search for a particular function, type a brief description of what you want to do 

in the Search for a Function box (for example, you could type monthly payment 

and Excel would show you financial functions that help you calculate monthly 

payments), and then click Go to conduct the search. You also can select a function 

category, such as Financial or Statistical, using the Select a Category drop-down 

box. In either case, a list of functions is provided in the Select a Function dialog 

box. 

2. From the Functions list, select the function you want to insert. Then click OK. 

The Function Arguments dialog box appears. This dialog box allows you to 

specify the range of cells (some functions require multiple ranges of cells) that the 

function acts upon (see Figure 5.4). 

Figure 5.4. The Function Arguments dialog box is where you specify the 

cells that will be acted upon by the function 
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1. Next, you must enter the range of cells that will be acted upon by the function. 

Click the Collapse button on the far right of the Number1 text box in the Function 

Arguments dialog box. This returns you to the worksheet. 

2. Use the mouse to select the cells that you want to place in the function (see Figure 

5.5). Then click the Expand button on the right of the Function Arguments dialog 

box. 

Figure 5.5. The Function Arguments dialog box collapses and allows you 

to select the cells that will be acted upon by the function. 
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1. Click OK. Excel inserts the function and cell addresses for the function into the 

selected cell and displays the result. 

If you find that you would like to edit the list of cells acted upon by a particular function, 

select the cell that holds the function and click the Insert Function button on the Formula 

bar. The Function Arguments dialog box for the function appears. Select a new range of 

cells for the function, as discussed in steps 4 and 5. 

Excel 2003 also makes it easy for you to bypass the Insert Function dialog box and insert 

commonly used functions such as Average, Count, Max, and Min. Click the arrow to the 

right of the AutoSum button on the Excel Standard toolbar and select a function from the 

list provided. To complete the function select the range of cells that you want the function 

to act on, and then press the Enter key. 

 

 

Moving from Worksheet to Worksheet 

Now that you've taken a look at how to enter labels, values, formulas, and functions, you 

should take a look at how to navigate the space provided by Excel workbooks and 

worksheets. By default, each workbook starts off with three worksheets. You can add or 

delete worksheets from the workbook as needed. Because each workbook consists of one 

or more worksheets, you need a way of moving easily from worksheet to worksheet. Use 

one of the following methods: 

• Click the tab of the worksheet you want to go to (see Figure 6.1). If the tab is not 

shown, use the tab scroll buttons to bring the tab into view, and then click the tab. 

 

• Figure 6.1. Use the tabs to move from worksheet to worksheet. 
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• Press Ctrl+PgDn to move to the next worksheet or Ctrl+PgUp to move to the 

previous one. 

Switching Between Workbooks 

Switching between the different workbooks that you have opened on the Windows 

desktop is very straightforward. By default, each workbook has its own button on the 

Windows taskbar and opens in its own Excel application window. To switch between 

workbooks, click the button for the workbook you want. 

If you don't want to have a separate taskbar entry for each open Excel workbook, you can 

turn this feature off using the Windows in Taskbar option on the View tab of the Options 

dialog box (click Tools, Options). Keep in mind, however, that disabling this feature 

means that you will have to use the Window menu to switch between Excel workbooks. 

To do so, select the Window menu, and then select the name of the workbook you want 

to make the current workbook in the Excel application window. 

 



Moving Within a Worksheet 

To enter your worksheet data, you need some way of moving to the various cells within 

the worksheet. Keep in mind that the part of the worksheet displayed onscreen is only a 

small piece of the actual worksheet. 

Using the Keyboard 

To move around the worksheet with your keyboard, use the key combinations listed  

                Moving Around a Worksheet with the Keyboard 

 

To Move Press This 

Up one cell Up-arrow key 

Down one cell Down-arrow key 

Right one cell Right-arrow key 

Left one cell Left-arrow key 

Up one screen Page Up 

Down one screen Page Down 

Leftmost cell in a row (column A) Home 

Lower-right corner of the data area Ctrl+End 

Cell A1 Ctrl+Home 

Last occupied cell to the right of a row End+right-arrow key 

 

Changing the Worksheet View 

Excel provides many ways to change how your worksheet appears within the Excel 

window. Changing the view has no effect on how your worksheets look when printed 

(unless you choose to hide data onscreen, a topic covered later in this lesson). However, 

changing the view and getting a different perspective helps you to see the overall layout 

of the worksheet and allows you to view worksheet cells that might not appear in the 

default screen view. For example, you can enlarge or reduce the size of the worksheet so 

that you can view more or less of it at one time. 

To enlarge or reduce your view of the current worksheet, use the Zoom feature. Simply 

click the Zoom button on the Standard toolbar and select the zoom percentage you want 

to use from the following: 25%, 50%, 75%, 100%, or 200%. If you want to zoom by a 

number that's not listed, just type the number into the Zoom box and press Enter. 



You can also have Excel zoom in on a particular portion of a worksheet. This is 

particularly useful when you have created very large worksheets. Select the area of the 

worksheet you want to zoom in on, and then click the Zoom button list and click 

Selection. You can then select different zoom values on the Zoom list to zoom in or out 

on that particular portion of the worksheet. Keep in mind that Excel zooms in on the 

entire worksheet, not just the selected cells. (It just makes sure that you can see the 

selected cells when you change the zoom values.) 

Fast Zoom with a Wheel Mouse If you use the Microsoft IntelliMouse or 

another compatible wheel mouse, you can zoom in and out quickly by holding 

down the Ctrl key as you move the wheel forward or back. 

 

You also can display your worksheet so that it takes up the full screen. This eliminates all 

the other items in the Excel window, such as the toolbars, the Formula bar, the status bar, 

and so on. Figure 7.1 shows a worksheet in the Full Screen view. To use this view, select 

the View menu and select Full Screen. To return to Normal view, click Close Full Screen. 

Figure 7.1. View your worksheet on the entire screen. 

 

Freezing Column and Row Labels 

When you work with very large worksheets, it can be very annoying as you scroll to the 

right or down through the worksheet when you can no longer see your row headings or 

column headings, respectively. For example, you might be entering customer data where 

the customer's name is in the first column of the worksheet, and when you scroll to the 

extreme right to enter data, you can no longer see the customer names. 

You can freeze your column and row labels so that you can view them no matter how far 

you scroll down or to the right in your worksheet. For example, Figure 7.2 shows frozen 

column labels (columns A and B, which include the first names and last names) that 

allow you to see the customer names no matter how far you move to the right of the 

worksheet. 

Figure 7.2. You can freeze row and column headings so that they remain 

onscreen as you scroll. 
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To freeze row or column headings (or both), follow these steps: 

1. Click the cell to the right of the row labels and/or below any column labels you 

want to freeze. This highlights the cell. 

2. Select the Window menu, and then select Freeze Panes. 

You might want to experiment on a large worksheet. Freeze the column and row 

headings, and then use the keyboard or the mouse to move around in the worksheet. As 

you do, the row and/or column headings remain locked in their positions. This enables 

you to view data in other parts of the worksheet without losing track of what that data 

represents. 

When you have finished working with the frozen column and row headings, you can 

easily unfreeze them. Select the Window menu again and select Unfreeze Panes. 

Splitting Worksheets 

When you work with very large worksheets, you might actually want to split the 

worksheet into multiple windows. This enables you to view the same worksheet in 

different windows. You can then scroll through the multiple copies of the same 

worksheet and compare data in cells that are normally far apart in the worksheet. 

Figure 7.3 shows a worksheet that has been split into multiple panes. Each "copy" of the 

worksheet will have its own set of vertical and horizontal scrollbars. 
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Figure 7.3. You can split a worksheet into two windows, making it easy to 

compare data in the worksheet. 

 
 

To split a worksheet, follow these steps: 

1. Click in the cell where you want to create the split. A split appears to the left of 

the selected cell and above the selected cell. 

2. You can adjust the vertical or horizontal split bars using the mouse. Place the 

mouse on the split bar and drag it to a new location. 

3. You can use the scrollbars in the different split panes to view data in the 

worksheet (different data can be viewed in each pane). 

To remove the split, select the Window menu and select Remove Split. 

Hiding Workbooks, Worksheets, Columns, and Rows 

For those times when you're working on top-secret information (or at least information 

that is somewhat proprietary, such as employee salaries), you can hide workbooks, 

worksheets, columns, or rows from prying eyes. For example, if you have confidential 

data stored in one particular worksheet, you can hide that worksheet, yet still be able to 

view the other worksheets in that workbook. You can also hide particular columns or 

rows within a worksheet. 

Use these methods to hide data: 

• To hide a row or a column in a worksheet, click a row or column heading to select 

it (you can select adjacent columns or rows by dragging across them). Then, right-

click within the row or column and select Hide from the shortcut menu that 



appears. The row or column will be hidden (see Figure 7.4). To unhide the row or 

column, right-click the border between the hidden item and rows or columns that 

are visible, and then select Unhide from the shortcut menu. 

Locking Cells in a Worksheet 

In some situations, you might create a worksheet or worksheets and someone else will 

enter the data. In these situations, you might want to lock cells that contain formulas and 

functions so that the person doing the data entry does not accidentally overwrite or delete 

the worksheet formulas or functions. Locking cells in a worksheet is a two-step process. 

You must first select and lock the cells. Then, you must turn on protection on the entire 

worksheet for the "lock" to go into effect. 

Follow these steps to lock cells on a worksheet: 

1. Select the cells in the worksheet that you want to lock. These are typically the 

cells that contain formulas or functions. 

2. Select Format and then Cells. The Format Cells dialog box appears. Click the 

Protection tab on the dialog box (see Figure 7.5). 

Figure 7.5. Cells can be locked using the Protection tab of the Format 

Cells dialog box. 
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1. Be sure the Locked check box is selected on the Protection tab. Then click OK. 

2. Now you must protect the entire worksheet to have the lock feature protect the 

cells that you selected. Select the Tools menu, point at Protections, and then select 

Protect Sheet. The Protect Sheet dialog box appears (see Figure 7.6). 

Figure 7.6. The worksheet must be protected if you want to lock cells 

containing formulas or functions 

enter a password if you want to require a password for "unprotecting" the worksheet. 

Then click OK. 

 

Correcting Data 

You've taken a look at entering text, values, formulas, and functions. There will definitely 

be occasions when you need to edit information in a cell. One way to change an entry in a 

cell is to replace it by selecting the cell and then entering new data. Just press Enter after 

entering the information. If you just want to modify the existing cell content, you can also 

edit data within a cell. 

To edit information in a cell, follow these steps: 

1. Select the cell in which you want to edit data. 

2. To begin editing, click in the Formula bar to place the insertion point into the cell 

entry. To edit within the cell itself, press F2 or double-click the cell. This puts you 

in Edit mode; the word Edit appears in the status bar. 

3. Press the right- or left-arrow key to move the insertion point within the entry. 

Press the Backspace key to delete characters to the left of the insertion point; 

press the Delete key to delete characters to the right. Then, type any characters 

you want to add. 

4. Press the Enter key when you have finished making your changes. 

5. If you change your mind and you no longer want to edit your entry, click the 

Cancel button on the Formula bar or press Esc. 

Undoing an Action 

Although editing a worksheet is supposed to improve it, you might find that you've done 

something to a cell or range of cells that you had not intended. This is where the Undo 

feature comes in. 

You can undo just about any action while working in Excel, including any changes 

you make to a cell's data. To undo a change, click the Undo button on the Standard 

toolbar (or select Edit, Undo). 

You can also undo an undo. Just click the Redo button on the Standard toolbar. 
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Using the Replace Feature 

Suppose you've entered a particular label or value into the worksheet and find that you 

have consistently entered it incorrectly. A great way to change multiple occurrences of a 

label or value is using Excel's Replace feature; you can locate data in the worksheet and 

replace it with new data. To find and replace data, follow these steps: 

1. Select the Edit menu, and then select Replace. The Find and Replace dialog box 

appears, as shown in Figure 8.1. 

Figure 8.1. Find and replace data with the Find and Replace dialog box. 

 
 

1. Type the text or value that you want to find into the Find What text box. 

2. Click in the Replace With text box and type the text you want to use as 

replacement text. 

3. To expand the options available to you in the dialog box, click the Options button 

(Figure 8.1 shows the dialog box in its expanded form). 

4. If you want to match the exact case of your entry so that Excel factors in 

capitalization, click the Match Case check box. If you want to locate cells that 

contain exactly what you entered into the Find What text box (and no additional 

data), click the Match Entire Cell Contents check box. 

5. To search for entries with particular formatting, click the Format button on the 

right of the Find What box. The Find Format dialog box appears (see Figure 8.2). 

You can search for entries that have been assigned number, alignment, font, 

border, patterns, or protection using the appropriate tab on the Find Format dialog 

box. After making your selection, click the OK button. 

Figure 8.2. The Find Format dialog box enables you to search for entries 

that have been assigned a particular formatting 
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1. You can also replace your entries with a particular formatting. Click the Format 

button on the right of the Replace With box. The Replace Format dialog box 

appears. It is the same as the Find Format dialog box. Simply select any formats 

you want to assign to your replacement, and then click OK. 

2. Click Find Next to find the first occurrence of your specified entry. 

3. When an occurrence is found, it is highlighted. Click Replace to replace only this 

occurrence and then click Find Next to find the next occurrence. 

4. If you want to find all the occurrences, click Find All; you can also replace all the 

occurrences of the entry with Replace All. 

5. When you have finished working with the Find and Replace dialog boxclick 

Close. 

Checking Your Spelling 

Because worksheets also include text entries, you might want to make sure that you 

check for any misspellings in a worksheet before printing the data. Excel offers a spell-

checking feature that finds and corrects misspellings in a worksheet. 

To run the Spelling Checker, follow these steps: 

1. Click the Spelling button on the Standard toolbar (or select Tools, Spelling). 

The Spelling dialog box appears. Excel finds the first misspelled word and 



displays it at the top of the Spelling dialog box. A suggested correction appears in 

the Suggestions box . 

 

1. To accept the suggestion in the Suggestions box, click Change, or click Change 

All to change all occurrences of the misspelled word. 

2. If the suggestion in the Suggestions box is not correct, you can do any of the 

following: 

o Select a different suggestion from the Suggestions box, and then click 

Change or Change All. 

o Type your own correction into the Change To box, and then click Change 

or Change All. 

o Click Ignore Once to leave the word unchanged. 

o Click Ignore All to leave all occurrences of the word unchanged. 

o Click Add to Dictionary to add the word to the dictionary so that Excel 

won't flag it as misspelled again. 

o Click AutoCorrect to add a correctly spelled word to the AutoCorrect list 

so that Excel can correct it automatically as you type. 

o If you make a mistake related to a particular entry, click the Undo Last 

button to undo the last change that you made. 

3. You might see a message asking whether you want to continue checking spelling 

at the beginning of the sheet. If so, click Yes to continue. When the Spelling 

Checker can't find any more misspelled words, it displays a prompt telling you 

that the spelling check is complete. Click OK to confirm that the spelling check is 

finished. 

Deleting Data 

To delete the data in a cell or range of cells, select them and press Delete. Excel also 

offers some additional options for deleting cells and their contents: 

• With the Edit, Clear command, you can delete only the formatting of a cell (or an 

attached comment) without deleting its contents. The formatting of a cell includes 

the cell's color, border style, numeric format, font size, and so on. You'll learn 

more about this option in a moment. 

• With the Edit, Delete command, you can remove cells and then shift surrounding 

cells over to take their place (this option is described in more detail in Lesson 12, 

"Inserting and Removing Cells, Rows, and Columns"). 

To use the Clear command to remove the formatting of a cell or a note, follow these 

steps: 

1. Select the cells you want to clear. 

2. Open the Edit menu and point at Clear. The Clear submenu appears. 
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3. Select the desired Clear option: All (which clears the cells of all contents, 

formatting, and notes), Formats, Contents, or Comments 

Formatting Text and Numbers 

When you work in Excel, you work with two types of formatting: value formatting and 

font formatting. In value formatting, you assign a particular number style to a cell (or 

cells) that holds numeric data. You can assign a currency style, a percent style, or one of 

several other numeric styles to values. 

Another formatting option available to you in Excel relates to different font attributes. 

For example, you can add bold or italic to the contents of a cell or cells. You can also 

change the font used for a range of cells or increase the font size. 

Next, you take a look at numeric formatting, and then you look at how different font 

attributes are controlled in Excel. 

Using the Style Buttons to Format Numbers 

The Formatting toolbar (just below the Standard toolbar) contains several buttons for 

applying a format to your numbers, including the following: 

Button Name Example/Description 

 Currency Style $1,200.90 

 Percent Style 20.90% 

 Comma Style 1,200.90 

 Increase Decimal Adds one decimal place 

 Decrease Decimal Deletes one decimal place 

To use one of these buttons, select the cell or cells you want to format, and then click the 

desired button. If you would like more formatting options for numeric values, read on; 

they are covered in the next section. 

Numeric Formatting Options 

The numeric values that you place in your Excel cells are more than just numbers; they 

often represent dollar amounts, a date, or a percentage. If the various numeric style 

buttons on the Formatting toolbar (discussed in the previous section) do not offer the 

exact format you want for your numbers, don't worry. Excel's Format Cells dialog box 

offers a wide range of number formats and even allows you to create custom formats. 



To use the Format Cells dialog box to assign numeric formatting to cells in a worksheet, 

follow these steps: 

1. Select the cell or range that contains the values you want to format. 

2. Select the Format menu and select Cells. The Format Cells dialog box appears. 

3. Click the Number tab. The different categories of numeric formats are displayed 

in a Category list (see Figure 9.1). 

Figure 9.1. Apply a numeric format in the Number tab of the Format Cells dialog box. 

 

 

1. In the Category list, select the numeric format category you want to use. The 

sample box displays the default format for that category. 

2. Click OK to assign the numeric format to the selected cells. 

Table 9.1. Excel's Number Formats 

Number 

Format 

Examples Description 
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Table 9.1. Excel's Number Formats 

Number 

Format 

Examples Description 

General 10.6 

$456,908.00 

Excel displays your value as you enter it. In other words, this 

format displays currency or percent signs only if you enter 

them yourself. 

Number 3400.50 

120.39 

The default Number format has two decimal places. 

Negative numbers are preceded by a minus sign, but they 

can also appear in red and/or parentheses. 

Currency $3,400.50 

$3,400.50 

The default Currency format has two decimal places and a 

dollar sign. Negative numbers appear with a minus sign, but 

they can also appear in red and/or parentheses. 

Accounting $3,400.00 

$978.21 

Use this format to align dollar signs and decimal points in a 

column. The default Accounting format has two decimal 

places and a dollar sign. 

Date 11/7 The default Date format is the month and day separated by a 

slash; however, you can select from numerous other formats. 

Time 10:00 The default Time format is the hour and minutes separated 

by a colon; however, you can opt to display seconds, a.m., or 

p.m. 

Percentage 99.50% The default Percentage format has two decimal places. Excel 

multiplies the value in a cell by 100 and displays the result 

with a percent sign. 

Fraction 1/2 The default Fraction format is up to one digit on each side of 

the slash. Use this format to display the number of digits you 

want on each side of the slash and the fraction type (such as 

halves, quarters, eighths, and so on). 

Scientific 3.40E+03 The default Scientific format has two decimal places. Use 

this format to display numbers in scientific notation. 

Text 135RV90 Use Text format to display both text and numbers in a cell as 

text. Excel displays the entry exactly as you type it. 

Special 02110 This format is specifically designed to display ZIP codes, 

phone numbers, and Social Security numbers correctly so 

that you don't have to enter any special characters, such as 

hyphens. 

Custom 00.0% Use Custom format to create your own number format. You 

can use any of the format codes in the Type list and then 

make changes to those codes. The # symbol represents a 



Table 9.1. Excel's Number Formats 

Number 

Format 

Examples Description 

number placeholder, and 0 represents a zero placeholder. 

 

 

Copying Formats with Format Painter 

After applying a numeric format or various font attributes to a cell or cell range, you can 

easily copy those formatting options to other cells. This works whether you're copying 

numeric or text formatting or shading or borders, as you'll learn in upcoming lessons. To 

copy a format from one cell to another, follow these steps: 

1. Select the cells that contain the formatting you want to copy. 

2. Click the Format Painter button on the Standard toolbar. Excel copies the 

formatting. The mouse pointer changes into a paintbrush with a plus sign next to 

it. 

3. Click one cell or drag over several cells to which you want to apply the copied 

formatting. 

4. Release the mouse button, and Excel copies the formatting and applies it to the 

selected cells 

Using AutoFormat 

If you don't want to take the time to test different border types and shading styles, you 

can let Excel help you with the task of adding some emphasis and interest to the cells of 

your worksheet. You can take advantage of AutoFormat, which provides various 

predesigned table formats that you can apply to a worksheet. 

To use predesigned formats, perform the following steps: 

1. Select the cell(s) that contain the data you want to format. This could be the entire 

worksheet. 

2. Select the Format menu, and then select AutoFormat. The AutoFormat dialog box 

appears  

Select a format from the AutoFormat dialog box. 

 



 

 

 

1. Scroll through the list to view the various AutoFormat styles provided. When you 

find a format that you want to use, click it to select it. 

2. To prevent AutoFormat from overwriting certain existing formatting (such as 

numbers, alignment, or fonts), click the Options button and deselect the 

appropriate check boxes. 

3. Click OK and your worksheet is formatted. 

Applying Conditional Formatting 

Another useful formatting feature that Excel provides is conditional formatting. 

Conditional formatting allows you to specify that certain results in the worksheet be 

formatted so that they stand out from the other entries in the worksheet. For example, if 

you wanted to track all the monthly sales figures that are below a certain amount, you can 

use conditional formatting to format them in red. Conditional formatting formats only 

cells that meet a certain condition. 

To apply conditional formatting, follow these steps: 

1. Select the cells to which you want to apply the conditional formatting. 



2. Select the Format menu and select Conditional Formatting. The Conditional 

Formatting dialog box appears 

3. Figure 10.4. Apply formats conditionally to highlight certain values. 

 

 

1. Be sure that Cell Value Is is selected in the Condition 1 drop-down box on the left 

of the dialog box. 

2. In the next drop-down box to the right, you select the condition. The default is 

Between. Other conditions include Equal To, Greater Than, Less Than, and other 

possibilities. Use the drop-down box to select the appropriate condition. 

3. After selecting the condition, you must specify a cell or cells in the worksheet that 

Excel can use as a reference for the conditional formatting. For example, if you 

select Less Than as the condition, you must specify a cell in the worksheet that 

contains a value that can be used for comparison with the cells that you are 

applying the conditional formatting to. Click the Shrink button on the Conditional 

Formatting dialog box. You are returned to the worksheet. Select the reference 

cell for the condition. 

4. Click the Expand button on the Conditional Formatting dialog box to expand the 

dialog box. 

5. Now you can set the formatting that will be applied to cells that meet your 

condition. Click the Format button in the Conditional Formatting dialog box and 

select the formatting options for your condition in the Format Cells dialog box. 

Then click OK. Figure 10.5 shows a conditional format that applies bold and italic 

to values that are greater than the value contained in cell F8. 

Figure 10.5. Set the various options for your conditional formatting. 
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1. After setting the conditions to be met for conditional formatting (you can click 

Add to set more than one condition), click OK. 

You are returned to the worksheet. Cells that meet the condition you set up for 

conditional formatting will be formatted with the options you specified. Figure 10.6 

shows cells that the settings used in Figure 10.5 conditionally formatted. 

Figure 10.6. Conditional formatting formats only the cells that meet your 

conditions 

 

 

Inserting and Removing Cells, Rows, and Columns--- 
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Inserting Rows and Columns 

As you edit and enhance your worksheets, you might need to add rows or columns within 

the worksheet. Inserting entire rows and columns into your worksheet is very 

straightforward. Follow these steps: 

1. To insert a single row or column, select a cell to the right of where you want to 

insert a column or below where you want to insert a row. 

To insert multiple columns or rows, select the number of columns or rows you 

want to insert. To insert columns, drag over the column letters at the top of the 

worksheet. To insert rows, drag over the row numbers. For example, select three 

column letters or row numbers to insert three rows or columns. 

2. Select the Insert menu, and then select Rows or Columns. Excel inserts rows 

above your selection and columns to the left of your selection. The inserted rows 

or columns contain the same formatting as the cells (or rows and columns) you 

selected in step 1. Figure 12.1 shows a worksheet to which additional columns 

have been added. 

Columns can easily be inserted into an Excel worksheet. 

 

 

As you can see, when you insert rows or columns, the Insert Options shortcut icon 

appears to the right of the inserted columns or below inserted rows. Use the Insert 

Options menu to specify the column or row from which the new column or row should 
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copy its formatting. For example, in the case of inserted columns, you can choose to copy 

the formatting from the column to the right or left of the inserted column or columns, or 

you can choose to clear the formatting in the inserted columns. 

Removing Rows and Columns 

When you delete a row in your worksheet, the rows below the deleted row move up to fill 

the space. When you delete a column, the columns to the right shift left. 

Follow these steps to delete a row or column: 

1. Click the row number or column letter of the row or column you want to delete. 

You can select more than one row or column by dragging over the row numbers 

or column letters. 

2. Select the Edit menu and then select Delete. Excel deletes the rows or columns 

and renumbers the remaining rows and columns sequentially. All cell references 

in formulas and functions are updated appropriately 

Inserting Cells 

Although inserting rows and columns makes it easy to dramatically change the layout of 

a worksheet, on occasion you might need to insert only a cell or cells into a worksheet. 

Inserting cells causes the data in existing cells to shift down a row or over a column to 

create a space for the new cells. 

To insert a single cell or a group of cells, follow these steps: 

1. Select the area where you want the new cells inserted. Excel inserts the same 

number of cells as you select. 

2. Select the Insert menu and then select Cells. The Insert dialog box appears (see 

Figure 12.2). 

Figure 12.2. You can insert cells into a worksheet using the Insert dialog 

box. 
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1. Select Shift Cells Right or Shift Cells Down (or you can choose to have an entire 

row or column inserted). 

2. Click OK. Excel inserts the cells and shifts the adjacent cells in the direction you 

specify. 

You will find that inserting cells is useful if you have entered rows of information and 

have mismatched data, such as a customer's name with someone else's order information. 

Inserting a couple of cells enables you to quickly edit the data without having to delete 

data or insert a new row. 

Adjusting Column Width and Row Height with a Mouse 

It doesn't take very long when you are working in Excel to realize that the default column 

width of 8.43 characters doesn't accommodate long text entries or values that have been 

formatted as currency or other numeric formats. You can adjust the width of a column 

quickly using the mouse. 

You can also adjust row heights, if you want, using the mouse. However, your row 

heights will adjust to any font size changes that you make to data held in a particular row. 

Row heights also adjust if you wrap text entries within them (see Lesson 9, "Changing 

How Numbers and Text Look," for more about wrapping text). You will probably find 

that you need to adjust column widths in your worksheets far more often than row 

heights. 

To adjust a column width with the mouse, place the mouse pointer on the right border of 

the column. A sizing tool appears, as shown in Figure 12.4. Drag the column border to 

the desired width. You can also adjust the column width to automatically accommodate 

the widest entry within a column; just double-click the sizing tool. This is called AutoFit, 

and the column adjusts according to the widest entry. 

Figure 12.4. Use the column width sizing tool to adjust the width of a column 
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If you want to adjust several columns at once, select the columns. Place the mouse on any 

of the column borders and drag to increase or decrease the width. Each selected column is 

adjusted to the width you select. 

Changing row heights is similar to adjusting column widths. Place the mouse on the 

lower border of a row and drag the sizing tool to increase or decrease the row height. To 

change the height of multiple rows, select the rows and then drag the border of any of the 

selected rows to the desired height. 

Using the Format Menu for Precise Control 

If you want to precisely specify the width of a column or columns or the height of a row 

or rows, you can enter specific sizes using a dialog box. This provides you with a little 

more control than just dragging a row height or column width. 

To specify a column width, follow these steps: 

1. Select the columns you want to change. 

2. Select the Format menu, point at Column, and then select Width. The Column 

Width dialog box appears (see Figure 12.5). 

Figure 12.5. Column widths can also be specified in the Column Width 

dialog box. 
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1. Type the column width into the dialog 

box (the width is measured in number of characters). 

2. Click OK. Your column(s) width is adjusted accordingly. 

Adjusting row heights is similar to adjusting column widths. Select the row or rows, and 

then select the Format menu, point at Rows, and select Height. In the Row Height dialog 

box that appears, type in the row height and then click OK. 

Inserting Worksheets 

When you create a new workbook, it contains three worksheets. You can easily add 

additional worksheets to a workbook. 

Follow these steps to add a worksheet to a workbook: 

1. Select the worksheet that you want to be to the right of the inserted worksheet. 

For example, if you select the August sheet shown in Figure 13.1, the new sheet 

will be inserted to the left of August. 

2. Select the Insert menu. 

3. Select Worksheet. Excel inserts the new worksheet to the right of the previously 

selected worksheet. 

 

Deleting Worksheets 

If you find that you have a worksheet you no longer need, or if you plan to use only one 

worksheet of the three that Excel puts into each workbook by default, you can remove the 

unwanted worksheets. Here's how you remove a worksheet: 

1. Select the worksheet(s) you want to delete. 

2. Select the Edit menu and then select Delete Sheet. 

3. If the sheet contains data, a dialog box appears, asking you to confirm the 

deletion. Click Delete to delete the sheet. You will lose any data that the sheet 

contained. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch70lev1sec2.html#ch70fig01#ch70fig01


Moving and Copying Worksheets 

You can move or copy worksheets within a workbook or from one workbook to another. 

Copying a worksheet enables you to copy the formatting of the sheet and other items, 

such as the column labels and the row labels. Follow these steps: 

1. Select the worksheet or worksheets you want to move or copy. If you want to 

move or copy worksheets from one workbook to another, be sure the target 

workbook is open. 

2. Select the Edit menu and choose Move or Copy Sheet. The Move or Copy dialog 

box appears, as shown in Figure 13.2. 

Figure 13.2. The Move or Copy dialog box asks where you want to copy 

or move a worksheet. 

 

1. To move the worksheets to a different workbook, be sure that workbook is open, 

and then select that workbook's name from the To Book drop-down list. If you 

want to move or copy the worksheets to a new workbook, select (New Book) in 

the To Book drop-down list. Excel creates a new workbook and then copies or 

moves the worksheets to it. 

2. In the Before Sheet list box, choose the worksheet you want to follow the selected 

worksheets. 

3. To move the selected worksheet, skip to step 6. To copy the selected worksheets 

instead of moving them, select the Create a Copy option. 

4. Select OK. The selected worksheets are copied or moved as specified. 

Moving a Worksheet Within a Workbook with Drag and Drop 

A fast way to copy or move worksheets within a workbook is to use drag and drop. First, 

select the tab of the worksheet(s) you want to copy or move. 
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Move the mouse pointer over one of the selected tabs, click and hold the mouse button, 

and drag the tab where you want it moved. To copy the worksheet, hold down the Ctrl 

key while dragging. When you release the mouse button, the worksheet is copied or 

moved. 

Moving or Copying a Worksheet Between Workbooks with Drag and 

Drop 

You can also use the drag-and-drop feature to quickly copy or move worksheets between 

workbooks. 

1. Open the workbooks you want to use for the copy or move. 

2. Select Window and select Arrange. The Arrange dialog box opens. 

3. You can arrange the different workbook windows horizontally, vertically, tiled, or 

cascaded in the Excel application window. For more than two open workbooks, 

your best selection is probably the Tiled option. 

4. After making your selection, click OK to arrange the workbook windows within 

the Excel application window. Figure 13.3 shows three open workbooks that have 

been tiled. 

Figure 13.3. You can arrange multiple workbooks in the Excel window and then move or 

copy worksheets. 

 

 
 

1. Select the tab of the worksheet(s) you want to copy or move. 

2. Move the mouse pointer over one of the selected tabs, click and hold the mouse 

button, and drag the tab where you want it moved. To copy the worksheet, hold 

down the Ctrl key while dragging. 
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3. When you release the mouse button, the worksheet is copied or moved 

Changing Worksheet Tab Names 

By default, all worksheets are named SheetX, where X is a number starting with the 

number 1. So that you'll have a better idea of the information each sheet contains, you 

should change the names that appear on the tabs. Here's how to do it: 

1. Double-click the tab of the worksheet you want to rename. The current name is 

highlighted. 

2. Type a new name for the worksheet and press Enter. Excel replaces the default 

name with the name you type. 

 

 

Understanding Charting Terminology— 

 

Charts enable you to create a graphical representation of data in a worksheet. You can use 

charts to make data more understandable to people who view your printed worksheets. 

Before you start creating charts, you should familiarize yourself with the following 

terminology: 

• Data Series— The bars, pie wedges, lines, or other elements that represent plotted 

values in a chart. For example, a chart might show a set of similar bars that 

reflects a series of values for the same item. The bars in the same data series 

would all have the same pattern. If you have more than one pattern of bars, each 

pattern would represent a separate data series. For example, charting the sales for 

Territory 1 versus Territory 2 would require two data series—one for each 

territory. Often, data series correspond to rows of data in your worksheet 

(although they can correspond to columns of data if that is how you have arranged 

the information in your worksheet). 

• Categories— Categories reflect the number of elements in a series. You might 

have two data series that compare the sales of two territories and four categories 

that compare these sales over four quarters. Some charts have only one category, 

and others have several. Categories normally correspond to the columns in your 

worksheet, with the category labels coming from the column headings. 

• Axis— One side of a chart. A two-dimensional chart has an x-axis (horizontal) 

and a y-axis (vertical). The x-axis contains the data series and categories in the 

chart. If you have more than one category, the x-axis often contains labels that 

define what each category represents. The y-axis reflects the values of the bars, 

lines, or plot points. In a three-dimensional chart, the z-axis represents the vertical 

plane, and the x-axis (distance) and y-axis (width) represent the two sides on the 

floor of the chart. 



• Legend— Defines the separate series of a chart. For example, the legend for a pie 

chart shows what each piece of the pie represents. 

• Gridlines— Typically, gridlines appear along the y-axis of the chart. The y-axis is 

where your values are displayed, although they can emanate from the x-axis as 

well (the x-axis is where label information normally appears on the chart). 

Gridlines help you determine a point's exact value. 

 

Working with Different Chart Types 

With Excel, you can create many types of charts. Some common chart types are shown in 

Figure 15.1. The chart type you choose depends on the kind of data you're trying to chart 

and on how you want to present that data. The following are the major chart types and 

their purposes: 

• Pie— Use this chart type to show the relationship among parts of a whole. 

• Bar— Use this chart type to compare values at a given point in time. 

• Column— Similar to the bar chart; use this chart type to emphasize the difference 

between items. 

• Line— Use this chart type to emphasize trends and the change of values over 

time. 

• Scatter— Similar to a line chart; use this chart type to emphasize the difference 

between two sets of values. 

• Area— Similar to the line chart; use this chart type to emphasize the amount of 

change in values over time. 

Figure 15.1. Excel chart types enable you to analyze and present your data. 
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Most of these basic chart types also come in three-dimensional varieties. In addition to 

looking more professional than the standard flat charts, 3D charts can often help your 

audience distinguish between different sets of data. 

Creating and Saving a Chart 

You can place your new chart on the same worksheet that contains the chart data (an 

embedded chart) or on a separate worksheet (a chart sheet). If you create an embedded 

chart, it is typically printed side by side with your worksheet data. Embedded charts are 

useful for showing the actual data and its graphical representation side by side. If you 

create a chart on a separate worksheet, however, you can print it independently. Both 

types of charts are linked to the worksheet data that they represent, so when you change 

the data, the chart is automatically updated. 

The Chart Wizard button on the Standard toolbar enables you to quickly create a chart. 

To use the Chart Wizard, follow these steps: 

1. Select the data you want to chart. If you typed column or row labels (such as Qtr 

1, Qtr 2, and so on) that you want included in the chart, be sure you select those, 

too. 

2. Click the Chart Wizard button on the Standard toolbar. 

3. The Chart Wizard - Step 1 of 4 dialog box appears (see Figure 15.2). Select a 

Chart Type and a Chart Sub-Type (a variation on the selected chart type). Click 

Next. 
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Figure 15.2. Choose the chart type using the Chart Wizard. 

 

 

1. Next, Excel asks whether the selected range is correct. You can correct the range 

by typing a new range or by clicking the Shrink button (located at the right end of 

the Data Range text box) and selecting the range you want to use. 

2. By default, Excel assumes that your different data series are stored in rows. You 

can change this to columns if necessary by clicking the Series in Columns option. 

When you're ready for the next step, click Next. 

3. Click the various tabs to change options for your chart (see Figure 15.3). For 

example, you can delete the legend by clicking the Legend tab and deselecting 

Show Legend. You can add a chart title on the Titles tab. Add data labels (labels 

that display the actual value being represented by each bar, line, and so on) by 

clicking the Data Labels tab. When you finish making changes, click Next. 

4.  

5. Figure 15.3. Select from various chart appearance options. 
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1. Finally, Excel asks whether you want to embed the chart (as an object) in the 

current worksheet (or any other existing worksheet in the workbook) or if you 

want to create a new worksheet for it. Make your selection and click the Finish 

button. Your completed chart appears. 

 

 

 

 

 

 

 

 

 


